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The Power BI service for business users
Article • 02/08/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

You live in a data culture where business decisions are based on facts, not opinions. You
need data to make these decisions, and your colleagues don't let you down. They send
you all types of reports, spreadsheets, emails with charts, and even printed handouts.

As the data piles up, it becomes harder to find what you need quickly, and you worry
that you might not have the most recent information.

Power BI makes your job easier and more impactful. All the content you receive
becomes charts and graphs that visualize your data for you. Instead of long lists or
tables of numbers and words, your data insights are beautiful, colorful, and compelling
visuals. They tell stories about your data.

Open the Power BI service in a browser or on a mobile device. You and your colleagues
work from the same trusted dashboards and reports. Power BI updates the data
automatically, so you're always working with the freshest content.

Overview of the Power BI service



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-consumer/power-bi-consumer-examples.png#lightbox#lightbox


The content isn't static, so you can dig in and look for trends, insights, and other
business intelligence. Slice and dice the content, and even ask it questions in your own
words. Or, sit back and let your data discover interesting insights, send you alerts when
data changes, or email reports to you on a schedule that you set. All your content is
available to you anytime, in the cloud or on-premises, from any device. That's just the
beginning of what Power BI can do.

How you interact with Power BI depends on your job role. As a consumer or business
user, you receive content, like dashboards, reports, and apps, from colleagues. You work
in the Power BI service, which is the online or mobile version of Power BI. You review and
interact with your content to make business decisions.

As a business user, you might not have access to all the capabilities of Power BI. That's
ok, because your job isn't building semantic models and reports. You use the Power BI
service for analysis, monitoring, exploration, and decision making.

You might hear the term "Power BI Desktop" or just "Desktop." Designers use this stand-
alone tool to build and share dashboards and reports. It's important to know that there
are other Power BI tools out there. But if you're a business user, you typically work only
with the Power BI service. Because you're working with content that is shared with you,
at least one of the following scenarios is true:

You have a Power BI Pro or Premium Per User (PPU) license.
Your organization has a Power BI Premium subscription, and the content being
shared with you comes from Premium capacity.

For more information about licenses and subscriptions, see Which license do I have?

Are you a Power BI business user?

７ Note

Users with PPU capacity subscriptions can only share content with other users who
also have a PPU license.



As you filter, slice, subscribe, and export, your work doesn't impact the underlying
semantic model or the original shared content.

You can't corrupt your data. Power BI is a great place to explore and experiment without
worrying that you might break something.

That doesn't mean that you can't save your changes. You can, but those changes only
affect your view of the content. To revert to the default view, select the Reset button.

Take a tour of the Power BI service for business users.

Power BI service training for business users.

Terminology and concepts for Power BI business users.

Safely interact with content

Related content

https://learn.microsoft.com/en-us/training/paths/consume-data-with-power-bi/


Basic concepts for the Power BI service
business user
Article • 01/20/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop Requires Pro or Premium license

Use this article to familiarize yourself with some of the terms and concepts associated
with the Power BI service. Understanding these terms and concepts makes it easier for
you to read through the other Power BI articles and to work in the Power BI service
(app.powerbi.com).

This article assumes that you already read the Power BI overview and identified yourself
as a Power BI business user. Business users receive Power BI content, like dashboards,
reports, and apps, from creator colleagues. Business users work with the Power BI
service (app.powerbi.com), which is the website-based version of Power BI.

You likely heard the term "Power BI Desktop" or just "Desktop." It's the stand-alone tool
used by designers who build and share dashboards and reports with you. It's important
to know that there are other Power BI tools out there. But, as long as you're a business

This article isn't about Power BI Desktop

https://learn.microsoft.com/en-us/power-bi/fundamentals/power-bi-overview


user, you typically work with the Power BI service. This article applies only to the Power
BI service.

For more information about the full suite of Power BI tools, see What is Power BI?.

To follow along, open app.powerbi.com in your browser.

There are many objects and concepts that make up the Power BI service, too many to
cover in a single article. So this article introduces you to the most common:
visualizations, dashboards, reports, apps, and semantic models (formerly called
datasets). These objects are sometimes referred to as Power BI content. Content exists
within workspaces.

A typical Power BI workflow involves all of the building blocks. A Power BI designer
(yellow in the diagram) collects data from semantic models, brings it into Power BI
Desktop for analysis, and creates reports full of visualizations that highlight interesting
facts and insights. The designer pins visualizations from reports to dashboards, and
shares the reports and dashboards with business users like you (black in the diagram).
There are many different ways that a designer can share content with you: as individual
pieces of content, content bundled together in an app, or by giving you permissions to a
workspace where the content is stored. (Don't worry, we talk about the different ways
that content is shared later in this article.)

Let's get started

https://learn.microsoft.com/en-us/power-bi/fundamentals/power-bi-overview


At its most basic:

 A visualization (or visual), is a type of chart built by Power BI designers. The
visuals display the data from reports and semantic models. Because they're highly
interactive, you can slice, filter, highlight, change, and even drill into visualizations.

For more info, see Interact with visuals in reports, dashboards, and apps.

 A semantic model is a container of data. For example, it might be an Excel file
from the World Health Organization. It might also be a company-owned database
of customers or it might be a Salesforce file. Semantic models are managed by
designers.

 A dashboard is a single screen with tiles of interactive visuals, text, and
graphics. A dashboard collects your most important metrics, on one screen, to tell
a story or answer a question. The dashboard content comes from one or more
reports and one or more semantic models.

For more info, see Dashboards for the Power BI service business users.

 A report is one or more pages of interactive visuals, text, and graphics that
together make up a single report. Power BI bases a report on a single semantic
model. Often, the designer organizes report pages to each address a central area of
interest or answer a single question.

For more info, see Reports in Power BI.

 An app is a way for designers to bundle and share related dashboards,
reports, and semantic models together. Business users receive some apps
automatically but can go search for other apps created by colleagues or by the
community. For example, out-of-the-box apps are available for external services
you may already use, like Google Analytics and Microsoft Dynamics CRM.

To be clear, if you're logged in to the Power BI service for the first time, you probably
don't see any shared dashboards, apps, or reports yet.

Workspaces are places to collaborate with colleagues on specific content. Workspaces
are created by Power BI designers to hold collections of dashboards and reports. The
designer can then share the workspace with colleagues. Designers can also bundle a

Workspaces

https://learn.microsoft.com/en-us/power-bi/consumer/end-user-visualizations


collection of dashboards and reports into an app and distribute it to the entire
community, to their organization, or to specific people or groups. Certain types of apps
called template apps, create a workspace when the app is installed. Learn more about
apps.

Everyone using the Power BI service also has a My workspace. My workspace is your
personal sandbox where you can create content for yourself.

To see your workspaces in Power BI select Workspaces from your navigation pane.

[Learn more about workspaces].(end-user-workspaces.md)

A semantic model is a collection of data that designers import or connect to and then
use to build reports and dashboards. As a business user, it's possible that you never
interact directly with semantic models, but it's still helpful to learn how they fit into the
bigger picture.

Semantic models



Each semantic model represents a single source of data. For example, the source could
be an Excel workbook on OneDrive, an on-premises SQL Server Analysis Services tabular
dataset, or a Google Analytics dataset. Power BI supports more than 150 data sources
and is always adding more.

When a designer shares an app with you, or gives you permissions to a workspace, you
can look up which semantic models are being used. But you can't add or change
anything in the semantic model. This means that as you interact with dashboards and
reports, the underlying data is safe. Changes you make to the dashboards and reports
don't affect the semantic model.

One semantic model...

Can be used over and over by report designers to create dashboards, reports, and
apps.

Can be used to create many different reports.

Visuals from that one semantic model can appear on many different dashboards.

To learn more about semantic models, visit these articles:

How do designers assign permissions to semantic models
How semantic models are shared with colleagues

On to the next building block, reports.

A Power BI report is one or more pages of visualizations, graphics, and text. All of the
visualizations in a report come from a single semantic model. Designers build reports
and share them with others; either individually or as part of an app. Typically, business
users interact with reports in Reading view.

Reports

https://learn.microsoft.com/en-us/power-bi/connect-data/service-datasets-build-permissions
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards


One report...

Can be created using data from only one semantic model. Power BI Desktop can
combine more than one data source into a single semantic model in a report, and
that report can be imported into Power BI.

Can be associated with multiple dashboards (tiles pinned from that one report can
appear on multiple dashboards).

Can be part of multiple apps.

A dashboard represents a customized graphical view of some subset of one or more
underlying semantic models. Designers build dashboards and share them with business
users; either individually or as part of an app. If a business user is given permissions to a
report, they can build their own dashboards too. A dashboard is a single canvas that has
tiles, graphics, and text.

Dashboards



Dashboards can look similar to a report page. You know that you're on a dashboard if
you see a natural language query field in the upper left corner. Also, when you select a
visual tile on a dashboard you jump to the underlying report or to a URL or to the
natural language query that was used to create that tile. For more explanation, see
Reports versus dashboards.

A tile is a rendering of a visual that a designer pins, for example, from a report to a
dashboard. Most pinned tiles show a visualization that a designer created from a
semantic model, saved in a report, and then pinned to that dashboard. A tile can also
contain an entire report page and can contain live streaming data or a video. There are
many ways that designers add tiles to dashboards, too many to cover in this overview
article. To learn more, see Dashboard tiles in Power BI.

Business users can't edit dashboards. You can however add comments, view related data,
set it as a favorite, subscribe, and more.

What are some purposes for dashboards? Here are just a few:

To see, in one glance, all the information needed to make decisions

To monitor the most-important information about your business

To ensure all colleagues are on the same page; viewing and using the same
information

To monitor the health of a business or product or business unit or marketing
campaign, and so on

https://learn.microsoft.com/en-us/power-bi/consumer/end-user-visualizations


To create a personalized view of a larger dashboard, all the metrics that matter to
you

ONE dashboard...

Can display visualizations from many different semantic models

Can display visualizations from many different reports

Can display visualizations pinned from other tools (for example, Excel)

Visualizations (also known as visuals) display insights that Power BI discovers in the data.
Visualizations make it easier to interpret the insight, because your brain can
comprehend a picture quicker than it can comprehend a spreadsheet of numbers.

Just some of the visualizations available in Power BI are: waterfall, ribbon, treemap, pie,
funnel, card, scatter, and gauge.

See the full list of visualizations included with Power BI.

Visualizations

Custom visuals



If you receive a report with a visual you don't recognize, and you don't see it included in
the full list of visualizations included with Power BI, likely it's a custom visual. Custom
visuals are created by Power BI community members and submitted to Power BI for use
in reports.

These collections of dashboards and reports organize related content together into a
single package. Power BI designers build them in workspaces and share apps with
individuals, groups, entire organizations, or the public. As a business user, you can be
confident that you and your colleagues are working with the same information; a single
trusted version of the truth.

Sometimes, the app's workspace itself is shared, and there can be many people
collaborating and updating both the workspace and the app. The extent of what you
can do with an app is determined by the permissions and access you're given.

Apps are easy to find and install in the Power BI service  and on your mobile device.
After you install an app, you don't have to remember the names of a lot of different
dashboards and reports. They're all together in one app, in your browser, or on your
mobile device.

This app has two dashboards and two reports that make up a single app. Selecting an
arrow to the right of a report name displays a list of the pages that make up that report.

Apps

７ Note

The use of apps requires a Power BI Pro or Premium Per User (PPU) license, or for
the app workspace to be stored in Premium capacity. Learn about licenses.

https://powerbi.com/


Whenever the app is updated, you automatically see the changes. Also, the designer
controls the schedule for how often Power BI refreshes the data. You don't need to
worry about keeping it up-to-date.

You can get apps in a few different ways:

The app designer can install the app automatically in your Power BI account.

The app designer can send you a direct link to an app.

You can search from within the Power BI service for apps available to you from
your organization or from the community. You can also visit Microsoft
AppSource , where you find all the apps that you can use.

In Power BI on your mobile device, you can only install apps from a direct link, and not
from AppSource. If the app designer installs the app automatically, you see it in your list
of apps.

Once you install the app, just select it from your Apps list and choose which dashboard
or report to open and explore first.

https://appsource.microsoft.com/marketplace/apps?product=power-bi


Now that you have an understanding of the building blocks that make up the Power BI
service for business users, continue learning using these links. Or, start using the Power
BI service with some sample data.

Review and bookmark the Glossary

Take a tour of the Power BI service

Read the overview of Power BI written especially for business users

Watch a video that reviews the basic concepts and gives a tour of the Power BI
service.

Related content

７ Note

This video might use earlier versions of Power BI Desktop or the Power BI
service.

https://www.youtube-nocookie.com/embed/B2vd4MQrz4M

https://www.youtube-nocookie.com/embed/B2vd4MQrz4M


Quickstart: learn about the Power BI
capabilities for business users
Article • 03/12/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

This quickstart demonstrates how to interact with the Power BI service to discover data-
driven business insights. This article isn't intended to be a deep dive, but rather a quick
trip through many of the actions available for Power BI business users.

If you're not signed up for the Power BI service, sign up for a free trial  before you
begin.

Power BI is a collection of software services, apps, and connectors that work together to
turn your unrelated sources of data into coherent, visually immersive, and interactive
insights. Your data might be a simple Excel spreadsheet or a collection of data from
different data sources. No matter, Power BI lets you easily connect to your data sources,
visualize (or discover) what's important, and share that with anyone or everyone you
want.

Open the Power BI service, in a browser or on a mobile device. You and your colleagues
work from the same trusted apps, dashboards, and reports, that update and refresh
automatically, so you're always working with the freshest content.

There are two modes for interacting with reports in the Power BI service: Editing view
and Reading view. If you're a business user, then you're more likely to use Reading view
to consume reports created by others. Editing view is used by report designers, who

What is Power BI?

Reading view

https://app.powerbi.com/signupredirect?pbi_source=web


create the reports and share them with you. Reading view is your way to explore and
interact with reports created by colleagues.

Most reports open in Reading view. To switch from Reading view to Editing view, select
Edit from the action bar. If Edit is grayed out, that means that you don't have
permissions to edit the report.

To switch back to Reading view, select Reading view from the action bar.

Even in Reading view, the content isn't static. You can dig in, looking for trends, insights,
and other business intelligence. Slice and dice the content, and even ask it questions
using your own words. Or, sit back and let your data discover interesting insights for
you; send you alerts when data changes, and email reports to you on a schedule you set.
All your data, anytime, in the cloud or on-premises, from any device.

Read on to learn about these features and more.

When we use the term "content" in Power BI, we're referring to items such as reports,
dashboards, and apps. This content is the building blocks you use to explore your data
and make business decisions.

An app is a Power BI content type that combines related dashboards, reports,
workbooks, and more all in one place. An app can have one or more dashboards and

Select Editing view and Reading view

Power BI content

７ Note

Dashboards, reports, and apps can be viewed and shared on mobile devices, too.

Apps



one or more reports, all bundled together. Power BI designers create apps and distribute
and share the apps with business users like you.

One way to view your apps is to select Apps from the nav pane and choose an app to
open.

To learn more about viewing apps, see Power BI apps.

A Power BI report is a multi-perspective view into a semantic model, with visuals that
represent different findings and insights from that semantic model. A report can have a
single visual or pages full of visuals. Power BI designers create reports and distribute and
share the reports with business users like you.

To learn how to view reports, see Power BI reports.

Reports



A Power BI dashboard is a single page, often called a canvas, that uses visualizations to
tell a story. Because it's limited to one page, a well-designed dashboard contains only
the most-important elements of that story.

The visualizations you see on the dashboard are called tiles and are pinned to the
dashboard by report designers. In most cases, selecting a tile takes you to the report
page where the visualization was created.

To learn how to view dashboards, see Power BI dashboards.

Skip the email. Add a personal comment or start a conversation with colleagues about a
dashboard, right there on that dashboard. The comment feature is just one of the ways
you can collaborate with others.

Dashboards

Interact in the Power BI service

Collaborate with colleagues



Learn more about commenting.

Two of the ways that the Power BI service does the work for you is with subscriptions
and alerts.

It's not necessary to open Power BI to monitor a dashboard. You can subscribe instead,
and Power BI emails you a snapshot of that dashboard on a schedule you set.

Sit back and let Power BI work for you

Subscribe to a dashboard (or report)

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-reading-view/comment.gif




Learn more about Power BI subscriptions.

Your data is live, and your visuals update automatically. If you want to get notified when
data changes above or below a threshold you set, use data alerts. Alerts work on
gauges, KPIs, and cards.

Power BI sends you an email when the value increases or decreases past the limit you
set.

Get alerts when your data reaches a threshold

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-subscribe


Learn more about Power BI alerts.

Sometimes the fastest way to get an answer from your data is to ask a question using
natural language. The Q&A question box is available at the top of your dashboard. For
example, "show me count of large opportunities by sales stage as a funnel."

Use Q&A to ask questions using natural language



Learn more about Power BI Q&A.

Visuals are made up of datapoints, and by hovering over a datapoint, you can view the
details.

Display details on a visualization

Adjust the display dimensions

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-reading-view/power-bi-hover.gif


Reports are viewed on many different devices, with varying screen sizes and aspect
ratios. The default rendering may not be what you want to see on your device.

To adjust, from the upper right menu bar select the View icon and choose one of the
display options.

Cross-highlight and cross-filter the related visualizations on a report page. The
visualizations on a single report page are all "connected" to each other. What this means
is that if you select one or more values in one visualization, other visualizations that use
that same value change based on your selection.

Learn more about visual interactions.

See how all the visuals on a page are interconnected

Update the filters used in the report

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-reading-view/pagefilter3b.gif


Open the Filters pane to reveal the filters applied to the page, report, and visualization.





If the report has filters applied, they'll display in the Filters pane. Make changes to the

filters to see the effect on the visuals. Save your changes, or use the  to
revert to the default report page state.

Hover over a visual and select the Focus mode icon . When you view a visualization
in Focus mode, it expands to fill the entire report canvas.

Zoom in on individual visuals



To display that same visualization without the distraction of menu bars, filter pane, and
other chrome--select Full screen from the View dropdown.



Learn more about focus mode and full screen mode.

Visuals on a report page can be sorted and saved with your changes applied.

Hover over a visual to make it active, and select More options (...) to open sorting
options.

Learn more about sorting visuals.

Sort a visualization

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-reading-view/sort.gif


A Power BI visualization is constructed using data from underlying semantic models. If
you're interested in seeing behind-the-scenes, Power BI lets you display the data that is
being used to create the visual. When you select Show as a table, Power BI displays the
data below (or next to) the visualization.

With a visual active, select More options (...) and choose Show as a table.

Show the data used to create a visualization

Export data to Excel



In addition to showing the data that is used to create a visual, you can also export that
data and view it in Microsoft Excel. When you export to Excel, you're creating a separate
document, a spreadsheet that isn't part of Power BI. Any changes that you make in the
Excel file don't impact the data in Power BI. Whether you want to take a closer look at
the data, or you want to use the data in another application or for another purpose,
Power BI gives you that flexibility. For more information, visit Export the data that was
used to create a visualization.

Exporting isn't limited to individual visuals; you can export entire reports to Excel or
PowerPoint to share with your colleagues. For more information, see Analyze in Excel
and Power BI in PowerPoint.

This article is a quick overview of just some of the things business users can do with the
Power BI service.

If you connected to an app, from the nav pane, select Apps to open the Apps
content list. Hover over the app to delete, and select the trashcan icon.

If you imported or connected to a Power BI sample report, from the nav pane,
open My workspace. Using the tabs at the top, locate the dashboard, report, and
semantic model, and select the trashcan icon for each.

Power BI for business users

Clean up resources

Related content

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-export-data
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-analyze-in-excel
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-power-bi-powerpoint-add-in-about


Tutorial - Getting around in Power BI
service
Article • 02/08/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Now that you know the basics of Power BI, let's take a look around the Power BI service.
As mentioned in the previous article, colleagues on your team might spend all of their
time in Power BI Desktop , combining data and creating reports, dashboards, and apps
for others. They're designers and creators. You, on the other hand, might spend all of
your time in the Power BI service, viewing and interacting with content created by others
(consuming experience). You're a business user. This tutorial is for business users of the
Power BI service.

If you're not signed up for Power BI, sign up for a free trial  before you begin.

Read Power BI service basic concepts.

Viewing Power BI content (reports, dashboards, apps) created by designers requires
one of two conditions:

A Power BI Pro or Premium Per User (PPU) license.
Your organization to have a Power BI Premium subscription, and the content to
be shared with you from a Premium capacity. Learn about licenses and
subscriptions.

For the purposes of this tutorial, we aren't requiring either of these conditions to
be met. Microsoft has sample content available to you directly from the Power BI
service interface. Use this sample content to learn your way around the Power BI
service.

1. To begin, open the Power BI service (app.powerbi.com), and sign in if you're
prompted.

Prerequisites

Open the Power BI service

https://powerbi.microsoft.com/desktop/
https://app.powerbi.com/signupredirect?pbi_source=web


2. Open a Power BI sample. From the navigation pane, select the Learn icon  and
in the Learning center, scroll down to Sample reports. Select the right arrow until
you get to Sales and Marketing Sample. Select the sample to open it.



3. The Power BI service installs the sample in My workspace, your private sandbox for
learning and experimenting. Only you can see your workspace. Select My
workspace to see details about this sample.

The sample includes one report, one dashboard, and one semantic model. Most
content shared with business users doesn't include direct access to the underlying
semantic models, but the samples, which are designed for all users, include
semantic models.

The sample content is organized within the context of a workspace named My
workspace. My workspace stores all of the content that you own and create. Think of it

View workspace content



as your personal sandbox or work area for your own content. Any sample data that you
download from the Power BI Learning Center is saved in your My workspace.

You acquire more workspaces when designers share content with you. For example, if
designers assign you access permissions to one of their workspaces, that workspace
shows up in your Power BI site.

My workspace

Workspaces are more than storage locations. From a workspace you can learn a lot
about the included dashboards, reports, and semantic models. Workspace owners
assign permissions to content in a workspace. Your permissions may allow you to take
More actions (...) on the content in a workspace. Since we're using sample content that
is saved in your My workspace, you have owner-level permissions by default.

From a workspace, you can open a dashboard or report by selecting it from the list. You
can favorite a dashboard or report by hovering and selecting the star icon. If a
workspace owner gave you sharing permissions, you can share from here as well.

Learn more about Workspaces.

A dashboard is a single page that shows visualizations of the most important elements
from one or more reports.

Open a dashboard and a report

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-shared-with-me


1. The Sales and marketing sample has one dashboard. To open the dashboard,
select it.

2. The dashboard opens in the Power BI service. Dashboards are something that
differentiates the Power BI service from Power BI Desktop. Learn about
dashboards.

3. The actions you can take on a dashboard are displayed in the top menu bar. Select
More options (...) to see the complete list.



4. The visuals on the dashboard are arranged as tiles. Hover over a dashboard tile
and select More options (...) to see the options you have for interacting with that
tile.

5. Select a dashboard tile to open the report that was used to create that tile. The
report opens to the page that contains the visual that is on the tile. In this example,
selecting the dashboard tile with the treemap opens the YTD Category report
page.



A report is made up of one or more pages. In most cases, each page is designed to
tell a story and that story is told with visualizations, text, shapes, and images.

Reports have several sections. On the left is the clickable list of report pages.
Across the top, is the menu bar containing actions you can take with the report.
The options available depend on the role and permission the report designer
assigned to you. On the right side is the Filters pane. And the center canvas
contains the report itself. Similar to the dashboard, there are actions that you can
take for the entire report, for individual visuals, and also for a single report page.

Learn more about Power BI reports.

The nav pane becomes more useful as colleagues share content with you. In this section
of the tutorial, we look at the Power BI service for a business user who works with
colleagues who share lots of reports, dashboards, and apps.

The top icon in the nav pane is your Power BI Home. It's the default landing page when
you log in to the Power BI service. Home is a great starting point for viewing and
navigating to your content. Home bring together the searching and sorting tools, the
nav pane, and a canvas with cards that you can select to open content. At first, you
might not have many cards on your Home canvas, but that changes as you start to use
Power BI with your colleagues.

Using the left navigation pane (nav pane)



To learn more, see Power BI Home.

See your full list of favorites, recent, and shared content by selecting Browse on the nav
pane. Here you find content lists that provide details about reports, apps, and
dashboards.

Browse



For more information, see Recent content, Favorite dashboards, reports, and apps, and
Dashboards and reports that are shared with me.

Go directly to your apps by selecting Apps on the navigation pane. You might not have
any apps yet. The Apps pane contains apps that are shared with you or that you install.

For more information, see Apps in Power BI.

For new users, the Learning center is especially helpful, with getting started content,
samples, and links to videos.

When you're new to the Power BI service, you only have a few pieces of content. But as
colleagues begin sharing data with you and you begin downloading apps, you might
end up with long lists of content. That's when you find searching and sorting helpful.

Search is available from almost every part of the Power BI service. Just look for the
search box or search magnifying glass icon.

In the Search field, type all or part of the name of a dashboard, report, workbook, app,
or owner. Power BI searches all of your content.

Open Apps

Open the Learning center

Search and sort content

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-shared-with-me


There are also many ways to sort content. Hover over column headers and look for
arrows indicating that the column can be sorted. Not all columns can be sorted.

Or, look for the search Filters near the upper right corner of your content lists. Find
content quickly by filtering categories, like type of content or owner.



For more information, see Navigation for Power BI business users: global search.

Let's end this tutorial with a helpful tip. If you have questions about a dashboard, report,
app, or other content--you can look up the owner or contact email. With the content
open, select the title menu to display the owner's contact link. The owner or contact may
be a person or a group.

You can now delete the sample report, dashboard, and semantic model from your My
workspace if you wish.

Find the owner

Clean up resources



1. Open the Power BI service (app.powerbi.com) and select My workspace.

2. Hover over the report and select More options (...) > Delete. Repeat to remove the
dashboard and semantic model.

Related content
Learn about the Power BI capabilities for business users



Find your dashboards, reports, and apps
Article • 02/19/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

In Power BI, the term content refers to visuals, apps, dashboards, and reports. Power BI
designers create content and share that content with their colleagues. Your content is
accessible and viewable in the Power BI service, and often the best place to start
working in the Power BI service is from Power BI Home.

After you sign in to the Power BI service, select Home from the navigation pane.

Your Home page opens. The layout and content on Home is different for every user.
New users have less content, but that changes as they use Power BI more often. Only
the content that you can access appears on your Home. For example, if you don't have
permissions to a report, that report doesn't appear on Home.

Explore Power BI Home

Simplified layout and Expanded layout



Your Home view depends on the layout you select. The Simplified view is the default.
This view shows Recommended content at the top with tabs for Recent, Favorites, and
My apps. Recommended content might include content that:

Is marked as a favorite
Is visited often
Is visited often by colleagues in your organization
Is featured on Home
Is used frequently by your closest colleagues
Is getting started content

The following example shows a Simplified layout for a new user.

The next example shows a Simplified layout for an experienced user.



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-home/power-bi-home.png#lightbox#lightbox


The Expanded layout includes a different set of information. If you select the Expanded
view from the View menu, the expanded layout becomes your default Home layout.

The following example shows the Expanded view for an experienced user.



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-home/power-bi-simplified-user.png#lightbox#lightbox


Power BI Home offers three ways of locating and viewing your content. All three
approaches access the same pool of content in different ways. Searching is sometimes
the easiest and quickest way to find something, while other times, selecting a card on
the Home canvas is your best option.

The Home canvas shows your favorite, frequent, recent, recommended, apps, and
workspaces. If you're new to the Power BI service, you also have getting started
content. To open content, select a card or an item in a list.
Along the left side is a navigation pane, referred to as the nav pane. The nav pane
has the same content as Home, but organized differently. Select Browse to see
your recent, favorite, and shared content. Select Data hub to see data available to
you from across your organization. Select Apps to see a list of apps available to
you. And select Learn to see learning materials, sample reports, and training.
At the top of Home, use the global search box to search for content by title, name,
or keyword.

The following sections review these options for finding and viewing content.



Locate content from your Home canvas

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-home/power-bi-expanded-view.png#lightbox#lightbox


On the Home canvas, view all content that you have permission to use. At first, you
might not have much content, but that changes as you start to use Power BI with your
colleagues.

As you work in the Power BI service, you receive dashboards, reports, and apps from
colleagues, and Power BI Home fills in with content.

Every Home landing page looks different. Power BI optimizes Home based on your
usage, settings, and the layout you select.

The Favorites + frequents section of Home contains links to the content that you visited
most often or that you tagged as a favorite. These cards have black stars because
they're tagged as favorites.

The Featured section contains content that your administrator or colleagues promoted
to your Home. Typically, the content that they feature is important or helpful for you to
do your job. In this example, the featured content includes metrics to track success.
Unless it's been disabled by your administrator, any user with Administrator, Member, or
Contributor permissions to a workspace can feature content on Home. For more
information about featuring content on Home, see Feature content on colleagues'
Power BI Home.

Home canvas

Most important content at your fingertips

Favorites and frequents

Featured

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-featured-content


The next section of Home contains two or more tabbed lists.

All displays content from all the other tabs combined.

Recent displays content you visited most recently. Notice the timestamp for each
item.

Shared displays content that your colleagues shared with you.

Favorites displays content you tagged as a Favorites.

My apps lists apps that are shared with you or that you downloaded from
AppSource. The most recent apps are listed here.

From external orgs (Preview) lists shared semantic models available from other
tenants. Use this list to discover and connect to data from external providers.

The exact resources that appear depend on your activity, settings, and Power BI
administrator. If you're a new user, you might see getting started content. If you don't
want to see getting started content on Home, select Hide getting started.

Categorized content

Getting started learning resources



Getting started resources, samples, and other learning content is always available from
the Learn tab in your nav pane.

The nav pane classifies your content in ways that help you find what you need quickly.

Explore the navigation pane





Use the nav pane to locate and move between dashboards, reports, apps, and other
content. Occasionally, using the nav pane is the quickest way to get to content. The nav
pane is there when you open your Home landing page and remains there as you open
other areas of the Power BI service.

The nav pane organizes your content into containers that are similar to what you also
see on the Home canvas. Select the Browse tab to display lists of your Recent, Favorites,
and Shared with me content.

The number of visible buttons on the nav pane depends on space. To view hidden
buttons, select the ellipses (...). As you open workspaces, they appear below My
workspace. To remove the workspace from the nav pane, select the X. Selecting the X
doesn't delete the workspace, it only removes it from the nav pane. To reopen a
workspace, select it from Workspaces.

Quickly find the content you want on the nav pane. Content is organized similar to the
Home canvas, but shows lists instead of cards.

Every Power BI service user has one My workspace. My workspace only contains
content that you download from Microsoft samples or that you create yourself. For
many business users, My workspace is empty and remains empty.

The following example shows what your workspace looks like if it's empty.

Workspaces



If someone in your organization adds you to a workspace, it appears in your list of
workspaces. Over time, you might have more than one workspace. For example, your
coworkers can add you to a workspace by giving you a role, such as Member,
Contributor, or Viewer. If you download a template app from outside your organization,
you get an app and a new workspace. You can also create workspaces if you have a paid
license. To open a workspace, select it from the nav pane.



The workspace opens on your canvas, and the name of the workspace is listed on your
nav pane. When you open a workspace, you can view its content. It includes content
such as dashboards, reports, worksheets, and dataflows. In the following example, the
Content & Learning workspace is open and it contains several types of content.



Sometimes, the fastest way to find your content is to search for it. For example, if a
dashboard that you don't use often isn't showing up on your Home canvas. Or, if your
colleague shared something with you, but you don't remember the title or what type of
content they shared. Sometimes, you might have so much content that it's easier to
search for it rather than scrolling or sorting.

To search, use the search field, which is in the upper right corner of the Home menu bar.
Enter the full or partial name of the content you're looking for. You can also enter your
colleague's name to search for content that they shared with you. The search finds
matches in all the content that you own or have access to.

Search all your content



Overview of the Power BI basic concepts

Related content



Interact with the Power BI service as a
Free user
Article • 12/15/2022

APPLIES TO: 
Power BI service for business users 
Power BI service for designers
& developers 
Power BI Desktop 
Requires Pro or Premium license

As a Power BI service user with a free license, you explore content (such as reports, apps,
scorecards, dashboards, and more) in order to make business decisions. That content is
created by designers who have Power BI Pro or Premium Per User (PPU) licenses. In
order to share it with users with free licenses, designers need to publish that content to
a group workspace backed by a Premium capacity. Premium capacity provides the
benefit of unlimited content sharing. Sometimes, designers share content by sending
you links to content such as a Power BI app Apps in the Power BI service, and sometimes
the content automatically installs and appears in Power BI under Apps or Browse >
Shared with me.

There are many different ways designers can share content. But this article is for Power
BI users with a free license, and therefore only describes how "free users" receive and
interact with content. For more information on other ways to share content, see Ways to
share your work in Power BI.

In the previous article, you learned that what you can do with dashboards, reports, and
apps (content) in the Power BI service depends on three things: your licenses, your roles
and permissions, and where content is stored.

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-how-to-collaborate-distribute-dashboards-reports
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-roles-new-workspaces
https://learn.microsoft.com/en-us/power-bi/connect-data/service-datasets-permissions


This article lists which features in the Power BI service are available to users with Free
licenses.

Let's review some Power BI concepts before we get to the list. This will be a quick review
and if you need more details, visit Licenses for consumers or Power BI basic concepts.

Collaborating and sharing in workspaces requires that workspace owners, who have Pro
or Premium Per User (PPU) licenses, assign you a role in that workspace.

Roles determine who can do what in that workspace. Free users are assigned the Viewer
role. Being assigned any other role requires that a free user upgrade to Pro or PPU.

When an organization has a Premium capacity subscription, admins and Pro users can
assign workspaces to the Premium capacity. Content in workspaces hosted in Premium
capacity can be accessed by users with any Power BI license as long as they have
appropriate permissions to access the content.

Each Power BI service user has at least one of the following: a free license, a Power BI
Pro license, a Premium Per user license. As long as your colleagues use Premium
capacity workspaces to share content, free users can view and interact with that content.

To find out what type of license is assigned to your account, select your profile picture
from the page header in Power BI service . If Pro account or Premium Per User
account is displayed, you can share content with other users. When Free is shown, you
can only create content in My Workspace and consume content that is hosted in a
Premium workspace. Select View account to see more details about your account.

７ Note

In sovereign cloud environments with Power BI Premium capacity, all users can view
content without needing an assigned license.

Quick review of terminology

Workspaces and roles

Premium capacity

Licenses

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-roles-new-workspaces
https://app.powerbi.com/


The following chart identifies which tasks can be performed by a user with a free license
interacting with content in their own My Workspace or in Premium capacity.

The first column represents a free user only working with content in My workspace. This
user cannot collaborate with colleagues in the Power BI service. Colleagues cannot
directly share content with this user, and this user cannot share from My workspace.

The second column represents a free user working with content in a workspace that is
saved in Premium capacity. This free user:

has a free user license type
is part of an organization that has a Premium capacity subscription
gets content (apps, dashboards, reports, etc.) from Pro or PPU users who share
that content using group workspaces in Premium capacity.
is assigned the Viewer role to those app workspaces.

 feature is available in the current scenario

 feature is not available in the current scenario


 feature availability is limited to My workspace. Content in My workspace is for the
owner's personal use and cannot be viewed by anyone else in Power BI.

* access to this feature can be turned on or off by a Pro user or an admin.


Power BI feature list for users with a free
license

７ Note

Content hosted in a PPU workspace can only be used by users with PPU licenses.

Legend



Features Scenario 1: Power BI Free
user who has no access to
content hosted in Premium
capacity.

Scenario 2: Power BI Free user
with Viewer permissions to
content stored in Premium
capacity.

Apps

Installs automatically *

Open

Favorite

Edit, update, republish

Create new app

AppSource: download and
open

Organization store:
download and open

Reshare an app

Workspaces in Premium
capacity

Create, edit, or delete
workspace or content

Add endorsements

Open and view

Read data stored in
workspace dataflows

Dashboards

Receive, view, and interact
with dashboards from
colleagues

Feature list



Features Scenario 1: Power BI Free
user who has no access to
content hosted in Premium
capacity.

Scenario 2: Power BI Free user
with Viewer permissions to
content stored in Premium
capacity.

Add alerts to tiles

View and respond to
comments from others:
add your own comments

*

Save a copy

Copy visual as an image?

Create, edit, update, delete

Export tile to .csv

Favorite

Full screen and focus
modes

Global search * *

Insights on tiles *

Q&A: use on dashboard * *

Q&A: add featured and
saved questions

Q&A: review asked
questions

Pin tiles from Q&A or
reports

Print * *

Refresh

Reshare

Subscribe yourself * *



Features Scenario 1: Power BI Free
user who has no access to
content hosted in Premium
capacity.

Scenario 2: Power BI Free user
with Viewer permissions to
content stored in Premium
capacity.

Subscribe others

View dashboards that have
been embedded into
PowerApps or SharePoint
pages

Datasets

Add, delete, edit

Create a report in another
workspace based on a
dataset in this workspace

Insights on datasets

Schedule refresh

Analyze in Excel *

Create a report

Create a paginated report

Share

Manage permissions

Save a copy

Create from template

Reports

Receive reports from
colleagues

Analyze report in Excel * *

View bookmarks created
by others, and add your
own bookmarks



Features Scenario 1: Power BI Free
user who has no access to
content hosted in Premium
capacity.

Scenario 2: Power BI Free user
with Viewer permissions to
content stored in Premium
capacity.

View and respond to
comments from others:
add new comments

Change display
dimensions

Save a copy

Copy visual as an image*

Cross-highlight and cross-
filter report visuals

Drill

Drillthrough * *

Embed (publish to web,
public)

*

Export summarized data
from report visuals*

Export underlying data
from report visuals*

Favorite the report

Filters: change types * *

Filters: interact

Filters: persistent * *

Search on the filter pane * *

Full screen and focus
modes

Insights on reports

Lineage view

1



Features Scenario 1: Power BI Free
user who has no access to
content hosted in Premium
capacity.

Scenario 2: Power BI Free user
with Viewer permissions to
content stored in Premium
capacity.

Export to PDF*

Performance Inspector

Export to PowerPoint*

Promote content to Home

Print report pages*

Interact with Q&A visual

QR Code

Refresh

Share content with
external users

Share: allow others to
reshare items

Show as table (show data)

Slicers: add or delete

Interact with slicers

Sort report visuals

Subscribe yourself to
reports*

Subscribe others to
reports

View related

View reports that have
been embedded into
PowerApps or SharePoint
pages



Features Scenario 1: Power BI Free
user who has no access to
content hosted in Premium
capacity.

Scenario 2: Power BI Free user
with Viewer permissions to
content stored in Premium
capacity.

Visuals: change types in
reports

* *

Change visual interactions

Visuals: add new

Visuals: add new fields

Visuals: change type

Visuals: hover to reveal
details and tooltips

Power BI for business users

Next steps



Sign in to the Power BI service
Article • 03/12/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Before you can sign in to Power BI, you need an account. There are two ways to get a
Power BI account. Your organization can purchase Power BI licenses for its employees or
individuals can sign up for free trials or personal licenses. This article covers the first
scenario.

After you have an account set up, you can sign in and get started in the Power BI
service. Use the steps here for general guidance. The exact screens may vary from what
you see here, depending on your version of Microsoft software, browser version, and
how your admin set up your license and tenant.

The Power BI service runs in a browser.

If you receive an email from a colleague, with a link to a dashboard or report,
select the link to Open this report or Open this dashboard.

Power BI accounts

Sign in for the first time

Step 1: Open the Power BI service

https://learn.microsoft.com/en-us/power-bi/fundamentals/service-self-service-signup-for-power-bi


Otherwise, open your favorite browser and type app.powerbi.com.

1. The first time you sign in, Microsoft checks to see if you already have a Microsoft
365 account. Enter your email address.

2. Enter your Microsoft 365 account password. It's the same email and password that
you use for other Microsoft products, like Outlook and Office. Depending on how
your account is set up, you might be prompted to enter a code sent to your email
or mobile device.

Step 2: Type your email address



Sometimes, your global administrator assigns you a license and sends you an email
with this information. Look in your inbox for a welcome email and follow the
instructions to sign in for the first time. Use this email account for your sign-in.

On your first visit, Power BI opens your Home landing page. If Home doesn't open,
select it from the navigation pane.

Step 3: Review your Home landing page



On Home, you can see all the content that you have permission to use. There might not
be much content at first, but that changes as you continue to use Power BI with your
colleagues. You can find the report that your colleague emailed to you under Recent on
the Home page.

Reports shared with you are also stored under Shared with me on the Browse page.

As a business user, others share content with you and you interact with that content to
view data and make business decisions. As you filter, slice, subscribe, export, and resize,
your changes don't impact the underlying semantic model or the original shared
content. Power BI is a safe space where you can explore and experiment.

That doesn't mean that you can't save your changes. You can, but those changes only
affect your view of the content. And you can always reset your changes back to the
default view by selecting Reset.

Safely interact with content



When you close or sign out of the Power BI service, your changes are saved. You can
pick up where you left off.

To close Power BI, close the browser tab where you're working.

If you share a computer, we recommend signing out each time you close Power BI. In
the upper right corner, select your profile picture, and then choose Sign out.

If you don't have a work or school account, you can still sign up for Power BI with a
Microsoft 365 trial.

Sign out of the Power BI service

Considerations and limitations

https://learn.microsoft.com/en-us/power-bi/enterprise/service-admin-signing-up-for-power-bi-with-a-new-office-365-trial


If you signed up for Power BI as an individual, sign in with the email address that
you used to sign up.

Some people use more than one Power BI account. If you do, you're prompted to
select an account from a list when signing in.

If sign up is disabled, use this article to get help.

View a Power BI app.

Related content

https://learn.microsoft.com/en-us/power-bi/fundamentals/service-self-service-signup-for-power-bi
https://learn.microsoft.com/en-us/power-bi/fundamentals/service-self-service-sign-up-help


Licenses and subscriptions for business
users
Article • 07/03/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

As a business user, you use the Power BI service to explore reports and dashboards so
you can make data-backed business decisions. If you've been using Power BI for a while,
you probably discovered that there are some features that only work if you have a
certain type of license, subscription, or permissions.

What you can do in the Power BI service depends on three things:

The type of license and subscription you're using
The type of workspace that stores the content
The roles and permissions you have in a workspace

This article describes the capabilities of each license type and how the location where
content is stored affects what you can do with it. You learn how to look up your license



and subscription information, and figure out where your content is stored. For more
information about workspace roles and permissions, see Collaborate in workspaces.

Each user of the Power BI service has either a free license, a Pro license, or a Premium
per-user (PPU) license. If you're a Power BI business user, you're probably using a free
license managed by your Power BI administrator.

It's possible to have more than one license at the same time. The service always delivers
you the experience equal to the most permissive license you currently have.

For a more detailed overview of licenses and subscriptions, see License types for Power
BI and Fabric.

Premium is an organizational subscription that provides a way to store content in a
virtual container called a Power BI Premium capacity. With Premium capacity, anyone
granted permissions, whether they're inside or outside your organization, can access
content stored in this virtual container. This access includes users with free licenses.

Premium capacity enables widespread distribution of content by users with paid licenses
without requiring paid licenses for the recipients who view the content. The person who
is creating the content in the Premium capacity uses a paid license to connect to data
sources, model data, and create reports, dashboards, and apps that are saved to a
workspace in Premium capacity. Users without a paid license can access a workspace
that's in Power BI Premium capacity, as long as they have a role in that workspace. When
users with a free license attempt to access a workspace in Premium capacity, and they
aren't assigned a role in that workspace, they're receive a prompt to upgrade their
license to Pro, PPU, or a trial.

Within the workspaces in Premium capacity, creators assign roles, like Viewer,
Contributor, Member, and Administrator. The roles creators assign to their colleagues,

Licenses

７ Note

A paid license, either Power BI Pro or Premium Per User (PPU), is required for

publishing content to a Power BI app workspace, editing content, and for

sharing content with others.

Power BI Premium capacity subscription

https://learn.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://learn.microsoft.com/en-us/power-bi/fundamentals/service-features-license-type
https://learn.microsoft.com/en-us/power-bi/enterprise/service-admin-purchasing-power-bi-pro
https://learn.microsoft.com/en-us/power-bi/enterprise/service-premium-per-user-faq


and the licenses the colleagues have, determine the extent to which those colleagues
can interact with the content. For more information, see workspace permissions and
roles.

When a creator creates and publishes an app, they grant access to individuals or entire
organizations. The extent to which you can interact with the app's content depends on
the specific access permissions given to you. For example, you might be given access to
view the app, connect to the underlying semantic models, make copies of reports, or
share the content.

For more info about Premium capacity, see What is Microsoft Power BI Premium?.

To display your account information, log in to Power BI in your browser
(app.powerbi.com). Select your profile picture in the upper right corner. In the following
screenshot, a user named Zalan has a free account and is signed up for a free trial. Other
types of licenses are Pro and Premium per-user. To see more details about your account,
select View account > Subscriptions.

This first user, Pradtanna, has Office 365 E5, which includes a Power BI Pro license.

Find out which licenses you have

https://learn.microsoft.com/en-us/power-bi/enterprise/service-premium-what-is


This second user, Zalan, has a free license. The name of the license is Fabric (Free).

Microsoft Power BI and Microsoft Fabric



Power BI is one of the experiences available in Microsoft Fabric. Power BI is one
component of Fabric. Power BI is also available as a standalone service. You might be
someone who uses only the Power BI experience and you might be someone who works
with more than one of the Fabric experiences.

For more information, see What is Microsoft Fabric.

Next, check to see if you have access to content in Premium capacity. Either of the users,
Pro or free, can belong to an organization that has Premium capacity.

Select Workspaces and scroll through the list of workspaces shared with you.
Workspaces in Premium capacity are marked with a diamond icon. To open a Premium
workspace, select it.

Find out if you have access to Premium
capacity

https://learn.microsoft.com/en-us/fabric/get-started/microsoft-fabric-overview


Not only workspaces are marked with a diamond icon. Apps and app workspaces saved
in Premium capacity also have a diamond icon.

In the following image, two of the apps are stored in Premium capacity.

If you don't see any diamond icons, it may mean that no colleague has shared content
with you from Premium capacity.

There are many ways organizations set up their Power BI subscriptions and licenses.
From a business user's perspective, one common scenario gives you a free license. Your
organization buys a Premium subscription, the administrator assigns Pro licenses to a
small group of users, and all the other users have free licenses. Typically, the
administrator assigns a Pro license to employees who create and share content. The Pro
users create workspaces and add dashboards, reports, semantic models, apps, and other
content to those workspaces. To allow free users to collaborate in those workspaces, the

Put it all together



administrator or Pro user then assigns the workspaces to Premium capacity and gives
free users permissions (roles) to that workspace.

License
type

Not in Premium capacity Premium capacity

Free Use as a personal sandbox to create content
for yourself and interact with that content. A
free license is a great way to try out the
Power BI service. You can't consume content
from anyone else or share your content with
others.

Interact with content assigned to
Premium capacity and shared with
you. Free, Premium per-user, and Pro
users can collaborate without
requiring the free user to have a paid
license.

Pro Collaborate with Premium per-user and Pro
users by creating and sharing content.

Collaborate with free, Premium per-
user, and Pro users by creating and
sharing content.

In the following diagram, the left side represents Pro users who create and share
content in app workspaces.

Workspace A isn't in Premium capacity.

Workspace B was created and saved in Premium capacity. This workspace has a
diamond icon.

ﾉ Expand table



The Power BI Pro creators can share and collaborate with other Pro users in either of the
workspaces. The Power BI Pro user can only share and collaborate with free users by
using Workspace B, which is in Premium capacity. The creator assigns roles to
collaborators within the workspace. Your role determines what actions you can take.
Power BI business users are usually assigned the Viewer role. For more information, see
Permissions in the workspaces.

It's possible to have more than one Power BI license. The Power BI service always
delivers the experience equal to the best license that you currently have. For
example, if you have both a Pro and a free license, the Power BI service uses the
Pro license.

Only SKUs (Stock Keeping Units) equivalent or higher than a F64 SKU allow free
Power BI users to consume Power BI apps and shared content in Premium capacity
in the Power BI service. Smaller F SKUs require a paid license to

You want to create and share content, or open content that someone else shared
with you. That content isn't in Premium capacity. You must have a paid license.
Either purchase a license or sign up for a trial, if there's one available. One option
that might be available is the free trial of Power BI paid features. If your
organization has self-service trials enabled, you can select the upgrade dialog that
appears in the Power BI service when you try to use a Pro feature.

When the trial expires, your license reverts back to the previous version, either free
or Pro. You no longer have access to features that require a paid license. If you
want to continue with a paid license, contact your administrator or IT Help Desk
about purchasing an upgrade. If you don't have an administrator or IT Help Desk,
visit the Power BI pricing page .

If you sign up for a free license by selecting a Try it free button, it never expires
unless you cancel it. If your trial upgrade ends or if your organization removes your
Pro or Premium license, your free license is still available to you.

Considerations and limitations

https://learn.microsoft.com/en-us/power-bi/fundamentals/service-self-service-signup-for-power-bi
https://powerbi.microsoft.com/pricing/
https://powerbi.microsoft.com/pricing/


Feedback

Was this page helpful?

Provide product feedback | Ask the community

A free user license for the Power BI service is perfect for someone exploring or
using it for personal data analysis and visualizations by using My workspace. A
free standalone user doesn't use Power BI to collaborate with colleagues.
Standalone users with free licenses can't view content shared by others or share
their own content with other Power BI users.

Am I a Power BI business user?
Learn about workspaces
Features for free users

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi


Q&A for Power BI business users
Article • 01/11/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Sometimes the fastest way to get an answer from your data is to ask a question using
natural language. For example, "show total units by year and product manufacturer."

Use Q&A to explore your data using natural language capabilities and receive answers
in the form of charts and graphs. Unlike a search engine, Q&A only provides results
about the data in Power BI semantic models.

To learn how to use Q&A, see Explore your data and create visuals using Q&A.

Q&A picks the best visual based on the data. Sometimes data is defined as a certain
type or category, which helps Q&A know how to display it. For example, if data is
defined as a date type, it's more likely to be displayed as a line chart. Data that is
categorized as a city is more likely to be displayed as a map.

What is Q&A?

Which visualizations does Q&A use?

https://learn.microsoft.com/en-us/power-bi/natural-language/q-and-a-intro


If you want a specific type of visual, tell Q&A which one to use by adding it to your
question. For example, "show me total sales by category as a treemap." But keep in
mind that it isn't always possible for Q&A to display the data using the visual type you
requested. Q&A prompts you with a list of workable visual types.

Q&A is available on dashboards in the Power BI service, and at the bottom of the
dashboard in Power BI mobile. If the dashboard designer gave you edit permissions,
save the visual by pinning it to your dashboard.

Where can I use Q&A?

Use Q&A on a dashboard

https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-pin-tile-from-q-and-a


To learn more, see Use Q&A on a dashboard.

Q&A is available in reports if the report designer added a specific type of interactive
visual called a Q&A visual or added a Q&A button. Ask natural language questions and
create new report visuals that represent the answers to your questions. If you have edit
permissions for the report, turn the results into a new visual in the report.

To learn more, see Use Q&A in a report.

Q&A is available in Power BI iOS apps and in Power BI embedded analytics as well.

Use Q&A in a report

Use Q&A in mobile apps and embedded reports

Considerations and limitations

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-q-and-a
https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-buttons#select-the-action-for-a-button
https://learn.microsoft.com/en-us/power-bi/natural-language/power-bi-tutorial-q-and-a
https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna
https://learn.microsoft.com/en-us/power-bi/developer/embedded/qanda


Question: I don't see Q&A on this dashboard.

Answer 1: If you don't see a question box, check your settings. Select the Settings icon
in the upper right corner of your Power BI toolbar.

Choose Power BI Settings > Dashboards. Highlight the dashboard that doesn't have a
Q&A question box. Make sure there's a check mark next to Show the Q&A search box
on this dashboard.

Answer 2: Sometimes you don't have access to the settings. If the dashboard owner or
your administrator turned Q&A off, check with them to see if it's OK to turn it back on.
To look up the owner, select the name of the dashboard from the top menu bar.

Question: I'm not getting the results I'd like to see when I type a question.

Answer: Select the option to contact the report or dashboard owner. You can find the
report or dashboard owner from the Q&A dashboard page or the Q&A visual. Or, you
can look up the owner from the Power BI header. There are many things the owner can

https://learn.microsoft.com/en-us/power-bi/natural-language/q-and-a-tooling-intro


do to improve the Q&A results. For example, the owner can rename columns in the
semantic model to use terms that are easily understood ( CustomerFirstName  instead of
CustFN ). Since the owner knows the semantic model, they can also come up with helpful
questions and add them to the Q&A suggested questions.

Microsoft might use your questions to improve Power BI. For more information about
how Microsoft uses your questions, see the Microsoft Privacy Statement  for more
information.

To learn how to ask your own natural language questions and create answers in
the form of visuals, see Use Q&A on a dashboard or Use Q&A in a report.

For tips on forming questions, see How to ask questions with Q&A.

If you have edit permissions, learn how to create a Q&A visual on a dashboard and
add a Q&A visual in a report.

Privacy

Related content

https://learn.microsoft.com/en-us/power-bi/natural-language/q-and-a-tooling-intro
https://go.microsoft.com/fwlink/?LinkId=521839
https://learn.microsoft.com/en-us/power-bi/natural-language/power-bi-tutorial-q-and-a
https://learn.microsoft.com/en-us/power-bi/create-reports/power-bi-visualization-introduction-to-q-and-a
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-q-and-a


Dashboards for business users of the
Power BI service
Article • 12/25/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

A Power BI dashboard is a single page, often called a canvas, that uses visualizations to
tell a story. Because it's limited to one page, a well-designed dashboard contains only
the most important elements of that story.

The visualizations on the dashboard are called tiles. Report designers pin tiles to the
dashboard. In most cases, selecting a tile takes you to the report page where the
visualization was created. If you're new to Power BI, start with Power BI basic concepts to
get a good foundation. Hovering over an element on a dashboard displays a tooltip.



７ Note

You can view and share dashboards on mobile devices.

To view dashboards that colleagues share with you, you must have a Pro or
Premium Per User (PPU) license or the content must be shared with you from a
workspace in Premium capacity. For more information, see Power BI license types.

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-dashboards/power-bi-dashboard.png#lightbox#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-view-dashboard


The visualizations on a dashboard come from reports, and each report is based on one
semantic model. You can think of a dashboard as an entryway into the underlying
reports and semantic models. Select a visualization to take you to the report that was
used to create it.

Dashboards are a great way to monitor your business, find answers, and see your most
important metrics at a glance. The visualizations on a dashboard can come from one or
more underlying semantic models or reports. A dashboard can combine on-premises
and cloud data, which provides a consolidated view regardless of where the data lives.

A dashboard isn't just a pretty picture, it's an interactive canvas. The tiles update as the
underlying data changes.

How you interact with Power BI depends on your job role. As a consumer or business
user, you receive content, like dashboards, reports, and apps, from colleagues who are
designers. Reports can be confused with dashboards because they're both canvases
filled with visualizations, but there are major differences from a Power BI business user's
point of view. The following table shows an overview of the different capabilities of
dashboards and reports.

Advantages of dashboards

Dashboards vs. reports for Power BI business
users

ﾉ Expand table



Capability Dashboards Reports

Pages One page One or more pages

Ask a question about
your data (Power BI
Q&A) field

Yes, almost always available No Q&A field

Data sources One or more report or semantic
model per dashboard

A single semantic model per
report

Filtering No, you can't filter or slice Yes, there are many ways to filter,
highlight, and slice

Set alerts Yes, you can create email alerts
when certain conditions are met

No, you can't set alerts

Can see underlying
semantic model tables
and fields

No. Can export data but can't see
the semantic model tables and
fields in the dashboard itself

Yes. Can see semantic model
tables and fields and values that
you have permissions to see

View a dashboard.
Learn about dashboard tiles and what happens when you select one.
Track and receive email alerts for individual dashboard tiles by Creating alerts on
tiles.
Learn how to use Power BI Q&A to ask a question about your data and get the
answer in the form of a visualization.

Related content

 Tip

Use the table of contents available on this page to find even more information.



View a dashboard
Article • 11/10/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Power BI business users spend a lot of time viewing dashboards. Dashboards are
designed to highlight specific information from the underlying reports and semantic
models. And Power BI business users rely on that information for tracking, monitoring,
answering questions, testing, and more--in order to make data-driven business
decisions.

A Power BI Pro or Premium license is required for both sharing a dashboard and viewing
a shared dashboard. Which license do I have?.

Dashboards can be opened from many locations in the Power BI service. One way to
open a dashboard is to select and open a workspace.

Open a dashboard



If that workspace contains a dashboard, you see the following icon.

Once you identified a dashboard, open it by selecting it and the dashboard fills your
Power BI canvas.

On the left navigation pane, view and open dashboards from:

Home
Browse,

Recent - if you recently visited a dashboard
Favorites - if you set a dashboard as a favorite
Shared with me - if a colleague shared a dashboard with you

Data hub - contains content from across your organization
Apps - most apps contain both dashboards and reports
Workspaces, including My workspace - if you downloaded any of the Power BI
samples or other content or if colleagues have shared content with you.

Back to dashboard overview.

Get comfortable with dashboards by taking a tour of one of our sample
dashboards.

Learn about dashboard tiles and what happens when you select one.

Next steps

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-shared-with-me
https://learn.microsoft.com/en-us/power-bi/create-reports/sample-datasets
https://learn.microsoft.com/en-us/power-bi/create-reports/sample-tutorial-connect-to-the-samples


Dashboard tiles in Power BI
Article • 06/13/2023

APPLIES TO: 
Power BI service for business users 
Power BI service for designers
& developers 
Power BI Desktop 
Requires Pro or Premium license

A tile is a snapshot of your data, pinned to a dashboard by a designer. Designers can
create tiles from a report, dataset, dashboard, the Power BI Q&A question box, Excel,
SQL Server Reporting Services (SSRS), and more. This screenshot shows many different
tiles pinned to a dashboard.

Besides tiles pinned from reports, designers can add standalone tiles directly on the
dashboard using Add tile. Standalone tiles include: text boxes, images, videos,
streaming data, and web content.

Need help with understanding the building blocks that make up Power BI? See Basic
concepts for the Power BI service business user.



1. To display the ellipsis, hover over the tile.

2. Select the ellipses to open the tile action menu. The options available vary by your
permissions, the visual type, and the method used to create the tile.

Some of the actions available from these menus are:

Open the report that was used to create the tile 

View the tile in focus mode 

Interacting with tiles on a dashboard



View insights 

Add a comment and start a discussion 

Export the data to Excel 

3. To close the action menu, select a blank area in the canvas.

When you select a tile, what happens next depends on how the tile was created and if it
has a custom link. If it has a custom link, selecting the tile takes you to that link.
Otherwise, selecting the tile takes you to the report, Excel Online workbook, SSRS report
that is on-premises, or Q&A question that was used to create the tile.

If nothing happens when you select a tile, or you receive an error message, here
are some possible reasons:

The report that was used to create the visualization wasn't saved, or has been
deleted.
The tile was created from a workbook in Excel Online, and you don't have at
least Read permissions for that workbook.
If the tile is created from SSRS, and you don't have permission to access the
SSRS report. Or, if you don't have access to the network where the SSRS server
is located.

For tiles created directly on the dashboard using Add tile, if a custom hyperlink has
been set, selecting the title, subtitle, or tile opens that URL. Otherwise, by default,
selecting one of these tiles created directly on the dashboard for an image, web
code, or text box produces no action.
If the original visualization used to create the tile changes, the tile doesn't change.
For example, if the designer pinned a line chart from a report and then changed
the line chart to a bar chart, the dashboard tile continues to show a line chart. The
data refreshes, but the visualization type doesn't.

Select a tile

７ Note

The exception to this is video tiles added to dashboards by designers. Selecting a
video tile (that was created this way) causes the video to play right there on the
dashboard.

Considerations and troubleshooting

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-export-data
https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-edit-tile


If a workspace is moved to Premium capacity, the existing dashboard refresh cache
doesn't move with the workspace. The new cache is created the first time a user
visits the dashboard in the new Premium capacity. After that, every data refresh will
refresh the cache and update the data.
If a tile is pinned from a workbook, you can't turn off the display of the title and
subtitle. The option to Edit details > Display title and subtitle is greyed out.

Data refresh in Power BI
Basic concepts for the Power BI service business user

Next steps

https://learn.microsoft.com/en-us/power-bi/connect-data/refresh-data


Add comments to a dashboard or report
Article • 11/09/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Add a personal comment or start a conversation about a dashboard or report with your
colleagues. The comment feature is just one of the ways a business user can collaborate
with others.

Comments can be added to an entire dashboard, individual visuals on a dashboard, a
report page, a paginated report, and individual visuals on a report page. Add a general
comment or add a comment targeted at specific colleagues. Comments can be up to
2,000 characters, including @mentions of other users and spaces.

７ Note

Collaborating with others, including adding comments to shared reports, requires a
Power BI Pro license or for the content to be hosted in Power BI Premium capacity.
Which license type do I have?

How to use the Comments feature

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-comment/comment.gif


When you add a comment to a report, Power BI captures the current filter and slicer
values, and creates a bookmark. So, when you select or respond to a comment, the
report page or report visual might change to show you the filter and slicer selections
that were active when the comment was first added.

Why is this feature important? If a colleague applied a filter that revealed an insight to
share with the team, the comment might not make sense without that filter selected.

If you're using a paginated report, you can only leave a general comment about your
report. Support for leaving comments on individual paginated report visuals isn't
available.

The process for adding comments to a dashboard or report is similar. In this example,
we're using a dashboard.

1. Open a Power BI dashboard or report and select the Comment icon. This action
opens the Comments section.

Here we see that the dashboard creator has already added a general comment.
Anyone with access to this dashboard can see this comment.

Add a general comment to a dashboard or report

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-comment/power-bi-comment.gif


2. To respond, select Reply, type your response, and then select Post.

By default, Power BI directs your response to the colleague who started the
comment thread, which is Lee in this case.



3. If you want to add a comment that isn't part of an existing thread, enter your
comment in the upper text field.



The comments for this dashboard now look like the following example.





In addition to adding comments to an entire dashboard or to an entire report page, you
can add comments to individual dashboard tiles and individual report visuals. The
processes are similar, and in this example we're using a dashboard.

1. Hover over the visual and select More options (...).

2. From the menu, select Add a comment.

3. The Comments section opens, and the other visuals on the page are greyed out.
This visual doesn't have any comments yet.

Add a comment to a specific dashboard or report visual



4. Enter your comment and select Post.

On a report page, when you select a comment on a visual, that visual is
highlighted (see the following example).

On a dashboard, the chart icon  shows that a comment is tied to a specific
visual. Comments that apply to the entire dashboard don't have a special
icon. Selecting the chart icon highlights the related visual on the dashboard.



5. Select Close to return to the dashboard or report.

Whether you're creating a dashboard, report, tile, or visual comment, grab your
colleagues' attention by using the "@" symbol. When you type the "@" symbol, Power
BI opens a dropdown menu where you can search for and select individuals from your
organization. Any verified name prefaced with the "@" symbol appears in blue font. The
@mentioned individuals immediately receive an e-mail in their inbox. If they're using a
Power BI Mobile app, they receive a push notification on their device. They can open the
report or dashboard directly from the notification, see the comment, view the data, and
reply accordingly.

Here's a conversation I'm having with the visualization designer. They're using the @
symbol to ensure I see the comment. I receive a notification and select the link to open
this dashboard and the relevant conversation.

Get your colleagues attention by using the @ symbol



Users with edit access to the report settings can disable the commenting feature.
Select File > Settings and deselect Allow people to comment on this report or
dashboard.

Comments are limited to 2,000 characters, including @mentions of other users and
spaces.

The maximum number of conversations on a dashboard or report is 100. The
maximum number of comments per conversation is 1000. To add a new
conversation or comment, delete prior conversations or comments.

Bookmarks aren't captured when you reply to a conversation. Only the first
comment in a conversation creates a bookmark.

Considerations and troubleshooting



If you're using a paginated report, you can only leave a general comment about
your report. Support for leaving comments on individual paginated report visuals
isn't available.

Back to visualizations for business users
Select a visualization to open a report

Next steps

https://learn.microsoft.com/en-us/power-bi/consumer/end-user-visualizations


View data insights on dashboard tiles
with Power BI
Article • 02/14/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Each visual tile on your dashboard is a doorway into data exploration. For more
information, see Dashboard tiles in Power BI. When you select a tile, it opens a report or
Q&A (Q&A for Power BI Business users), where you can filter and dig into the semantic
model behind the report. And when you run insights, Power BI does the data
exploration for you.

When you run insights on tiles, Power BI looks at the data used to render that tile. If
Power BI finds interesting facts or trends in that data, you see those facts or trends in
the form of interactive visuals. Insights can run on a specific dashboard tile and you can
even run insights on an insight.

The insights feature is built on a growing set of advanced analytical algorithms
developed with Microsoft Research. These algorithms allow people to find insights in
their data in new and intuitive ways. For more information, see Types of insights
supported by Power BI. The dashboard insights feature is similar to the semantic model
quick insights feature. To see how to run quick insights on an entire semantic model,
see Generate data insights on your semantic model automatically with Power BI.

Run insights on a dashboard tile

https://learn.microsoft.com/en-us/power-bi/create-reports/service-insights


When you run insights on a dashboard tile, Power BI searches just the data used to
create that single dashboard tile.

1. Open a dashboard. For more information, see Dashboards for business users of the
Power BI service.

2. Hover over a tile, select the More options (...) feature on the tile, then choose View
insights from the dropdown menu.

3. The tile opens in Focus mode with the insights cards displayed along the right.
Select the pin icon to save any of these insight tiles to your dashboard. For more
information, see Display content in more detail: focus mode and full screen mode.



4. After you decide which insight card to explore, select it. The selected insight
appears on the canvas, and new insight cards, based solely on the data in that
single insight, display along the right.

Now that you have an insight open, continue exploring.

Filter the visual on the canvas. To see the filters, go to the Filter's pane and select
the arrow in the upper right corner.

You can run insights on the insight card itself. Insights on insights is often referred
to as related insights. To generate related insights, select an insight card to make it
active. It moves to the left side of the report canvas, and new cards, based solely
on the data in that single insight, display along the right. Filters are available for

Interact with the insight cards



the new insight card as well.

To return to your report, select Exit Focus mode, located in the upper left corner of the
screen.

View insights doesn't work with all dashboard tile types. For example, it isn't available
for Power BI custom visuals, streaming data, DirectQuery tiles, or data protected with
RLS (row-level security).

Use the Analyze feature to explain fluctuations in report visuals
Types of insights supported by Power BI

Considerations and troubleshooting

Related content



Tutorial: Set alerts on Power BI
dashboards
Article • 02/08/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Set alerts in the Power BI service to notify you when data on a dashboard changes
above or below limits you set. Alerts can be set on tiles pinned from report visuals or
from Power BI Q&A. Alerts can be set only on gauges, KPIs, and cards.

Alerts only work on data that is refreshed. When data refreshes, Power BI looks to see if
an alert is set for that data. If the data reaches an alert threshold, an alert is triggered.

This tutorial covers the following.

A Power BI license. If you're not signed up for Power BI, sign up for a free trial
before you begin.
Access to a dashboard with one of the following types of tile: gauge, KPI, or card.
A semantic model that refreshes.

Who can set alerts＂

Which visuals support alerts＂

Who can see my alerts＂

Do alerts work on Power BI Desktop and mobile＂

How to create an alert＂

Where will I receive my alerts＂

Prerequisites

Who can set alerts

https://app.powerbi.com/signupredirect?pbi_source=web


Alerts can be created in the Power BI service by customers with any license type. Set
alerts on dashboard tiles:

you create and save in My workspace.
shared with you in a Premium reserved capacity.
in any workspace you can access, if you have a Power BI Pro or Premium Per User
(PPU) license.

Only you can see the alerts you set, even if you share your dashboard. Data alerts are
fully synchronized across platforms; set and view data alerts in the Power BI service, in
the Power BI mobile apps, and in Power BI for Teams.

Alerts can be set on three types of tiles (gauges, KPIs, and cards) on a Power BI
dashboard. This tutorial uses the Sales and Marketing app available from AppSource. To
follow along, get the sample.

1. From a dashboard gauge, KPI, or card tile, select the ellipsis.

2. Select the alert icon,  or Manage alerts, to add one or more alerts for the
Market share card.

Who can see alerts I create?

２ Warning

These alerts provide information about your data. If you view your Power BI data on
a mobile device and that device gets stolen, we recommend using the Power BI
service to turn off all alerts.

Add an alert to a dashboard tile

https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps


3. On the Manage alerts pane, select + Add alert rule. Ensure the slider is set to On,
and give your alert a title. Titles help you easily recognize your alerts.

4. Scroll down and enter the alert details. In this example, we create an alert that
notifies us once a day if our market share increases to 40% (.4) or higher. We opt
to have Power BI send us an email when an alert is triggered. Triggered alerts also
appear in our Notification center.

5. Select Save and close.

Receiving alerts



When the data being tracked reaches one of the thresholds you set, several things
happen. First, Power BI checks to see if it's been more than an hour, or more than 24
hours (depending on the option you selected), since the last alert was sent. As long as
the data is past the threshold, you get an alert.

Next, Power BI sends an alert to your Notification center and, optionally, in email. Each
alert contains a direct link to your data. Select the link to see the relevant tile.

1. When you set the alert to send you an email, you find something like this in your
Inbox. This email is from an alert we set for the Sentiment card.

2. Power BI also adds a message to your Notification center.

3. Open your Notification center to see the alert details.



There are many ways to manage your alerts: from the dashboard tile itself, from the
Power BI Settings menu, on an individual tile in the Power BI mobile app on the iPhone,
or in the Power BI mobile app for Windows 10.

1. If you need to change or remove an alert for a tile, reopen the Manage alerts
window. All the alerts that you set for that tile are displayed.

Managing alerts

From the tile itself

https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps
https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps


2. To modify an alert, select the arrow to the left of the alert name.

3. To delete an alert, select the trashcan to the right of the alert name.

1. Select the gear icon from the Power BI menubar.

2. Under Settings select Notifications > Power BI Alerts.

From the Power BI settings menu



3. From here you can turn alerts on and off, open the Manage alerts window to make
changes, or delete the alert.

If you're unable to set an alert for a gauge, KPI, or card, contact your Power BI
admin or IT help desk for help. Sometimes alerts are turned off or unavailable for
your dashboard or for specific types of dashboard tiles.
Alerts only work on data that is refreshed. They don't work on static data. Most of
the samples supplied by Microsoft are static.
The ability to receive and view shared content requires a Power BI Pro license, a
Premium Per User license, or for the report to be saved in Premium reserved
capacity. For more information, read Which license do I have?.
Alerts can be set on visuals created from streaming datasets that are pinned from a
report to a dashboard. Alerts can't be set on streaming tiles created directly on the
dashboard using Add tile > Custom streaming data.

Delete the alerts you created in this tutorial. Select the gear icon from the Power BI
menubar. Under Settings select Notifications > Power BI Alerts and delete the alert.

Considerations and limitations

Clean up resources

Set data alerts on your mobile device

https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-set-data-alerts-in-the-mobile-apps


Reports in Power BI
Article • 02/06/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop

A Power BI report is a multi-perspective view into a semantic model, with visuals that
represent findings and insights from that semantic model. A report can have a single
visual or many pages full of visuals. Depending on your job role, you might be someone
who designs reports, or you might be a business user who consumes reports. This article
is for business users.

A. This report has six pages (or tabs). The example shows the Sentiment page.
B. This page has five visuals and a page title.
C. The Filters pane shows all applied filters. To collapse the Filters pane, select the arrow
(>).
D. The Power BI banner shows the title of the report and the sensitivity label. Select the
title to open a menu that shows the report location, date it was last updated, and
contact information for the report creator.
E. The action bar contains links to numerous actions you can take on this report. Some
actions require extra permissions. For example, based on your permissions you may be
able to edit, subscribe, and share the report. All users can add a comment, view a
bookmark, or generate automatic insights. Select More options (...) to see the full list of
report actions.

The parts of a report



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-reports/power-bi-numbered-report.png#lightbox#lightbox


If you're new to Power BI, read Basic concepts for the Power BI service business users to
get a good foundation. You can view, share, and annotate reports on mobile devices. For
more information, see Explore reports in the Power BI mobile apps.

Power BI bases a report on a single semantic model. Report designers create the visuals
in a report to represent pieces of information. Presenting data as visuals makes it easier
to grasp the meaning of what you're seeing. And, the visuals aren't static. They update
as the underlying data changes. The designers do the pre-work, adding visuals that they
believe are interesting. But you get to explore and dig deeper. You interact with the
visuals and filters as you dig into the data to discover insights and find answers. The
extent of what you can do with a report depends on your role and the permissions the
report designer assigns to you.

As you explore and interact with your content by filtering, slicing, subscribing, and
exporting, you can't corrupt the reports. Your work doesn't affect the underlying
semantic model or the original shared dashboards, reports, and apps.

Your changes don't affect underlying data, but that doesn't mean you can't save your
changes. You can, but those changes only affect your view of the content. To revert to
the default view of the report, select the Reset icon.

Advantages of reports

Safely interact with content

７ Note

You can't damage your data. The Power BI service is a great place for you to explore
and experiment without worrying about breaking something.

Save your changes or revert to the default
settings

https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-reports-in-the-mobile-apps


Dashboards can be confused with reports because they're both canvases filled with
visualizations. But there are major differences. The following table shows an overview of
the different capabilities of dashboards and reports:

Capability Dashboards Reports

Pages One page One or more pages

Data sources One or more report or
semantic model per
dashboard

A single semantic model per report

Filtering No, you can't filter or slice Yes, there are many ways to filter, highlight,
and slice

Can see underlying
semantic model
tables and fields

No. Can export data but
can't see the semantic
model tables and fields in
the dashboard itself

Yes. Can see semantic model tables and
fields and values that you have permissions
to see

Customization No Yes, depending on your permissions you
can cross-filter, change visual type, apply
design features, add bookmarks and
comments, generate QR codes, analyze in
Excel, and much more

Pinning Can pin existing visuals
(tiles) only from current
dashboard to your other
dashboards

Can pin visuals (as tiles) and entire report
pages to any of your dashboards

Dashboards versus reports

ﾉ Expand table

Related content



Depending on your role, you may be a designer, someone who creates reports for your
own use or to share with colleagues. You want to learn how to create and share reports.

Or you might be a business user, someone who receives reports from others. You want
to learn how to understand and interact with the reports. If you're a report business user,
these links are for you:

Start with a tour of the Power BI service, so you know where to find reports and
report tools.
Learn how to open a report and all the interactions available to business users.
Get comfortable with reports by taking a tour of a sample.
Explore Dashboards in the Power BI service.
See which semantic model the report is using and which dashboards are showing
visuals from the report, see View related content in the Power BI service.

 Tip

If you didn't find what you're looking for here, use the table of contents on this
page to browse more articles.

https://learn.microsoft.com/en-us/power-bi/create-reports/sample-tutorial-connect-to-the-samples


Open a report in the Power BI service
Article • 04/25/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

A Power BI report is one or more pages of organized visuals. All Power BI users can
create and edit their own reports. However, opening reports created by others requires
a paid license (Power BI Pro or Premium Per User) or special access to a Premium
capacity.

This article teaches you how to open reports that are shared with you. The most
common scenarios are covered. The first scenario is when a Power BI designer creates a
report and shares it directly. The second scenario is when a designer shares a report as
part of an app.

For more information about sharing reports, see Licenses and subscriptions for business
users.

Power BI designers share reports with you by sending an email link or by adding the
report to your Power BI content. These reports are located under Shared in the Browse
tab.

1. Open the Power BI service (app.powerbi.com), and sign in if you're prompted.

2. On the navigation pane, select Browse, and on the Browse page, select Shared.

Open a report that is shared with you

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-shared-with-me


3. The report icon  is displayed next to the report name. Select a report to open
it.

1. Notice the tabs along the left side. Each tab represents a report page or a
dashboard. Selecting the YTD Category tab opens the YTD Category Trend
Analysis page.

2. Expand the Filters pane along the right side. Filters that are applied to this report
page, or to the entire report, are displayed here. If you have permissions, change
these filters to see the impact on your report and visuals.

Explore the report



3. Hover over a visual to show the actions you can perform. For this treemap, we see
pin, copy, filter, display the visual at full size, and an ellipsis (...).

Select the ellipsis (...) to see more options.



4. Explore the action bar at the top of your report. From the File menu, you can make
copies and print. If you have permissions, Export your report to PowerPoint or
Share your report with colleagues. Select Get insights and Power BI searches for
and displays interesting information from the report data. All of the features
available from the action bar are explained in separate Power BI articles.

5. Change the size and display of your report. To adjust the report display size, use
the slider in the bottom right. To select display options from a menu, open the
View menu and choose a display option. Your choices are Full screen, Actual size,
Fit to page, and Fit to width. Notice the difference that each display options
makes.



There are many ways for you to interact with a report to discover insights and make
business decisions. Other articles about Power BI reports are available from the Power BI
Learn table of contents.

The apps you receive from colleagues are located on the Home page and in the Apps
container on your navigation pane. An app is a collection of dashboards and reports

Open a report that's part of an app



that a Power BI designer compiles for you.

You must have a Power BI Pro license to open an app unless the app workspace is
stored in Premium capacity. A user with any Power BI license can have access to reports
stored in Premium capacity.

Follow along with Microsoft sample content.

1. In your browser, go to appsource.microsoft.com.

2. Search for "Sales & Marketing" and select Microsoft sample - Sales & Marketing.

3. Select Get it now > Continue > Install to install the app in your Apps container.

4. Go back to Home by selecting Home from the navigation pane.

5. Scroll down and select My Apps.

6. Select your new Sales and Marketing app to open it. Depending on the options
set by the app designer, the app opens to a dashboard or a report. This app opens
to a dashboard.

Most dashboard tiles are pinned from reports. Selecting a tile opens the report that was
used to create the tile.

Open a report from a dashboard



1. To open an underlying report, select a tile from a dashboard. From the Sales and
Marketing dashboard, we select the Total Units YTD Variance % column chart tile.

2. The associated report opens to the YTD Category Trend Analysis page. This is the
source page for the column chart tile.

７ Note

Not all tiles lead to a report. If you select a tile that was created with Q&A, the
Q&A screen opens. If you select a tile that was created using the dashboard Add
tile widget, a video, website, or other content might open.

https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-add-widget
https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-add-widget
https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-add-widget
https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-add-widget


Feedback

Was this page helpful?

Provide product feedback | Ask the community

As you get more comfortable navigating the Power BI service, you figure out workflows
that are best for you. A few other ways to access reports:

Using the related content pane.
In an email, when someone shares with you or you set an alert or you create or
receive a subscription.
From your Notification center
From a workspace

Open and view a dashboard
Explore the report Filters pane

More ways to open a report

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-share-reports
https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-subscribe
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-new-workspaces


Change the display of a report page
Article • 02/14/2023

APPLIES TO: 
Power BI service for business users 
Power BI service for designers
& developers 
Power BI Desktop 
Requires Pro or Premium license

You can view reports on many devices with varying screen sizes and aspect ratios. Learn
how to change the display of a report page, so it fits your needs.

The options in the View menu give you flexibility to display report pages at the size and
width you choose.



Explore the View menu

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-report-view/power-bi-canvas.png#lightbox#lightbox


If you view a report on a small device, it might be hard to see titles and legends. Select
View > Actual size to increase the size of the report page. Use the scroll bars to move
around the report.

Fit the report to your screen width by selecting Fit to width from the View menu.
Because it adjusts the width and not the height, you might need to use the vertical scroll
bar.



If you don't want any scroll bars, but you want to make the best use of your screen size,
select Fit to Page from the View menu.

Change your display colors by selecting High contrast colors in the View menu. Select
one of the options, such as High-contrast #1, High-contrast #2, High-contrast black, or
High-contrast white. This feature gives people with impaired vision options to see the
reports better. The example below is the High-contrast #1 option.



Select Full screen in the View menu to display your report page without menu bars and
headers. Full screen is a good choice for small screens where the details might be hard
to see. Full screen can also be a good choice when projecting report pages on a large
screen for people to view but not interact with.

When you exit the report, your View settings aren't saved. The changes revert to the
default view settings. If you want to save these settings, you can preserve them as a
bookmark.



Use the zoom controls in your browser to increase or decrease the available canvas area.
Decreasing the zoom expands the available canvas area, and increasing the zoom
decreases the available canvas area.

Sometimes it's difficult to see the details in a visual. You can focus on one visual by itself
to make it bigger by using Focus mode. For more information, see Focus mode and Full
screen mode.

The following example shows a visual in Focus mode.

Use your browser to change page display

Zoom in on a visual



The next example shows a visual in Full screen mode.

Compare focus mode and full screen mode
Take a tour of the report Filters pane

Next steps



Change how a chart is sorted in a Power
BI report
Article • 06/11/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

In the Power BI service, you can highlight important information in a visual by sorting
data fields. Some fields contain numeric data (such as sales figures) and some contain
text data (such as state names). After you sort a visual, you can save a personalized
version of your changes. The Power BI service provides flexibility and quick menus that
allow you to efficiently sort your visuals.

In a Power BI report, you can sort most visuals by one, and sometimes two fields. But
some visuals can't be sorted, like treemaps, filled maps, scatter charts, gauge charts,
waterfall charts, cards, and visuals on a dashboard.

To choose a sorting option, open any report that you created or that is shared with you.
Select a visual that can be sorted, and choose More options (...). Depending on the type
of visual, the sorting options are Sort descending, Sort ascending, Sort by, and Sort
axis.

） Important

This article is for Power BI service users who don't have edit permissions for a
report or semantic model. If you're a report designer, administrator, or owner,
see Sort one column by another column in Power BI for information that is more
relevant to you.

Get started

https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-sort-by-column


Visuals can be sorted alphabetically or numerically. If the content is text, sort
alphabetically from Z to A. If the content is numbers, sort low to high. For example, in
this chart's Y-axis, the Sales Stage text and is sorted alphabetically A to Z.

Sort alphabetically or numerically



To change the sort order, select either Sort ascending or Sort descending. The
following example shows the visual sorted by Opportunity Count in ascending order.
The field and order that are sorted are indicated with a checkmark.

Certain types of visualizations can be sorted by more than one column. The order you
select the columns determines sort priority.

The data in this table is sorted by Number of customers. The small arrow in the column
header indicates that the column is sorted. The arrow points down because the column
is sorted in descending order.

Sort by multiple columns



You can sort multiple columns to create a sorting sequence. To add more columns to the
sort order, select the Shift key while also selecting the column header you would like to
add next in the sort order. For example, if you select Number of customers and then
select Shift and Total revenue, then the table is sorted first by customers, then by
revenue. The red outlines show areas where the sort order changed.



If you select Shift and then select the same column a second time, the sort direction
(ascending or descending) is changed. If you select Shift and select a column you
previously added to the sort order, that column moves to the back of the sort order.

Power BI reports retain the filters, slicers, sorting, and other data view changes that you
make, even if you're working in Reading view. So, if you navigate away from a report,
and return later, your sorting changes are saved. To revert your changes back to the
report designer's settings, select Reset to default from the top menu on the report
page.

The report designer can prevent changes from being saved. If they do, the Reset to
default button is greyed out.

You can also save your changes with bookmarks, if the report designer enables the
Personalize visual feature for the report. You can change the sort order of a visual and

save it as a bookmark. If you see the personalize visual icon  in the visual's header,
this feature is enabled. You don't need edit permissions to use this feature.

Save your sort order changes



For more information, see Personalize visuals in a report.

Sometimes you want to sort your data by using a field that isn't included in the visual.
For example, you might want to sort by month in sequential order (and not in
alphabetical order) or you might want to sort by entire numbers instead of by digit
(example, 0, 1, 9, 20 and not 0, 1, 20, 9).

To learn how to sort by a different field in the semantic model, see Sort one
column by another column in Power BI. To use this feature, you must have edit
permissions for the report.

Ask the report designer to create new columns in the semantic model to address
sorting issues. The designer's contact information is listed in the report title's
menu.

More about Interactions with visuals in reports, dashboards, and apps.

Sort by other criteria

Related content

https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-sort-by-column
https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-sort-by-column
https://learn.microsoft.com/en-us/power-bi/consumer/end-user-visualizations


Feedback

Was this page helpful?

Provide product feedback | Ask the community

Basic concepts for the Power BI service business user.

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi


Take a tour of the report Filters pane
Article • 03/23/2023

APPLIES TO: 
Power BI service for business users 
Power BI service for designers
& developers 
Power BI Desktop 
Requires Pro or Premium license

This article explains how to use the report Filters pane in the Power BI service. You can
use filters to discover new insights in your data.

There are many different ways to filter data in Power BI. For example, you can filter data
by selecting data points on a report visual to filter other visuals on the page—this is
called cross-filtering and cross-highlighting. For more information, see How visuals
cross-filter each other in a Power BI report.

When a colleague shares a report with you, make sure to look for the Filters pane.
Sometimes it's collapsed along the right edge of the report. Select the Filers pane to
expand it.

Work with the report Filters pane



The Filters pane contains filters that the report designer adds to the report. Business
users can interact with the existing filters and save changes. However, they can't add
new filters to the report. In the previous example, the designer added three page-level
filters: Segment is All, Year is 2014, and Region is Central. You can interact and change
these filters, but you can't add a fourth page-level filter.

Some of the filters are shaded, and some aren't. If a filter is shaded, it means a filter has
been applied, and some data is excluded. In the following example, the Region filter
card is shaded and expanded. The Central option is the only option selected from the
dropdown. Since Region is under the Filters on this page heading, all visuals on this
page aren't displaying. The data from West and East regions are excluded.



In the Power BI service, reports keep any changes you make in the Filters pane. The
service carries those changes through to the mobile version of the report.

To reset the Filters pane to the designer's defaults, select the Reset icon from the top
menu bar.

The Filters pane displays all filters added by the designer to the report. The Filters pane
is also the area where you can view information about the filters and interact with them.
You can save changes or use Reset to default to revert to the original filter settings.

If there are changes you'd like to save, you can also create a personal bookmark. For
more information, see Bookmarks in the Power BI service.

The Filters pane displays and manages several types of report filters: report, report
page, and visual.

In the following example, you can see a visual that has three filters: Manufacturer,
Month, and Total units. The report page also has filters listed under the Filters on this
page heading. The entire report has a filter for Date, listed under Filters on all pages.

７ Note

If you don't see the Reset to default option, the report designer might have
disabled it. The designer can lock specific filters so that you can't change them.

View all the filters for a report page



Some of the filters have (All) next to them. (All) means all values are being included in
the filter. In the previous screenshot, Segment(All) tells us this report page includes data
about all the product segments.

Anyone with permissions to view this report can interact with these filters.

To get a closer look at the filters affecting a specific visual, hover over the visual to
reveal the filter icon 
. Select that filter icon to see a pop-up window with all the filters
and slicers affecting that visual. The filters in the pop-up window are the same filters
displayed on the Filters pane, plus any other filters affecting the selected visual.

View filters applied to a visual



Types of filters in the pop-up window include:

Basic filters
Slicers
Cross-highlighting
Cross-filtering
Advanced filters
Top N filters
Relative Date filters
Sync-slicers
Include/Exclude filters
Filters passed through a URL

In this example:

1. Date is a filter applied to all pages in this report.

2. Manufacturer is VanArsdel, Natura, Aliqui, or Pirum is a filter applied to this
visual.



3. Region is Central and Year is 2014 are filters applied to this report page.

4. Year is a filter applied on this report page.

Sometimes a filter can have a long list of values. Use the search box to find and select
the value you want.

To understand a filter, expand it and look at the available values and counts. To expand
the filter, select the arrow next to the filter name.

Search in a filter

Display filter details

Change filter selections



One way to search for data insights is to interact with the filters. You can change filter
selections by using the drop-down arrow next to the field name. Depending on the filter
and type of data that Power BI is filtering, your options range from simple selections
from a list, to identifying ranges of dates or numbers. See the advanced filter example.
Notice the change in the Total Units YTD filter on the treemap between 2,000 and 3,000.
This change removes Pirum and VanArsdel from the treemap.

If you don't want to keep the changes you've made to the filters, select the Reset icon
from the top menu bar. This selection reverts the filters to their original state, as set by
the report designer.

 Tip

To select more than one filter value at a time, hold down the CTRL key. Most filters
support multi-select.

Reset filter to default



To reset a filter to (All), clear it by selecting the eraser icon next to the filter name.

How visuals cross-filter each other in a Power BI report

Clear a filter

Next steps



How visuals cross-filter each other in a
Power BI report
Article • 01/23/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

One of the great features of Power BI is the way all visuals on a report page are
interconnected. If you select a data point on one of the visuals, all the other visuals on
the page that contain the same data change based on your selection.

By default, selecting a data point in one visual on a report page will cross-filter or cross-
highlight the other visuals on the page. The report designer sets how the visuals on a
page interact. Designers have options to turn visual interactions on and off, and to
change the default cross-filtering, cross-highlighting, and drilling behavior.

If you haven't encountered hierarchies or drilling yet, you can learn all about them by
reading Drill down in Power BI.

How visuals interact with each other

Cross-filter and cross-highlight

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-interactions/interactions.gif


Cross-filtering and cross-highlighting can be useful to identify how one value in your
data contributes to another. The terms cross-filter and cross-highlight are used to
distinguish the behavior described here from what happens when you use the Filters
pane to filter and highlight visuals.

The following report pages show examples of cross-filtering and cross-highlighting. The
Total Category Volume by Segment bar chart has two values, Moderation and
Convenience.

In the following example, Moderation is selected.



Because Moderation is selected on the bar chart:

Cross-filtering removes data that doesn't apply. Selecting Moderation in the bar
chart cross-filters the line chart. The line chart now only displays data points for the
Moderation segment.

Cross-highlighting retains all the original data points but dims the portion that
doesn't apply to your selection. Selecting Moderation in the bar chart cross-
highlights the column chart. The column chart dims all the data that applies to the
Convenience segment and highlights all the data that applies to the Moderation
segment.

If your report has a visual that supports drilling, by default, drilling one visual has
no effect on the other visuals on the report page. However, the report designer can
change this behavior, so check your drillable visuals to see if drilling filters other
visuals has been enabled by the report designer.

Visual-level filters are retained when cross-filtering and cross-highlighting other
visuals on the report page. So, if VisualA has visual-level filters applied by the
report designer or by you, and you use VisualA to interact with VisualB, visual-level
filters from VisualA will be applied to VisualB.

Considerations and troubleshooting



If the tables have no hierarchical relationships, slicing up the measures (often
referred as complex slicers) might result in an error. If you have access to the logs,
you'll see the message "Measures are not allowed with complex slicers unless they
have a filter context change". To avoid this situation, don't use complex slicers or
remodel the relationships to get the desired output.

Take a tour of the report Filters pane

Related content



Slicers in the Power BI service
Article • 01/23/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

A slicer is a type of visual that filters the other visuals on a report page. When using
Power BI reports, you'll discover many types of slicers. The image, above, shows the
same slicer but with different selections. Notice how each selection filters the other
visuals on the page.

When creating reports, designers add slicers to help tell a story and to give you tools to
explore your data.

The numeric range slicer helps you explore quantitative data such as total sales by:
geography, units in stock, and order date. Use the handles to select a range.

How to use slicers

Numeric range slicer



In a basic checkbox slicer, select one or more checkboxes to see the impact on the other
visuals on the page. To select more than one, use CTRL-select. Sometimes, the report
designer will set the slicer to only allow you to select one value at a time.

Basic vertical checkbox slicer



When the slicer options are images or shapes, making your selections is similar to using
checkboxes. You can choose one or more image or shape to apply the slicer to the other
visuals on the page.

Image and shape slicers



Hierarchy slicer



In a slicer with a hierarchy, use the chevrons to expand and collapse the hierarchy. The
header updates to show your selections.

With emerging fast refresh scenarios, the ability to filter to a smaller window of time can
be very useful. Using the relative time slicer, you can apply time-based filters to any date
or time data in your report. For example, you can use the relative time slicer to show
only video views within the last 2 days, hours, or even minutes.

Relative time slicer



To deactivate a slicer, select the eraser icon.

For more information, see the following articles:

Visualization types in Power BI

Deactivate a slicer

Related content

https://learn.microsoft.com/en-us/power-bi/consumer/end-user-visualizations


Identify and use buttons in the Power BI
service
Article • 06/11/2024

In the reports you receive from colleagues, you might notice buttons and wondered
how to use them. Some buttons have words, some have arrows, others have graphics,
and some even have dropdown menus. This article shows you how to recognize and use
buttons.

For information on how to add buttons to reports, see Create buttons in Power BI
reports.

A button can resemble a shape, image, or icon from a report page. If an action occurs
when you select it, then it's probably a button.

Report creators add buttons on reports to help you with navigation and exploration.
Here are some button types: back, bookmark, arrow, Microsoft Power BI Q&A (Q&A),
help, and blank.

A back button can have an arrow icon. When you select it, Power BI takes you to the
previous page. Back buttons are often used with drill through. Here's an example of the
steps of a back button used with drill through.

1. Select Word in the bar chart and drill through to Market basket analysis.

Recognize a button

Types of buttons

Back buttons

https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-buttons
https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-buttons


2. Power BI opens the Market basket analysis report page and uses the selections
made on the source page to filter what displays on the destination page. In this
example, the Market basket analysis report page is filtered for Word.

3. Select the back button labeled Go back to return to the previous page.



Report designers often include bookmarks with their reports. You can view the list of
report bookmarks by selecting Bookmarks from the upper right corner. When a report
designer adds a bookmark button, it's just an alternate way to navigate to a particular
report page associated with that bookmark. The page has the applied filters and settings
captured by the bookmark. For more information, see Bookmarks in the Power BI
service.

In the following example, the button has a bookmark icon and the bookmark name
Urban.

Bookmark buttons



When selected, the bookmark button takes you to the location and settings defined for
that bookmark. In this example, the bookmark is on the Growth opportunities report
page and it's already cross-filtered for Urban.

Drill through buttons



There are two ways to drill through in the Power BI service. Drilling through takes you to
a different report page. The data on that destination page displays according to the
filters and selections you made on the source page.

One way to drill through in a report is to right-click a data point in a visual, select Drill
through, and choose the destination. For more information on this method, see Back
buttons. The second method report designers use is to add a drill through button. The
button makes the action more obvious and calls attention to important insights.

Drill through buttons can have more than one prerequisite. If you don't fulfill all the
prerequisites, the button doesn't work. Let's look at an example.

Here the drill through button is designed to take you to the Store details page. Hovering
over the button reveals a tooltip with the prerequisites. You need to select both a store
and a product. Until you select one of each, the button remains inactive.

After you select one product (Word) and one store (Leo), the button changes color,
signifying it's now active.

Selecting the drill through button takes you to the Store report page. The Store page
displays according to your filters of Word and Leo.



Drill through buttons can also have dropdown menus that offer a choice of destinations.
After you make your selections on the source report page, select the destination report
page for the drill through. The following example shows the selection change to drill
through to the Market details report page.

Page navigation buttons take you to a different page in the same report. Report
designers often create navigation buttons to tell a story or guide you through the report
insights. In the following example, the report designer added a button on each report
page. The button takes you back to the first page (the top-level summary page) of the
report. The page navigation button is helpful when there are multiple pages in a report.

Page navigation buttons



If you select a Q&A button, it opens the Power BI Q&A Explorer window. The Q&A
window displays on top of the report page and closes when you select the X. For more
information, see Q&A for Power BI business users.

Web URL buttons open a new browser window. Report designers might add this type of
button as a reference source, to link to the corporate website or a help page, or even as
a link to a different report or dashboard. In the following example, the Web URL button
lets you download the source file for the report.

Q&A buttons

Web URL buttons



Feedback

Was this page helpful?

Provide product feedback | Ask the community

Since the page opens in a separate window, to return to the Power BI report, close the
window, or select your Power BI tab.

Bookmarks in the Power BI service
Drill mode in the Power BI service

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi


Bookmarks in the Power BI service
Article • 03/29/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop Requires Pro or Premium license

A bookmark captures the state of a report page. It includes the changes you made to
filters, slicers, and visuals on that page. After the report page is set the way you want,
give it a friendly name. Now you can easily return to that state of the report page. Select
a bookmark, and Power BI takes you back to that view.

There are two types of Power BI bookmarks: personal and report. Report designers add
the report bookmarks. When the designers share their reports with colleagues, the
bookmarks travel with the reports. Everyone who can open and view that report can also
see and use the report bookmarks. Anyone who can open a report can create personal
bookmarks; you don't even need edit permissions. However, if you create personal
bookmarks and share your report, the personal bookmarks don't travel with the report.
Personal bookmarks are for your use only.

Introduction to bookmarks

Types of bookmarks

 Tip

There are some ways for you to share your personal bookmarks with others. See
Share changes later in this article for tips and tricks.



This article explains how to create and use personal bookmarks. It also explains how to
interact with report bookmarks that someone else creates and shares with you. Viewing
shared reports and report bookmarks requires one or both of the following
prerequisites:

a Power BI Pro or a Premium Per User (PPU) license Which license do I have?
a report that is saved in Premium capacity and shared with you.

If you're designing reports and creating report bookmarks for others to use, see Create
report bookmarks.

In the Power BI service and Power BI Desktop, report owners can create report
bookmarks. For more information, read about report bookmarks.
If you have edit permissions for the report, you can quickly build a bookmark
navigation experience. Bookmark navigation is available for both personal and
report bookmarks. Each bookmark converts to a customizable button or dropdown
menu.

There are many uses for personal bookmarks. If you discover an interesting insight and
want to preserve it, create a personal bookmark so you can return later. If you need to
leave and want to preserve your current work, create a personal bookmark. You can
even make a personal bookmark your default view of a report, so each time you return
that view of the report page opens first.

You can also create a collection of personal bookmarks and arrange them in the order
you want. Then you can step through each bookmark in a presentation to highlight a
series of insights that tell a story. This feature works like a slideshow, where you select
an arrow to go forward or backward. There's a limit of 20 personal bookmarks per
report. For more information about creating a bookmark slide show, see Bookmarks as a
slide show.

To open the Bookmarks pane, start on a report page and select the bookmarks icon 
and choose Show more bookmarks.

Other articles about bookmarks

Use personal bookmarks to save insights and
build stories in Power BI

Open the Bookmarks pane

https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-bookmarks
https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-bookmarks
https://learn.microsoft.com/en-us/power-bi/create-reports/button-navigators#bookmark-navigator
https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-bookmarks#bookmarks-as-a-slide-show


If you can view a report, then you can also add personal bookmarks. The maximum
number of personal bookmarks per report is 20. When you create a bookmark, the
following elements are saved with the bookmark:

The current page
Filters
Slicers, including slicer type (for example, dropdown or list) and slicer state
Visual selection state (such as cross-highlight filters)
Sort order
Drill location

If you have edit permissions for a report, you can set and save other elements that are
saved with a bookmark. For example, you can decide which visuals on the page are
visible when the bookmark is selected. To learn more about report bookmarks and the
Selection pane, see Using the Selection pane.

Configure a report page the way you want it to appear in the bookmark. The following
example has filters applied to the default report page:

1. Date is changed to include All dates.

Create personal bookmarks in the Power BI
service

Create two different personal bookmarks

https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-bookmarks


2. Region filter is changed to include only West .
3. A specific data point on the doughnut chart visual is selected. This selection cross-

filters and cross-highlights the other visuals on the report canvas.

1. After your report page and visuals are arranged how you want them, select the

bookmarks icon  and choose Show more bookmarks to open the Bookmarks
pane.

2. From the Bookmarks pane, select Personal bookmarks > Add.

3. The personal bookmark gets a generic name, or you can enter a name. If you want
this bookmarked view to be your default view, select the Make default check box.

4. Select Save. To edit your bookmark, select the ellipses next to the bookmark's
name and choose Update, Make default, Rename, or Delete.



Create the first bookmark

７ Note

You can also add and edit bookmarks directly from the bookmark menu, without
opening the Bookmarks pane.

Create the second bookmark

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-bookmarks/power-bi-personal.png#lightbox#lightbox


1. Open a different report page and create another personal bookmark. The
bookmark in the following example captures the YTD information for the
VanArsdel company.

2. Now that you have two bookmarks, switch between them by selecting the
bookmark in the Bookmarks pane or in the bookmarks menu.

3. To return to the original published view of the report, select the Reset icon, and
then select Reset on the dialog.

To view the report bookmarks created by the report designer, from the Bookmarks
pane, select Report bookmarks.

Open report bookmarks



If the report designer included report bookmarks, they appear under the Report
bookmarks heading. This report page has two report bookmarks: Overview- By
Manager and Overview-By Product.

７ Note

To view shared reports, or to save reports in Premium capacity, you need a Power BI
Pro or Premium Per User license. To learn more, see Licenses and subscriptions for
business users.

Report bookmarks



To present or view bookmarks in order, select View from the Bookmarks pane to begin
a slideshow.

When in View mode, notice the following features:

The name of the bookmark appears in the bookmark title bar, which appears at the
bottom of the canvas.
The bookmark title bar has arrows where you can move to the next or previous
bookmark.
To exit View mode, select Exit from the Bookmarks pane, or select the X in the
bookmark title bar.

Bookmarks as a slideshow



In View mode, you can collapse the Bookmarks pane to provide more space for your
presentation. While in View mode, all visuals are interactive and available for cross-
highlighting, like they are when you interact with them in other modes.

While you can't directly share your personal bookmarks with others, there are some
workarounds. These workarounds require that you have one or both of the following
prerequisites:

Pro or PPU license
Permissions to content saved in a workspace in Premium capacity

Here are a few ways you can share your view with others:

Share your active view. If you have a personal bookmark active when you share a
report, recipients who have read access to the report see the bookmarked version
of that report page. Recipients don't see your bookmark in their "Personal
bookmarks" list. They see the result of your personal bookmark.

This personalized view of the report doesn't override the designer's original report
or the designer's report bookmarks. Sharing with colleagues who don't already
have read access requires reshare permissions. If you're unable to share your view
of the report, contact the report owner to request reshare permission.

When you select Share from the top menu of the report, you can choose to
include your changes.

Share changes



Chat in teams. Like the previous method, with a personal bookmark active, you can
share a report in Microsoft Teams. Select Chat in Teams from the top menu. In the



Share to Microsoft Teams dialog, enter the name of the person, group, or channel
that you want to share to. The URL automatically appears in the Say something
about this box; you can enter additional information and edit the way the report
link appears, and then select Share. For more information, see Share a filtered
Power BI report.

Use the comment feature. With a personal bookmark active, add a comment.
When other users select the comment, they see your personal bookmark view. For
more information, see Add comments to a dashboard or reports.

If you make changes to your personal bookmark after you share a report, it has no effect
on your recipients' view. For example, if you share a report with a 2021 date filter
applied and then change the year to 2022 in your bookmark, your recipient still sees the
2021 filter.

From the upper-right corner of your report canvas, select Reset to default. This action
removes all your changes in the report and sets it back to the designer's last saved view
of the report. Resetting the report doesn't delete the bookmarks.

In this release of personal bookmarks, there are a few considerations and limitations to
keep in mind.

７ Note

To share reports, you will need a Power BI Pro or Premium Per User license, or for
the report to be saved in reserved capacity. To learn more, see Licenses and
subscriptions for business users.

Reset all your changes to a report

Considerations and limitations

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-share-reports


Feedback

Was this page helpful?

Provide product feedback | Ask the community

The bookmark captures the state of the page at the time the bookmark is created.
When someone selects the bookmark, Power BI attempts to show them that
bookmark in its original report state. However, there are situations where showing
the bookmark isn't possible. For example, if the report owner changes the name of
a field that the bookmark uses, Power BI no longer displays visuals, filters, or slicers
that use that field. Certain visuals display no data for the renamed field. Filtered or
sliced visuals revert to the default view.

Most Power BI custom visuals should work well with personal bookmarking. If you
run into trouble with bookmarking and a Power BI custom visual, contact the
creator of that visual, and ask them to add support for bookmarks.

Generally, your personal bookmarks aren't affected if the report designer updates
or republishes the report. However, if the designer makes major changes to the
report, such as removing fields used by a personal bookmark, you'll receive an
error message the next time you attempt to open that bookmark.

Report bookmarks and personal bookmarks created in Power BI Desktop or in the
Power BI service are recognized in the Power BI mobile apps for iOS and Android
tablets and phones, and in the Power BI Windows app. However, you can't create
bookmarks in these apps. For information about using bookmarks in the Power BI
mobile apps and the Power BI Windows app, see Explore reports in the Power BI
mobile apps - bookmarks.

Because personal bookmarks capture the exploration state of the current page,
personal bookmarks don't capture changes to other pages. For example, if you
have sync-slicers in your report and you personalize the sync-slicer to use a
different field and capture a personal bookmark, then the personal bookmark only
captures the slicer change on the current page.

You can create up to 20 bookmarks for a single report.

Personalize visuals in a report

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi
https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-reports-in-the-mobile-apps#bookmarks


Add spotlights to Power BI reports
Article • 02/19/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Use spotlights to draw attention to a specific visual on a report page.

1. Open a report in the Power BI service.

2. Select the visual that you want to highlight. Select the More options (...)
dropdown, then choose Spotlight.

3. The selected visual is highlighted, which causes all other visuals on the page to
fade to near transparency.

Add a spotlight

７ Note

If the spotlight mode is active when you add a bookmark, that mode is
retained in the bookmark.



Display content in more detail: focus mode and full screen mode

Related content



Set alerts on Power BI reports (public
preview)
Article • 02/21/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Premium or Fabric license

With Data Activator, you can set data alerts on the reports that you're interested in
following. Read more about it in What is Data Activator?

You need to have write permission for a workspace with a Fabric capacity license.

You can sign up for a Microsoft Fabric free trial .

1. From the visual context menu or report toolbar, tap a visual in the report, and then
select Set alert.

Prerequisites

Set a data alert



https://learn.microsoft.com/en-us/fabric/data-activator/data-activator-introduction
https://aka.ms/try-fabric
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-set-alerts/set-alert-button.png#lightbox


A pane opens where you can set the measure you want to monitor in that visual,
and the conditions you want to detect.

2. In the Set an alert pane, choose:

A measure to monitor.
A condition to evaluate.
A threshold to pass.

3. Decide whether to be notified by email or in Teams.

4. Save the alert to a workspace with a Fabric capacity license.

5. Select Start my alert, then select Create alert.

Power BI creates a Data Activator reflex and connects it to the data in your Power BI
semantic model. Data Activator automatically starts monitoring your data and notifies
you when the condition is met.

You can further customize the trigger to:

Watch for more complex conditions
Notify different users
Even launch a Power Automate workflow.

For more information, read the Data Activator documentation.



Customize the trigger

https://learn.microsoft.com/en-us/fabric/data-activator/data-activator-introduction
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-set-alerts/set-alert-pane.png#lightbox


Data Activator

Related content

https://learn.microsoft.com/en-us/fabric/data-activator/data-activator-introduction


Personalize visuals in a report
Article • 06/12/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

It's hard to make one visual that satisfies everyone's requirements. So, when a colleague
shares a report with you, you might want to make changes to the visuals—without
having to ask your colleague to make the changes for you.

Maybe you'd like to swap what's on the axis, change the visual type, or add something
to the tooltip. With the Personalize this visual feature, make the changes yourself and
when you have the visual the way you want it, save it as a bookmark to come back to.
You don't even need edit permission for the report.

This feature helps you gain further insights through ad-hoc exploration of visuals on a
Power BI report. The following are some of the modifications that you can make. The
available options vary by visual type.

Change the visualization type.
Swap out a measure or dimension.
Add or remove a legend.
Compare two or more measures.
Change aggregations, and more.

Not only does this feature allow for new exploration capabilities, it also includes ways
for you to capture and share your changes:

Capture your changes.

What you can change



Share your changes.
Reset all your changes for a report.
Reset all your changes for a visual.
Clear out your recent changes.

By personalizing a visual, you can explore your data in many ways, without leaving
report reading view. The following examples show different ways you can modify a
visualization to meet your needs.

1. Open a report in reading view in the Power BI service.

2. In the menu bar for the visual, select the Personalize this visual  icon.

Do you think the data would display better as a Stacked column chart? Change the
Visualization type.

） Important

The ability to personalize a visual must be enabled by the report designer. If you

don't see the Personalize this visual  icon, then the report designer didn't
enable this feature for the current report. Check with the report owner or your
administrator to have the feature enabled. To display contact information for the
report owner, select the name of the report from the Power BI menu bar.

Personalize visuals in the Power BI service

Change the visualization type

Swap out a measure or dimension



Replace the field being used for the X axis or Y axis by selecting the field that you want
to replace, then selecting a different field.

By adding a legend, you can color-code a visual based on a category. In this example,
we're color-coding based on company name.

By using drag and drop, you can change the placement of fields within the same visual
property or even across different visual properties. For example, you can quickly move a
field in the legend to the axis of a visual.

Add or remove a legend

Change the placement of fields



You can also quickly reorder the columns of a table or matrix.

Compare and contrast values for different measures by using the + icon to add multiple
measures for a visual. To remove a measure, select More options (...) and choose
Remove field.

Compare two or more different measures



Change how a measure is computed by changing the aggregation in the Personalize
pane. Select More options (...) and choose the aggregation to use.

Using personal bookmarks, capture your changes so you can return to your
personalized view. Select Bookmarks > Add a personal bookmark and give the
bookmark a name.

Change aggregations

Capture changes



You can also make the bookmark your default view.

If you have reshare and read permissions, when you share the report you can choose to
include your changes. This personalized version doesn't overwrite the author's version.
The colleague who is viewing your personalized report can select Reset to default and
return to the author's version of the report. If the colleague has editing permissions,
they can save your personalized version as a new report.

From the upper-right corner of your report canvas, select Reset to default. Resestting
removes all your changes in the report and sets it back to the author's last saved view of
the report.

Share changes

Reset all your changes to a report



From the menu bar for the visual, select Reset this visual to remove all your changes to
a particular visual and set it back to the author's last saved view of that visual.

Select the eraser icon to clear all changes since you opened the Personalize pane.

Reset all your changes to a visual

Clear recent changes



Currently the feature has a few limitations to be aware of.

Personalize this visual can be turned off for an entire report or for a particular
visual. If you don't have permissions to personalize a visual, check with your Power
BI admin or the report owner. To display contact information for the report owner,
select the name of the report from the Power BI menu bar.
User explorations don't automatically persist. You need to save your view as a
personal bookmark to capture your changes.
This feature is supported in the Power BI mobile apps for iOS and Android tablets
and in the Power BI Windows app. It isn't supported in the Power BI mobile apps
for phones. However, any change to a visual you save in a personal bookmark
while in the Power BI service is respected in all the Power BI mobile apps.

Copy and paste a report visualization
More questions? Ask the Power BI Community

Considerations and limitations

Related content

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-copy-paste
https://community.powerbi.com/
https://community.powerbi.com/
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Explore your data in the Power BI
service (preview)
Article • 06/20/2024

In Power BI, sometimes you just want to do some ad hoc exploration of your data.
Maybe you're an analyst who just got access to a new semantic model or data source,
and you want to spend time learning about it before you build a report off it. Or maybe
you're a business user who needs to answer a specific question about the data to
include in a PowerPoint presentation, but the report you’re using doesn’t answer your
exact question. Creating a new report from scratch in these cases is a big hurdle, when
you just need a quick answer or screenshot for a slide deck.

Introducing the public preview of the new Explore feature, where you have a lightweight
and focused experience to explore your data. Similar to exporting your data and
building a PivotTable in Excel, now directly within Power BI you can quickly launch
Explore to begin creating a pair of a matrix and a visual to get the answers you need
without all the extra complexity of reports.

1. Find a dataset or report you’d like to explore.



Get started

https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/explore-matrix-plus-visual.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/explore-matrix-plus-visual.png#lightbox


2. Have Copilot write an overview of the data

3. Begin exploring by building your matrix or PivotTable by adding fields from the
data pane.

4. Add filters if you need them.

5. Save and share your exploration.

For a given dataset, report, or datamart, begin your exploration by selecting the More
options (…) menu from a workspace list or the data hub list view.

You also see this option in the Data hub details page as part of the Discover business
insights action card:

７ Note

A matrix is like a PivotTable in Excel .

1. Find a dataset or report you’d like to explore

In a report

https://support.microsoft.com/office/create-a-pivottable-to-analyze-worksheet-data-a9a84538-bfe9-40a9-a8e9-f99134456576
https://support.microsoft.com/office/create-a-pivottable-to-analyze-worksheet-data-a9a84538-bfe9-40a9-a8e9-f99134456576


Or you may want to explore the underlying data behind a report. You can begin
exploration from the report More options (…) menu in a workspace list, or the Explore
this data option on the report menu bar.

What if while working with a datamart, you’d like to visualize and explore the subset of
the data produced from an ad-hoc query you just ran. You have the option to use the
new Explore feature to dig into your query results as well.

1. Select Data overview > Create with Copilot.

In a datamart

2. Create an overview of the data with Copilot



Copilot creates a paragraph describing the data.



Regardless of where you start from, when you launch the explore experience you land in
the new focused view. Your data appears in the data pane, and you can edit, drag and
drop, or select fields to start building a matrix or visual.

From a dataset, the Explore experience starts with a matrix. That's often a first step, to
explore by building out a matrix or PivotTable, to better understand what’s available or
get down to the right subset of data before visualizing. On the other hand, if you're
coming from a datamart, you’re coming from a grid view of the data already, so you
start off with a visual instead.

You can expand the visual representation of the matrix on the lower part of the dialog.
This visual maps to the same data as what you show in the matrix. As you modify the

3. Begin exploring by building your matrix or
visual

７ Note

Some users may see the data pane on the left as we experiment with placement to
optimize the experience.



https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/begin-exploration.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/begin-exploration.png#lightbox


fields you're exploring, it automatically updates and selects the best visual for that set of
fields.

If you prefer, you can swap the layout to show the visual and matrix side by side instead
of one on top of the other by using the layout buttons in the top right to adjust the
orientation.





https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/explore-matrix-plus-visual.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/explore-matrix-plus-visual.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/change-layout-view.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/change-layout-view.png#lightbox


To adjust which fields are located on the rows and columns, use the field wells in the
Rearrange data section of the data pane. You only see the field wells of one visual,
either the chart or the matrix. To see the other field wells, select the visual you want to
edit. You know which one you’re editing by the black outline.

Just as when you were editing the matrix and the visual updated automatically, as you
edit the visual, your matrix updates to reflect the same data. This update applies not
only to the fields used, but also interactions like sorting and drilling. Assuming the visual
can accurately reflect the sort or drill state, it updates appropriately.

For example, these visuals have a date hierarchy and you want to drill down to quarters.



https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/rearrange-data-visual-black-outline.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/rearrange-data-visual-black-outline.png#lightbox


When you do so on the visual, the matrix also updates accordingly.

As you build out your exploration, you can also take advantage of a new filtering
experience. Select the Add filter button on the top left to quickly add filters on the fields
already in your visual or pick from any fields in your dataset in the All data section.



７ Note

Certain matrix configurations can't currently be visualized in other chart types.
Depending on the situation, a visual may not be rendered or the sort and drill state
may not apply. For example, if you expand one specific row in the matrix, that won't
apply in the visual, because that interaction within other visual types isn't currently
supported.

4. Add filters if you need them

https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/drill-down-next-level.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/drill-down-next-level.png#lightbox


In this exploration experience, the filters are added as pills at the top of view, so you can
easily see what the current filter state is and quickly modify it on the fly.





5. Save and share your exploration

Save your exploration

https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/add-new-filter-trip-purpose-1.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/add-new-filter-trip-purpose-1.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/apply-filter-trip-purpose-honeymoon-2.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/apply-filter-trip-purpose-honeymoon-2.png#lightbox


To save and share your exploration, select the Save button in the upper-left corner. In
the dialog, you can name the exploration, pick a workspace to save it to, and add a
sensitivity label, if applicable. This will save your current canvas layout (horizontal or
vertical) of the exploration as well.

Now you’re ready to share your exploration with others. Select the Share button in the
upper-right corner. Continue to add your recipients' email addresses and share. You
should be immediately prompted to share the underlying dataset so the recipients can
view the contents of your exploration. If you're not prompted, ensure that you share the
dataset with read permissions.

If you'd like to change your audience, select People in your organization can view.

７ Note

You can only save explorations to workspaces in a Premium capacity at this time.



Share your exploration

https://learn.microsoft.com/en-us/power-bi/connect-data/service-datasets-share
https://learn.microsoft.com/en-us/power-bi/connect-data/service-datasets-share
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/save-exploration.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/explore-data-service/save-exploration.png#lightbox


Choose your audience and their permissions, and select Apply. Provide email addresses
and a message, then select Send.

Or select Copy link and send it by another means.

You may want to save your exploration as a report instead. You can do so by choosing
Save, then Save as report. This saves your exploration as a single page report matching
the layout when saved. For example, if you're viewing both the matrix and the visual,
you get one page with a matrix on the top half and the visual on the bottom half of the
page.

You can share this new report as with other reports by using the Share button.

Exploration authors need build permissions on the dataset to create an exploration
and open the Explore dialog.

７ Note

Usually for reports, sharing the underlying dataset is done behind the scenes.

Considerations and limitations

To create



When you save, the destination workspace must be in a Premium capacity.
Changing a sensitivity label on a dataset doesn't currently propagate down to the
exploration that you create for it.
There is currently a known issue when you attempt to save an exploration from the
Datamart SQL editor entry point.
Explore isn't currently supported for streaming datasets.
If you save to My workspace, you may need to refresh your page to see the newly
saved exploration artifact.

Exploration users need a Power BI Pro or PPU license to share.
When you share your exploration, you also need to grant build permissions to the
underlying dataset so your recipients can view the exploration. If you skip this
second step, your recipients can't see the exploration, and have to request
permissions.
Explorations aren't currently shown in lineage view as related to the dataset.

Currently, you can't open an exploration on a mobile device in the Power BI mobile
app.

Explore isn't currently available from datasets and reports on the Power BI service Home
or Create pages.

All native visuals are supported with the exception of these visuals:

Matrix
Slicers
Q&A
Smart narratives
Metrics
Paginated reports
Power Apps
Power Automate

To share

To open a saved exploration

Entry points

Supported visuals



Feedback

Was this page helpful?

Provide product feedback | Ask the community

Personalize visuals in a report

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi


Use the Analyze feature to explain
fluctuations in report visuals
Article • 02/23/2023

APPLIES TO: 
Power BI service for business users 
Power BI service for designers
& developers 
Power BI Desktop 
Requires Pro or Premium license

When there are large increases and sharp drops in values on report visuals, you might
wonder about the cause of such fluctuations. With Analyze in the Power BI service, you
can easily find the reason.

For example, consider the following visual that shows Total units by Month and
Manufacturer. VanArsdel is outperforming its competitors but has a deep dip in June
2014. In such cases, you can explore the data and help explain the change that occurred.

You can ask the Power BI service to explain increases, decreases, or unusual distributions
in visuals, and get fast, automated, insightful analysis about your data. Right-click on a
data point, select Analyze > Explain the decrease (or increase if the previous bar was
lower), or Analyze > Find where this distribution is different. Then the insight is
displayed in an easy-to-use window.



The Analyze feature is contextual, and is based on the immediately previous data point
—such as the previous bar or column.

After examining different columns, Power BI selects and displays those factors that show
the biggest change to relative contribution. For each, the values that have the most
significant change to contribution are called out in the description. In addition, the
values that have the largest actual increases and decreases are also called out.

To see all of the insights generated by Power BI, use the scrollbar. The order is ranked
with the most significant contributor displayed first.

To use insights to explain trends seen on visuals, right-click on any data point in a bar or
line chart and select Analyze. Then choose an option that appears: explain the increase,
explain the decrease, or explain the difference.

Power BI then runs its machine learning algorithms over the data and populates a
window with a visual and a description. The description details which categories most
influenced the increase, decrease, or difference. In the following example, the first
insight is a waterfall chart.

７ Note

This feature is in preview, and is subject to change. The insight feature is enabled
and on by default (you don't need to check a Preview box to enable it).

Which factors and categories are chosen

Using insights



Select the small icons at the bottom of the waterfall visual to have insights display a
scatter chart, stacked column chart, or ribbon chart.

Use the thumbs up and thumbs down icons at the top of the page to provide feedback
about the visual and the feature.



You can use insights when your report is in Reading or Editing view. It's versatile for
analyzing data and creating visuals you can easily add to your reports. If the report is
open in Editing view, you see a plus icon next to the thumb icons. Select the plus icon to
add the insight to your report as a new visual.

The details returned by insights are intended to highlight the differences between the
two time periods to help you understand the change between them.

You can think of the algorithm like this—it takes all the other columns in the model and
calculates the breakdown by that column (for the before and after time periods) to
determine how much change occurred in that breakdown. Then returns those columns
with the biggest change. In the previous example, State is selected in the waterfall
insight, as the contribution made by Louisiana, Texas, and California fell from 13% to
19% from June to July. This change contributed the most to the decrease in Total units.

For each insight returned, there are four visuals that can be displayed. Three of those
visuals are intended to highlight the change in contribution between the two periods,
such as the explanation of the increase from Qtr 2 to Qtr 3. The ribbon chart shows
change both before and after the selected data point.

Details of the results returned

The scatter plot



The scatter plot visual shows the value of the measure in the first period (x-axis) against
the value of the measure in the second period (y-axis) for each value of the column
(State in this case). Data points are in the green region if they've increased and in the
red region if they've decreased.

The dotted line shows the best fit, and data points above this line increased by more
than the overall trend and those below it by less.

Data items whose value was blank in either period won't appear on the scatter plot.

The 100% stacked column chart visual shows the value of the contribution to the total
(100%) for the selected data point and the previous. This allows side-by-side
comparison of the contribution for each data point. In the following example, tooltips

The 100% stacked column chart



shows the actual contribution for the selected value of Texas. Because the list of states is
long, tooltips helps you see the details. With the use of tooltips, you see that Texas
contributed about the same percent to the total units (31% and 32%), but the actual
number of total units decreased from 89 to 71. Remember, the Y axis is a percentage,
not a total, and each column band is a percentage, not a value.

The ribbon chart visual shows the value of the measure before and after. It helps show
the changes in contributions when the ordering of contributors changed (for example,
LA dropped from number two contributor to number eleven). TX is represented by a
wide ribbon at the top, signifying that it is the most significant contributor before and
after. The drop shows that the value of the contribution dropped both during the
selected period and after.

The ribbon chart



The fourth visual is a waterfall chart, showing actual increases or decreases between the
periods. This visual clearly shows one significant contributor to the decrease for June
2014—in this case, State. And the particulars of State's influence on total units are that
declines in Louisiana, Texas, and Colorado played the most significant role.

The waterfall chart



Since these insights are based on the change from the previous data point, they aren't
available when you select the first data point in a visual.

The Analyze feature isn't available for all visual types.

The following list is the collection of currently unsupported scenarios for the Analyze
feature (Explain the increase, Explain the decrease, Find where the distribution is
different):

TopN filters
Include or exclude filters.
Measure filters
Non-numeric measures

Considerations and limitations



Use of "Show value as."
Filtered measures. Filtered measures are visual level calculations with a specific
filter applied (for example, Total Sales for France) and are used on some of the
visuals created by the insights feature.
Categorical columns on X-axis unless it defines a sort by column that is scalar. If
using a hierarchy, then every column in the active hierarchy has to match this
condition.
RLS or OLS enabled data models

Waterfall charts in Power BI
Scatter charts, bubble charts, and dot plot charts in Power BI
Visualizations in Power BI reports
Create ribbon charts in Power BI

Next steps

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-waterfall-charts
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-scatter
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-report-visualizations
https://learn.microsoft.com/en-us/power-bi/visuals/desktop-ribbon-charts


Visualization types in Power BI
Article • 06/05/2024

APPLIES TO:  Power BI Desktop  Power BI service

A visualization is an image created from data. Visualizations are also called "visuals."
Some examples of visuals are: pie chart, line chart, map, and KPI. This article lists
visualizations available in Power BI. We add new visualizations. Stay tuned!

And check out the Microsoft AppSource , where you find a growing list of Power BI
visuals you can download and use in your own dashboards and reports. Feeling
creative? Learn how to create and add your own visuals to this community site.

All of these visualizations can be added to Power BI reports, specified in Q&A, and
pinned to dashboards.

The basic area chart is based on the line chart with the area between the axis and line
filled in. Area charts emphasize the magnitude of change over time, and can be used to
draw attention to the total value across a trend. For example, data that represents profit
over time can be plotted in an area chart to emphasize the total profit. On the other
hand, stacked area charts display the cumulative total of multiple data series stacked on
top of each other, showing how each series contributes to the total.

Visualizations in Power BI

Area charts: Basic (Layered) and Stacked

https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals
https://appsource.microsoft.com/marketplace/apps?product=power-bi-visuals
https://learn.microsoft.com/en-us/power-bi/developer/visuals/power-bi-custom-visuals
https://learn.microsoft.com/en-us/power-bi/developer/visuals/power-bi-custom-visuals
https://learn.microsoft.com/en-us/power-bi/developer/visuals/office-store


For more information, see Basic Area chart.

Bar charts are the standard for looking at a specific value across different categories.

Bar and column charts

Cards

Multi row

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-basic-area-chart


Multi row cards display one or more data points, one per row.

Single number cards display a single fact, a single data point. Sometimes a single
number is the most important thing you want to track in your Power BI dashboard or
report, such as total sales, market share year over year, or total opportunities.

For more information, see Create a Card (big number tile).

Single number

Combo charts

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-card


A combo chart combines a column chart and a line chart. Combining the two charts into
one lets you make a quicker comparison of the data. Combo charts can have one or two
Y axes, so be sure to look closely.

Combo charts are a great choice:

When you have a line chart and a column chart with the same X axis.
To compare multiple measures with different value ranges.
To illustrate the correlation between two measures in one visual.
To check whether one measure meets the target, which is defined by another
measure.
To conserve canvas space.

For more information, see Combo charts in Power BI.

The decomposition tree visual lets you visualize data across multiple dimensions. It
automatically aggregates data and enables drilling down into your dimensions in any

Decomposition tree



https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-combo-chart
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/power-bi-decomposition-expanded.png#lightbox
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/power-bi-decomposition-expanded.png#lightbox


order. It is also an artificial intelligence (AI) visualization, so you can ask it to find the
next dimension to drill down into based on certain criteria. This capability makes it a
valuable tool for ad hoc exploration and conducting root cause analysis.

Doughnut charts are similar to pie charts. They show the relationship of parts to a
whole. The only difference is that the center is blank and allows space for a label or icon.

For more information, see Doughnut charts in Power BI.

Funnels help visualize a process that has stages, and items flow sequentially from one
stage to the next. One example is a sales process that starts with leads and ends with

Doughnut charts

Funnel charts

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-doughnut-charts


purchase fulfillment.

For example, a sales funnel that tracks customers through stages: Lead > Qualified Lead
> Prospect > Contract > Close. At a glance, the shape of the funnel conveys the health
of the process you're tracking. Each funnel stage represents a percentage of the total.
So, in most cases, a funnel chart is shaped like a funnel -- with the first stage being the
largest, and each subsequent stage smaller than its predecessor. A pear-shaped funnel
is also useful -- it can identify a problem in the process. But typically, the first stage, the
"intake" stage, is the largest.

For more information, see Funnel Charts in Power BI.

A radial gauge chart has a circular arc and displays a single value that measures
progress toward a goal. The goal, or target value, is represented by the line (needle).
Progress toward that goal is represented by the shading. And the value that represents
that progress is shown in bold inside the arc. All possible values are spread evenly along
the arc, from the minimum (left-most value) to the maximum (right-most value).

In the example, we are a car retailer, tracking our Sales team's average sales per month.
Our goal is 200,000 and represented by the location of the needle. The minimum
possible average sales is 100,000 and we set the maximum as 250,000. The blue shading
shows that we're currently averaging approximately $180,000 this month. Luckily, we still
have another week to reach our goal.

Radial gauges are a great choice to:

Show progress toward a goal.

Gauge charts

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-funnel-charts


Represent a percentile measure, like a KPI.
Show the health of a single measure.
Display information that can be quickly scanned and understood.

For more information, see Gauge Charts in Power BI.

A key influencer chart displays the major contributors to a selected result or value.

Key influencers are a great choice to help you understand the factors that influence a
key metric. For example, what influences customers to place a second order or why were
sales so high last June.

For more information, see Key influencer charts in Power BI

Key influencers chart



KPIs

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-radial-gauge-charts
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-influencers
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/power-bi-influencer-expanded.png#lightbox
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/power-bi-influencer-expanded.png#lightbox


A Key Performance Indicator (KPI) is a visual cue that communicates the amount of
progress made toward a measurable goal.

KPIs are a great choice:

To measure progress (what am I ahead or behind on?).
To measure distance to a metric (how far ahead or behind am I?).

For more information, see KPIs in Power BI.

Line charts emphasize the overall shape of an entire series of values, usually over time.

Line charts

Maps

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-kpi


Use a basic map to associate both categorical and quantitative information with spatial
locations.

For more information, see Tips and tricks for map visuals.

The combination of ArcGIS maps and Power BI takes mapping beyond the presentation
of points on a map to a whole new level. The available options for base maps, location
types, themes, symbol styles, and reference layers creates gorgeous informative map
visuals. The combination of authoritative data layers (such as census data) on a map
with spatial analysis conveys a deeper understanding of the data in your visual.

For more information, see ArcGIS maps in Power BI.

Basic map

ArcGIS map

Azure map

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-map-tips-and-tricks
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualizations-arcgis


For more information, see Azure Maps visual for Power BI.

A filled map uses shading or tinting or patterns to display how a value differs in
proportion across a geography or region. Quickly display these relative differences with
shading that ranges from light (less-frequent/lower) to dark (more-frequent/more).

For more information, see Filled Maps in Power BI.

 Tip

Used to associate both categorical and quantitative information with spatial
locations.

Filled map (Choropleth)

 Tip

The more intense the color, the larger the value.

https://learn.microsoft.com/en-us/azure/azure-maps/power-bi-visual-getting-started?context=/power-bi/create-reports/context/context
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-filled-maps-choropleths


Shape maps compare regions on a map using color. A shape map can't show precise
geographical locations of data points on a map. Instead, its main purpose is to show
relative comparisons of regions on a map by coloring them differently.

For more information, see Shape Maps in Power BI.

The matrix visual is a type of table visual (see Tables in this article) that supports a
stepped layout. A table supports two dimensions, but a matrix makes it easier to display
data meaningfully across multiple dimensions. Often, report designers include matrixes
in reports and dashboards to allow users to select one or more element (rows, columns,
cells) in the matrix to cross-highlight other visuals on a report page.

For more information, see Matrix visuals in Power BI.

Shape map

Matrix



 Tip

The matrix automatically aggregates the data and enables drilling down into the
data.

Pie charts

https://learn.microsoft.com/en-us/power-bi/visuals/desktop-shape-map
https://learn.microsoft.com/en-us/power-bi/visuals/desktop-matrix-visual
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/matrix-expanded.png#lightbox
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/matrix-expanded.png#lightbox


Pie charts show the relationship of parts to a whole.

Report designers can create a Power App and embed it into a Power BI report as a
visual. Consumers can interact with that visual within the Power BI report.

For more information, see Add a Power Apps visual to your report.

Power Apps visual

Q&A visual

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-powerapp


The Q&A visual provides users with a text box to query data in Power BI reports. Users
can use natural language to query data, and the Q&A visual interprets the query and
provides an appropriate visualization.

For example, if a user asks a question like "What were the product sales in 2019?" the
Q&A visual queries the relevant data and create an appropriate visualization to display
the results. This visualization can be in many different formats, such as a chart or a table.

For more information, see Q&A visuals in Power BI.

 Tip

Similar to the Q&A experience on dashboards, the Q&A visual lets you ask
questions about your data using natural language.

R script visuals

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-q-and-a
https://learn.microsoft.com/en-us/power-bi/create-reports/power-bi-tutorial-q-and-a


For more information, see R visuals in Power BI.



 Tip

Visuals created with R scripts, commonly called R visuals, can present advanced
data shaping and analytics such as forecasting, using the rich analytics and
visualization power of R. R visuals can be created in Power BI Desktop and
published to the Power BI service.

Ribbon chart

https://learn.microsoft.com/en-us/power-bi/visuals/service-r-visuals
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/power-bi-r-visual-expanded.png#lightbox
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/power-bi-r-visual-expanded.png#lightbox


Ribbon charts show which data category has the highest rank (largest value). Ribbon
charts are effective at showing rank change, with the highest range (value) always
displayed on top for each time period.

For more information, see Ribbon charts in Power BI.

A scatter chart always has two value axes to show one set of numerical data along a
horizontal axis and another set of numerical values along a vertical axis. The chart
displays points at the intersection of an x and y numerical value, combining these values
into single data points. These data points might be distributed evenly or unevenly across
the horizontal axis, depending on the data.

A bubble chart replaces data points with bubbles, with the bubble size representing an
additional dimension of the data.

Scatter

Scatter, bubble, and dot plot chart

https://learn.microsoft.com/en-us/power-bi/visuals/desktop-ribbon-charts


Both scatter and bubble charts can also have a play axis, which can show changes over
time.

A dot plot chart is similar to a bubble chart and scatter chart except that it can plot
numerical or categorical data along the X axis. This example happens to use squares
instead of circles and plots sales along the X axis.



For more information, see Scatter charts in Power BI.

By definition, high-density data is sampled to quickly create visuals that are responsive
to interactivity. High-density sampling uses an algorithm that eliminates overlapping

Scatter-high density



https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-scatter
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/density-scatter-expanded.png#lightbox
https://learn.microsoft.com/en-us/power-bi/visuals/media/power-bi-visualization-types-for-reports-and-q-and-a/density-scatter-expanded.png#lightbox


points, and ensures that all points in the data set are represented in the visual. It doesn't
just plot a representative sample of the data.

This ensures the best combination of responsiveness, representation, and clear
preservation of important points in the overall data set.

For more information, see High Density Scatter charts in Power BI.

A slicer is a standalone chart that can be used to filter the other visuals on the page.
Slicers come in many different formats (category, range, date, etc.) and can be formatted
to allow selection of only one, many, or all of the available values.

Slicers are a great choice to:

Display commonly used or important filters on the report canvas for easier access.
Make it easier to see the current filtered state without having to open a drop-down
list.
Filter by columns that are unneeded and hidden in the data tables.
Create more focused reports by putting slicers next to important visuals.

For more information, see Slicers in Power BI.

Slicers

Smart narrative

https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-high-density-scatter-charts
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-slicers


The Smart narrative adds text to reports to point out trends, key takeaways, and add
explanations and context. The text helps users to understand the data and identify the
important findings quickly.

For more information, see Create smart narrative summaries.

A standalone image is a graphic that is added to a report or dashboard.

For more information, see Add an image widget to a dashboard.

Standalone images

Tables

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-smart-narrative
https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-add-widget


A table is a grid that contains related data in a logical series of rows and columns. It
might also contain headers and a row for totals. Tables work well with quantitative
comparisons where you are looking at many values for a single category. For example,
this table displays five different measures for Category.

Tables are a great choice:

To see and compare detailed data and exact values (instead of visual
representations).
To display data in a tabular format.
To display numerical data by categories.

For more information, see Working with tables in Power BI.

Treemaps are charts of colored rectangles, with size representing value. They can be
hierarchical, with rectangles nested within the main rectangles. The space inside each
rectangle is allocated based on the value being measured. And the rectangles are
arranged in size from top left (largest) to bottom right (smallest).

Treemaps are a great choice:

To display large amounts of hierarchical data.
When a bar chart can't effectively handle the large number of values.
To show the proportions between each part and the whole.
To show the pattern of the distribution of the measure across each level of
categories in the hierarchy.
To show attributes using size and color coding.

Treemaps

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-tables


To spot patterns, outliers, most-important contributors, and exceptions.

For more information, see Treemaps in Power BI.

A waterfall chart shows a running total as values are added or subtracted. It's useful for
understanding how an initial value (for example, net income) is affected by a series of
positive and negative changes.

The columns are color coded so you can quickly tell increases and decreases. The initial
and the final value columns often start on the horizontal axis, while the intermediate
values are floating columns. Because of this "look", waterfall charts are also called bridge
charts.

Waterfall charts are a great choice:

When you have changes for the measure across time or across different categories.
To audit the major changes contributing to the total value.
To plot your company's annual profit by showing various sources of revenue and
arrive at the total profit (or loss).
To illustrate the beginning and the ending headcount for your company in a year.
To visualize how much money you make and spend each month, and the running
balance for your account.

For more information, see Waterfall charts in Power BI.

Waterfall charts

Related content

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-treemaps
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-waterfall-charts
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Visualizations in Power BI reports
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for your data
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https://www.sqlbi.com/ref/power-bi-visuals-reference/


Drill mode in the Power BI service
Article • 12/25/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

This article shows you how to use the drill mode in the Microsoft Power BI service. You
can explore in-depth details about your data by using the drill-down, drill-up, and
expand features on your visual. To learn how to create a hierarchy, read hierarchies in
Power BI

To use the drill mode, the Power BI visual must have an explicit or implicit hierarchy.
Report designers often add explicit date hierarchies to reports. Those hierarchies are
marked with the hierarchy icon. A common date hierarchy is one that contains fields for
the year, quarter, month, and day. A report might have implicit hierarchies too. These
informal hierarchies don't have the icon. But the relationship, and therefore a drill path,
exists. For example, you might have a visual that shows the number of medals won in a
sports competition. The drill path in this example is the sport, which has specific unique
types of the sport, and the events. By default, the visual shows the medal count by sport,
like gymnastics, skiing, and aquatics. Then, you can select one of the visual elements,
like a bar, line, or bubble, to display the individual sports. For example, selecting the
aquatics element shows you data for swimming, diving, and water polo. Then, selecting
the diving element opens the next level in the hierarchy and shows you details for
springboard, platform, and synchronized diving events.

You can tell if a visual has a hierarchy by hovering over it. If the drill control options
appear in the action bar, your visual has a hierarchy.

The following example is a bar chart that has a hierarchy made up of category,
manufacturer, segment, and product. The bar chart shows the total number of units sold
in the year 2014 by category. Category is the top level of the hierarchy. The chart is
filtered by the categories Rural and Urban.

Drill mode requirements

Drill down and up

https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-inline-hierarchy-labels


There are two ways to access the drill-down, drill-up, and expand features for visuals.

One way is to hover over a visual to use the icons in the action bar. Turn on the drill-
down option by selecting the single downward arrow. The grey background indicates
that the drill-down option is turned on.

Another way to access the drill features is by right-clicking a data point on the visual to
open a menu with available options.

Ways to access the drill features



There are many ways to drill into your visual. Selecting the double arrow drill-down icon

 takes you to the next level in the hierarchy. For example, if you're at the category
level, you can drill down to the manufacturer level, then the segment level, and, finally,
the product level for all categories. Each step in the path shows you new information.

To go up a level in the hierarchy, select the drill-up icon. 

Drill down all fields at once



Drill down one field at a time

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-drill/power-bi-drill-path.png#lightbox#lightbox


The double arrow drill-down icon drills down all fields on the canvas at once. This
example shows how to drill down one field at a time.

1. From the category level, where the chart shows Rural and Urban, select the drill-

down icon  to turn it on.

Now you have the option of drilling down one field at a time by selecting a visual
element, like a bar, bubble, or leaf.

2. Select the bar for Rural. The bar chart now shows all the Rural manufacturers.

3. At this point, you can:

Continue drilling down for Rural.

７ Note

If you don't turn on the drill-down option and you select a visual element, it
cross-filters the other charts on the report page rather than drilling down.



Drill down for a particular Rural manufacturer.

Expand.

Continue to drill down one field at a time by selecting Natura. The bar chart now
shows the segments for the Natura manufacturer in the Rural category.

Notice that the title changes to show which level you are on as you drill down and
back up again.

4. Drill down to the products by selecting the Productivity bar. Now you are at the
product level.



The Expand option adds another hierarchy level to the current view. If you're at the
category level, which shows Rural and Urban, you can expand all current bars at the
same time. The first time you expand, the manufacturer is added for both Rural and
Urban. Expand again and, in addition to the manufacturer, segment data is added for
both Rural and Urban. Each step in the path shows the previous information and adds
on one level of new information.

The following example shows how to use this feature to expand all fields at one time.

1. From the previous step, select the drill-up arrow until you reach the second level,
Total Units by Category and Manufacturer.



Expand fields



Expand all fields at once

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-drill/power-bi-drill-last.png#lightbox#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-drill/power-bi-expand-path.png#lightbox#lightbox


2. Confirm that the drill-down option  is still turned on and select the expand

down icon.  The bar chart shows more detail. It now shows category,
manufacturer, and segment.

3. Select the expand down icon  one more time to display all four hierarchy levels
of detail for Rural. To see more detail, hover over a bar.



To get detailed data for one field, you can expand down one level in the hierarchy.

1. From the previous step, select the drill-up icon until you reach the category level.

2. With the drill-down icon turned off, select the Rural bar, and then select the

expand down icon. 

On the next level, the data for the field you selected is emphasized.



Expand one field at a time

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-drill/power-bi-expand-final.png#lightbox#lightbox


When you drill down, you only go to the next level of the hierarchy. When you expand,
you go to the next level of the hierarchy while also preserving the data of the level
you're on.

Use Show as a table to get a look behind the scenes. Each time you drill or expand,
Show as a table displays the data used to build the visual. This feature makes it easier to
see how hierarchies, drill, and expand work together to build visuals.

1. In the upper right corner, select More options (...), and then select Show as a table.

Show the data in a table as you drill



The data that makes up the bar chart appears below the visual.

2. Select the double arrow icon to drill down all fields at once. Watch the data in the
table change to reflect the data that's being used to create the bar chart. The
following table shows the results of drilling down all fields at once from the
category level to the product level.

The first table represents the top level of the hierarchy. It shows the categories
Rural and Urban. The next three tables represent the bar chart's data as you drill
down all levels at once, from category to manufacturer to segment to product.



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-drill/power-bi-show-table.png#lightbox#lightbox


By default, drilling doesn't filter other visuals in a report, but the report designer
can change this setting. As you drill, look to see if the other visuals on the page are
cross-filtering or cross-highlighting.

To view a report that is shared with you, a Power BI Pro or Premium license is
required, or the report must be stored in Power BI Premium capacity. For more
information, see Find out which licenses you have.

Using inline hierarchies

Set and use date tables

Power BI - Basic Concepts

More questions? Visit the Power BI Community



Considerations and limitations

Related content

https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-inline-hierarchy-labels
https://learn.microsoft.com/en-us/power-bi/transform-model/desktop-date-tables
https://community.powerbi.com/
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-drill/power-bi-show-data.png#lightbox#lightbox


Interact with an ArcGIS map in Power BI
Article • 03/09/2023

This article describes different ways a business user can consume ArcGIS Maps in the
Power BI service. ArcGIS Maps in Power BI is also available on Power BI Desktop and
mobile. Once a creator shares an ArcGIS map with you, there are many ways to interact
with that map. For more information, see Create ArcGIS maps in Power BI.

ArcGIS for Power BI is a map visualization used to enrich data, reports, and dashboards.
ArcGIS for Power BI adds geographic, location, and regional demographic data, smart
map themes, and analytic features such as drive time, infographics, and points of
interest. Combining authoritative data layers on an ArcGIS for Power BI map with spatial
analysis provides more complex insight onto your Power BI data.

For example, you can use ArcGIS for Power BI to provide regional insight into sales
figures. The following ArcGIS map shows regional sales by size against a demographic
layer of the 2020 Esri Diversity Index. An interactive tooltip for Lancaster County shows
total population, household population, and total households for the selected area.

 Tip

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualizations-arcgis


Here are some things you should know if this is your first time using ArcGIS for Power BI.
ArcGIS Maps for Power BI is provided by Esri . Your use of ArcGIS Maps for Power BI is
subject to Esri's terms  and privacy policy . Power BI users wanting to use the ArcGIS
Maps for Power BI visuals need to accept the consent dialog.

The features available depend on whether you're the report designer (person who made
the map) or a business user (someone shared an ArcGIS map with you). If you're
interacting with an ArcGIS map as a business user, you're more likely to use Reading
view to consume ArcGIS Maps in the Power BI serve. Here are the actions available to
you:

Action Premium customer (with view
permissions)

Power BI Pro
customer

View the data used to create the
visual

Y Y

Subscribe for reports and dashboards Y Y

See the map in focus mode and full
screen mode

Y Y

View related content Y Y

Interact with the filters set by the
report designer

Y Y

Share the report Y Y

Export the underlying data N Y

Get usage metrics N Y

Publish to the web N Y

Save a copy N Y

To learn more, explore Esri's Get Started page for the ArcGIS for Power BI visual ,
or visit Esri's Marketing site  to see examples and read testimonials. For training
and documentation, see Esri's online help .

User consent

Interact with an ArcGIS map

http://www.esri.com/
https://go.microsoft.com/fwlink/?LinkID=826322
https://go.microsoft.com/fwlink/?LinkID=826323
https://learn.microsoft.com/en-us/power-bi/consumer/end-user-show-data
https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-subscribe
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-share-reports
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-export-data
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-usage-metrics
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-publish-to-web
https://doc.arcgis.com/en/power-bi/use/explore-maps.htm
https://www.esri.com/powerbi
https://doc.arcgis.com/en/maps-for-powerbi/get-started/about-maps-for-power-bi.htm


When you first open an ArcGIS for Power BI map visualization in Reading view, the Map
tools button is typically collapsed.

Select the map tools button 
to expand the tools.

The map tools expand to show the available options. When selected, each tool opens a
task pane that provides detailed options.

There are multiple ways to select locations on the map. The options available depend on
the type of layer selected. If the map contains more than one layer, the selection tool
will apply the action to the active layer. A maximum of 250 data points can be selected
at a time. For more information, see Select locations on the map .

Display the Map tools

 Tip

Esri provides comprehensive documentation about using ArcGIS for Power BI .

Select locations

https://doc.arcgis.com/en/power-bi/use/select-features-on-the-map.htm
https://go.microsoft.com/fwlink/?LinkID=828772



Single select. This is the default tool. You can select individual data points and
individual features.


Select by rectangle. With this tool, you can draw a rectangle on the map and select
the contained data points and features. Use CTRL to add or remove selections.


Select by circle. With this tool, you can draw a circular shape on the map and select
the contained data points and features. Use CTRL to add or remove selections.


Select by polygon. With this tool, you can draw boundaries or polygons within
reference layers to select contained data points and features. Double-click your mouse
to complete a selection. Use CTRL to enable snapping.


Select by freehand polygon. With this tool, you can draw a freehand shape on the
map and select the contained data points and features. Use CTRL to add or remove
selections.


Select by reference layer. This tool is only visible if there's a reference layer on the
map and that reference layer is the active layer. Select features on the reference layer to
highlight them. For more information, see Work with map layers—ArcGIS for Power BI .


Drive time select This tool is only visible if there's a search area layer (buffer or drive
time area) on the map and the search area layer is the active layer. Draw to select data
points and features within the defined area. For more information, see Find Nearby
Locations .


The eraser tool. This tool clears all selections. It's only active after selections have
been made on the map.

Pin a specific address, place, or point of interest on the map. In this example, we're
looking for the Washington Monument.

1. Expand the map tools 
and select the Search button 
to open the search pane.
2. Type the keywords Washington Monument in the search field.
Keywords can

include an address, place, or point of interest. As you type, recent searches or
suggestions based on similar keywords appear.

3. From the results list, choose Washington Monument, 2 15th St NW, Washington
DC 20024 USA and select Close. A symbol appears on the map, and the map
automatically zooms to the location, pinning it during your session. Pins remain in
place on the map only during the current session. You can't save a pinned location
with the map.
For more information, see Pin a location—ArcGIS for Power BI .

Pin a location

https://doc.arcgis.com/en/power-bi/use/work-with-map-layers.htm
https://pro.arcgis.com/en/pro-app/latest/tool-reference/business-analyst/find-nearby-locations.htm
https://doc.arcgis.com/en/power-bi/use/pin-locations.htm


As a business user, you can show or hide a layer, change the sequence in which a layer is
shown, and zoom to a layer’s data boundaries. To view your map’s layers, follow these
steps:

Expand the map tools 
and select the Layers button 
to open the Layers pane.

To hide a layer, select the Hide button.

To show a hidden layer, select the Show button 
.

To change the sequence in which a layer is shown on the map, for example, to
display a Demographic reference layer on top of the data layer, drag the reference
layer to the top of the list of layers in the Layers pane.

To zoom to the extent of the layer’s data boundaries, select More options (...) and
select Zoom to layer.

You can also use the Filters pane to filter layer content on your ArcGIS for Power BI map
based on the available data added by the report designer.

For more information about working with layers, visit Work with map layers—ArcGIS for
Power BI .

The Filters pane contains data added by the report designer. There are many different
ways to filter your map content.

1. Expand the Filters pane to the right of the map visualization.

View, show, or hide layers

７ Note

If you find that you can't perform these tasks, it may be that the report designer
has disabled these features. Contact the report designer if you have questions.

Filter map layers

https://doc.arcgis.com/en/power-bi/use/work-with-map-layers.htm


2. Select fields to filter the map. Use Basic filtering, to choose from data shown on
the map. Use Advanced filtering to narrow content by specific parameters.



3. Some filters have value parameters (Boolean) available.

4. When you've selected your filter options, select Apply filter.
The map is filtered by
your selections.



A basemap provides a background, or visual context, for the data in a map. For example,
a basemap that shows streets can provide context for address data. As a Power BI
business user, there are four basemaps provided: Dark Gray Canvas, Light Gray Canvas,
OpenStreetMap, and Streets.

To change the basemap, follow these steps:

1. Expand the map tools 
and select the Basemap button 
to display the gallery
of available basemaps.

2. Select the Dark Gray Canvas basemap.

3. The map updates to the new basemap. For more information, see Change the
basemap—ArcGIS for Power BI .

Change the basemap

７ Note

For access to basemaps, the report designer must make them available when
designing the report. If the basemaps are unavailable, you will not see the Basemap
button in the Map tools.

https://doc.arcgis.com/en/power-bi/use/change-the-basemap.htm


This tool option appears only if the report designer includes data to perform a Find
Similar analysis. For more information on the features of the Analysis tools, see Create
ArcGIS in Power BI.


Infographics. With this tool, you can provide interactive cards with specific details
about the areas on the map.


Reference Layer. With this tool, you can add a demographic layer to help
contextualize your data from Power BI or add a reference layer from ArcGIS to enrich
your data.


Buffer/Drive time. With this tool, you can find locations on your map within a specific
distance, or ring buffer, of the point of origin.


Find similar. With this tool, you can quickly identify locations with attributes
comparable to those locations currently selected on the map.

Esri provides comprehensive online documentation for ArcGIS for Power BI.
To access
the ArcGIS for Power BI online help from the visualization, follow these steps:

1. Expand the map tools 
and select the Settings button 
.

2. In the Settings pane, select the Help button.

Select Analysis tools

Get help

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualizations-arcgis


3. Select OK in the confirmation window that appears.
The ArcGIS for Power BI online
help opens in a browser window.
Then you can:

Find answers to frequently asked questions about ArcGIS for Power BI.
Report issues, find the latest information, ask questions, and find answers on
the Power BI community thread related to ArcGIS for Power BI.
Suggest improvements by submitting it to the Power BI Ideas list.

On the Settings pane, you can also view attribution for your map, read about the Esri
EUEI (End User Experience) program, and turn Send usage data to Esri on or off.

If the map has a reference layer and the report designer has added tooltips, you can
select a location to display its details. The following example shows a tooltip for the
Cleveland, Ohio, 2020 Total Population broken down by five-year age increments.

Use tooltips



Hover your pointer over basemap location symbols to display symbol details in a tooltip.

 Tip

You might have to zoom in to select a specific location. If there are overlapping
locations, Power BI will present you with more than one tooltip at a time. Select the
arrows to move between the tooltips.



If the report designer adds an Infographics layer to the ArcGIS map, you'll see additional
data displayed in the upper right corner of the map. Here's an example where the report
designer added the 2021 Median Household Income.

ArcGIS Maps for Power BI is available in the following services and applications:

Service/Application Availability

Power BI Desktop Yes

Power BI service
(app.powerbi.com)

Yes

Power BI mobile
applications*

Yes

Use infographics

Considerations and Limitations



Service/Application Availability

Power BI publish to
web

Yes, for designers signed in to a valid licensed ArcGIS account .

Power BI Embedded Yes, for designers signed in to a valid licensed ArcGIS account .

Power BI service
embedding
(powerbi.com)

No

Power BI Report
Server

Yes, when signed into a valid ArcGIS Enterprise account through Report
Server (online environment only). Not supported in a disconnected
environment or with ArcGIS Online. Accessing Report Server with ArcGIS
for Power BI consumes ArcGIS credits. For more information about credits,
see Understand credits

*In mobile environments, you can view maps created using the ArcGIS for Power BI
visualization included with Power BI (Standard account). Maps that contain premium
content from ArcGIS aren't supported in mobile environments.

In services or applications for which ArcGIS for Power BI isn't available, ArcGIS
visualizations will show as an empty visual with the Power BI logo.

How do ArcGIS Maps for Power BI work together?

ArcGIS Maps for Power BI is provided by Esri . When you provide your consent, any
data you use that is connected to the map visualization is sent to Esri’s services for
geocoding. This means that location information is transformed into latitude and
longitude coordinates that can be represented on a map. Through ArcGIS for Power BI,
Esri provides services to enrich your data. These include basemaps, spatial analytics,
location services, demographic data, and other authoritative data layers. ArcGIS for
Power BI interacts with Power BI using an SSL connection protected by a certificate
provided and maintained by Esri. For more information about ArcGIS Maps for Power BI,
see Esri's ArcGIS Map for Power BI product page .

What is an ArcGIS account?

Esri offers an Esri ArcGIS account  through ArcGIS for Power BI. Adding an ArcGIS
account to Power BI can greatly enhance your mapping visualization capabilities by
adding an extensive library of data reference layers and geo enrichment.

https://doc.arcgis.com/en/power-bi/use/sign-in-to-arcgis.htm
https://doc.arcgis.com/en/power-bi/use/sign-in-to-arcgis.htm
https://doc.arcgis.com/en/arcgis-online/administer/credits.htm
https://www.esri.com/
https://www.esri.com/powerbi
https://www.esri.com/en-us/arcgis/products/arcgis-for-power-bi/buy


Power BI doesn't send personal information about you to Esri. This is a separate
relationship with a third-party vendor. Once you add ArcGIS account content to your
ArcGIS for Power BI visualization, you'll have access to all the Esri content and data
associated with your account, role, and organization. Any other Power BI user with
whom you share that data‐whether within your organization or the public‐might also
need an ArcGIS account to view shared, potentially licensed content. For details about
account types and data limitations, see ArcGIS for Power BI online help .

For technical or detailed questions about ArcGIS for Power BI, see ArcGIS for Power BI
get started  or reach out to Esri Technical Support .

The following table compares the standard features available to all Power BI users to
those features available to users signed in to a valid, licensed ArcGIS account.

Feature Standard, included with
Power BI

Requires ArcGIS account

Basemaps Four basic basemaps All Esri basemaps, access to your organization's
basemaps, custom basemaps.

Geocoding 3,500 locations per map,
10,000 locations per
month

10,000 locations per map, no monthly limit

Reference
layers

10 curated reference
layers that contain U.S.
demographic data and
publicly shared feature
layers in ArcGIS

Access to all global web maps and layers as defined
by your ArcGIS organization or account. This includes
access to ArcGIS Living Atlas of the World maps and
layers (feature services) and publicly shared feature
layers in ArcGIS.

https://doc.arcgis.com/en/power-bi/get-started/account-types.htm
https://doc.arcgis.com/en/power-bi/get-started/about-maps-for-power-bi.htm
https://www.esri.com/contact#c=us&t=5


Feature Standard, included with
Power BI

Requires ArcGIS account

Infographics A curated gallery of U.S.
demographic data
variables, a maximum of
two variables, support for
drive time and radius
settings

Access to all global demographic data variables as
defined by your ArcGIS organization or account. This
includes access to the ArcGIS GeoEnrichment data
browser, a maximum of five variables, and support for
all distance and travel settings.

The ArcGIS map is not showing up

In services or applications where ArcGIS Maps for Power BI isn't available, the
visualization will show as an empty visual with the Power BI logo.

I'm not seeing all of my information on the map

When geocoding latitude and longitude on the map, up to 30,000 data points are
displayed. When geocoding data points such as zip codes or street addresses, only the
first 15,000 data points are geocoded. Geocoding place names or countries/regions
aren't subject to the 15,000 address limit.

Is there any charge for using ArcGIS Map for Power BI?

ArcGIS Maps for Power BI is available to all Power BI users at no extra cost. It's a
component provided by Esri, and your use is subject to the terms and privacy policy
provided by Esri, as noted earlier in this article. If you sign up for an Esri ArcGIS
account , there are costs associated .

I'm getting an error message about my cache being full

This is a bug that is being addressed. In the meantime, select the link in the error
message for instructions on clearing your Power BI cache.

Can I view my ArcGIS maps offline?

No, Power BI needs network connectivity to display the maps.

Get started: Esri documentation and tutorials for ArcGIS for Power BI .

More questions? Try asking the community thread related to ArcGIS Maps for
Power BI .

ArcGIS Map for Power BI product page

Next steps

https://doc.arcgis.com/en/power-bi/use/sign-in-to-arcgis.htm
https://doc.arcgis.com/en/power-bi/get-started/account-types.htm
https://go.microsoft.com/fwlink/?LinkID=828772
https://go.microsoft.com/fwlink/?LinkID=828771
https://www.esri.com/powerbi


Get started with metrics in Power BI
Article • 11/10/2023

APPLIES TO:  Power BI Desktop  Power BI service

Metrics in Power BI let customers curate their metrics and track them against key
business objectives, in a single pane. This feature enhances data culture by promoting
accountability, alignment, and visibility for teams and initiatives within organizations.

This article covers the basics of using metrics in the Power BI service. See the other
articles about metrics for more detail:

Create scorecards and manual metrics in Power BI
Create metrics that are connected to an existing report visual
Get started with hierarchies in Power BI scorecards
Stay on top of your metrics
Follow your metrics
Keep on top of your metrics on the go in the Power BI mobile apps, too
Protect your scorecards with goal-level permissions
Arrange metrics and columns in scorecards
Customize statuses in scorecards
Get notifications in Teams about changes to metrics

More articles about metrics

https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-create
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-create-connected
https://learn.microsoft.com/en-us/power-bi/create-reports/service-metrics-get-started-hierarchies
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-check-in
https://learn.microsoft.com/en-us/power-bi/create-reports/service-metrics-follow
https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-metrics
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-set-permissions
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-move
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-custom-status
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-teams-notifications#metrics-notifications


Metrics are a Pro feature. Users can access various aspects of the experience depending
on their license.

Permission Minimum requirements

Author and share scorecards and metrics, and perform
check-ins

Power BI Pro license

View scorecards and metrics Power BI Premium capacity + Free
user

OR

Power BI Pro license

View scorecard samples and author scorecards in My
Workspace

Free user

If you don’t meet the minimum requirements for any of these, contact your Power BI
administrator before you begin.

After you sign in to the Power BI service, select Metrics from the navigation pane. Power
BI displays your Metrics hub page. The layout and content in the Metrics page is
different for every user. As a new user, your Metrics page will be empty, as shown the
following image.

License requirements

Explore the Metrics hub page



The top section contains all the metrics that matter the most to you, and the scorecard
samples. Power BI curates these metrics automatically, based on metrics that you're
assigned to, you've edited, or you've performed a recent check-in. If you don't have any
scorecards yet, you see the samples there.

A metric must have at least two values, Current and Target, to show up in this section.

Recommended

Recent, Favorites, Shared with me, and All Scorecards



The next section is a tabbed list.

Recent are the scorecards you've visited most recently. Each item has a timestamp.

Favorites are the scorecards you've starred.

Shared with me contains scorecards that your colleagues have shared with you.

All scorecards lists all the scorecards you have access to.

When you're viewing your scorecard, you can also change the view from List view to
Compact view, which is currently in preview.

Compact view adjusts to various screen sizes and supports resizing columns. You can do
everything you can do in list view, except editing and creating a new metric.

Change the scorecard view

Frequently asked questions (FAQ)



Why don’t I see history for my metric when I connect to a Power BI data point?

You don’t see a history for a single data point because we only pull history for time
series data. To see the history of your metric when you connect to time series data,
select Track all data in this time series when you connect.

I'm connecting to time series data and still don’t see the history of the metric. Why
not?

We don't pull in the history of time series if we only have a partial date, for example, day
of the week or month. We can only pull in the history of a time series when we have a
full date to track, such as day, month, and year.

Why aren't my metrics getting updated over time in my scorecard?

There are a few reasons why your metric may not be getting updated:

It’s a manual metric: Manual metrics aren't updated automatically as they're not
connected to a data source with regular refreshes. To create a history for a manual
metric, do regular check-ins.
You don't have scheduled refresh for the semantic model: Metric values are only
updated as often as the semantic model is refreshed. If you don’t have a scheduled
refresh on your semantic model, you don't see any updates in the metric value.
Learn about scheduled refresh.
Metrics don’t get updated if they're created from a push dataset.

I'm trying to create a metric but I can’t connect to a report. Why do I see a yellow
warning icon?

To connect your current value or target to data, you need build permissions for that
report. Learn about build permissions.

I shared a scorecard but my users can’t do check-ins and add notes. Why not?

Currently, users need to have edit permissions for the scorecard to add check-ins.
Updated scorecard and metric-level permissions are in the works. They'll allow check-in
permissions without edit permissions for the scorecard.

Why can’t I update the value as part of my check-in?

You can only update values in manual metrics. If a metric value is connected to data, you
can't update it manually. The data is pulled directly from the report and is updated as
often as the semantic model refreshes.

How often do metrics update in the scorecard?

https://learn.microsoft.com/en-us/power-bi/connect-data/refresh-scheduled-refresh
https://learn.microsoft.com/en-us/power-bi/connect-data/service-datasets-build-permissions


Metrics only update as often as the data updates in the semantic model. We support
connecting via import, live connection, and DirectQuery. Additionally, we take snapshots
of the metrics data at a maximum daily cadence, and always retain the last updated
value for a given day. The snapshots are always available in the underlying semantic
model we create, which you can then build content on top of.

I changed the tracking cycle of my metric. Why does the data still look the same?

Changing the tracking cycle only changes the trend that you see below your
value/target area. Changing this setting doesn't impact refreshes on the data or when
your data is updated in the metrics.

Why don’t I see the Power BI workspace I’m looking for when I create a scorecard?

In order to create a scorecard in a workspace, you need a contributor or owner role in
that workspace. Learn about roles in workspaces.

Scorecards do have metric-level permissions roles. While workspace permissions give
view or build access to the workspace, metric-level permissions restrict access. Certain
people can only see certain metrics and perform check-ins within a scorecard. Read
more about metric-level permissions in scorecards.

Metrics don't yet support bring your own key (BYOK).
Metrics don't yet support row-level security (RLS).
For now, the maximum number of submetric levels is four.
Metrics don't support publish-to-web.
Business-to-business sharing (sharing across tenants) isn't supported.
Scorecards aren't supported in a Multi-Geo capacity.
Scorecards aren't supported in embedded analytics.

Create scorecards and manual metrics in Power BI
Create connected metrics in Power BI
Stay on top of your metrics in Power BI
Protect your scorecard with metric-level permissions
Metrics admin settings

More questions? Try the Power BI Community .

Issues and limitations

Next steps

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-roles-new-workspaces
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-set-permissions
https://learn.microsoft.com/en-us/power-bi/admin/service-admin-premium-multi-geo
https://learn.microsoft.com/en-us/power-bi/developer/embedded/embedded-analytics-power-bi
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-create
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-create-connected
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-check-in
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-set-permissions
https://learn.microsoft.com/en-us/fabric/admin/service-admin-portal-goals-settings
https://community.powerbi.com/


Stay on top of your metrics
Article • 01/16/2024

APPLIES TO:  Power BI Desktop  Power BI service

Metrics in Power BI let your customers curate their metrics and track them against key
business objectives, in a single pane. In addition to seeing all your metrics in one view,
scorecards make it easy for you to dig deeper into the data, update your metrics, make
notes on important events. These features are covered in this article. You can also follow
your metrics, to be notified when they change.

The metrics Details pane provides the entire history for the metric from the start date,
including check-ins, status changes, and relevant notes.

To access the details pane, open a scorecard and select the metric name. Power BI
automatically shows the details pane.

View metric details

https://learn.microsoft.com/en-us/power-bi/create-reports/service-metrics-follow


You can filter scorecards to metrics labeled as a particular status. Selecting the summary
cards at the top of the scorecard makes it easy to see what is on track or at risk.

This metric is at risk.

Filtering and keyword search



This metric is behind.

There's also a keyword search that filters the scorecard down to metrics that match the
keyword. Select the Filter icon above the first metric and type the keywords you're
looking for. The scorecard filters to show those results, without losing the context of any
parent/child metric relationships, making it easy to quickly find a particular metric and
see how it's doing.

The scorecard before filtering.



The scorecard filtered to Premium.

1. In a scorecard, select the metric name.

2. In the Details pane, select New check-in.

Update manual values



3. Complete the following actions in any order:

Choose a date.

Enter a new or updated value.

Select a status.

Optionally, include a note.

4. Select Save.

1. In a scorecard, select the metric name.

Update connected values



2. In the Details pane, select New check-in.

3. Complete the following actions in any order:

Choose a date. Choosing a date auto-populates the value for that day. You can't
override a connected value.

Select a status.

Optionally, include a note.

4. Select Save.

Get started with metrics in Power BI
Create scorecards and manual metrics in Power BI
Create connected metrics in Power BI

More questions? Try the Power BI Community .

Related content

https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-introduction
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-create
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-create-connected
https://community.powerbi.com/


View hierarchies in Power BI metrics
Article • 11/10/2023

APPLIES TO:  Power BI Desktop  Power BI service

Metrics support cascading scorecards that roll up along hierarchies you set up in your
scorecard. You can view and interact with hierarchies in scorecards two different ways.

Scorecard list view
Heatmap view

To view your hierarchical scorecard, you can use the slicer to navigate to whichever level
of your hierarchy you want to view. From here you can do things like open the details
pane, go to a report, and perform check-ins, just like any other scorecard view.

All connected values, mapped owners, and statuses dictated by rules will reflect the
appropriate data at each hierarchy level, so long as the relationships exist. There needs
to be a relationship between the hierarchy level fields in the underlying semantic models
to correctly filter the values. Manual metrics will be indicated by an information icon
showing which values are manual for that metric.

Scorecard list view



https://learn.microsoft.com/en-us/power-bi/create-reports/media/service-metrics-get-started-hierarchies/hierarchies-cross-section.png#lightbox


You can view intersections of multiple hierarchies. For example, you can look at a cross
section between one selection from product, and one selection from the geography
hierarchy, indicated in the slicer name as shown in the following images.

Here the header within a scorecard restates the two levels of the hierarchy that a user
chose, Germany and Laptops.



https://learn.microsoft.com/en-us/power-bi/create-reports/media/service-metrics-get-started-hierarchies/hierarchies-two-slicers.png#lightbox


By selecting Heatmap from the view options, you can start to build a custom heatmap
view that allows side by side comparison of different hierarchy levels. This experience is
exposed in read mode, so consumers can also do their own exploration using the pane,
showing and comparing different segments, though saving and sharing views aren't yet
supported.

You can also customize what information to show in each metric box by selecting the
slicer dropdown, then selecting Open display settings. This is a great view to use in
business reviews.

Heatmap view



https://learn.microsoft.com/en-us/power-bi/create-reports/media/service-metrics-get-started-hierarchies/hierarchies-heatmap-view.png#lightbox


Customize the heatmap view in the Display settings dialog box.

Premium or PPU workspace is required.

There are data limits on hierarchies:

Additional considerations for viewing a
hierarchy



Up to 10,000 items per hierarchy (across all semantic models)
Up to five hierarchies
Up to five levels per hierarchy

Permissions can't be set at a hierarchy level – metric level permissions are set at
the scorecard and applied to all hierarchy views.

Data connections are evaluated by impersonating the hierarchy owner/creator
where row-level security (RLS) may apply. This does not change metric level
permissions.

Dynamic and static RLS is supported but it is routed through the hierarchy creator.
All scorecard viewers impersonate the hierarchy creator’s access.

Hierarchy permissions can't be set at a specific hierarchy level. Metric level
permissions are inherited from the original scorecard and are applied at all levels,
and RLS via the hierarchy creator dictate permissions.

Non-admin users may experience refresh issues when setting up hierarchies on a
semantic model with dynamic RLS.

Manual metrics are indicated by an information icon showing which values are
manual for that metric.

Notifications regarding status changes on child scorecard levels aren't triggered.

There is a limit of one selection per hierarchy for viewing a hierarchical scorecard.

History for hierarchical metrics isn't supported because data is always queried live
from the semantic model, instead of cached when the semantic model refreshes.

Saving and sharing heatmap views isn't yet supported.

Get started with cascading scorecards in Power BI
Scenarios: When to use hierarchies in Power BI scorecards

Next steps

https://learn.microsoft.com/en-us/power-bi/create-reports/service-metrics-get-started-hierarchies
https://learn.microsoft.com/en-us/power-bi/create-reports/service-metrics-hierarchies-scenarios


Paginated reports in the Power BI
service
Article • 03/17/2023

APPLIES TO: 
Power BI service for business users 
Power BI service for designers
& developers 
Power BI Desktop 
Requires Pro or Premium license

There are two types of reports available on Power BI, Power BI reports and paginated
reports.

Power BI reports are optimized for exploration and interactivity. A sales report where
different salespeople want to slice the data in the same report for their specific
region/industry/customer and see how the numbers change would be best served by a
Power BI report.

Paginated reports are well suited for viewing reports as pages, printing as PDF, exporting
to Excel, or generating documents. A sales detail report where you want to see row-level
detail data for specific region/industry/customer and perhaps export it to Excel or print
as accessible PDF would be best served by a paginated report.

In content lists and on your Home landing page, paginated reports can be identified by

their icon 
. A paginated report can be shared with you directly, or as part of a Power
BI app. If the report designer gave you permissions, you'll be able to re-share the
paginated report and subscribe yourself and others.

Identify a paginated report



These reports are called paginated because they're formatted to fit well on a printed
page. One advantage is that they display all the data in a table, even if the table spans
multiple pages. Report designers can control the report page layout exactly.

Paginated reports are best for scenarios that require a highly formatted, pixel-perfect
output optimized for printing or PDF generation. A profit and loss statement is a good
example of the type of report you would probably want to see as a paginated report.

When report designers create a paginated report, they're really creating a report
definition. It doesn't contain the data. It specifies where to get the data, which data to
get, and how to display the data. When you run the report, the report processor takes
the report definition, retrieves the data, and combines it with the report layout to
generate the report. Sometimes, the report displays default data. Other times you need
to enter parameters before the report can display any data.

Select a paginated report to open it in the Power BI service. If it has parameters, you
need to select them before you can view the report.

And that's typically the extent of the interaction - setting the parameters. If you're a
billing analyst, you might use paginated reports to create or print invoices. If you're a
sales manager, you might use paginated reports to view orders by store or sales person.

This simple paginated report generates profit by year after you select the Year
parameter.

What is a paginated report?

How do paginated reports work?



Compared to paginated reports, Power BI reports are much more interactive. Power BI
reports allow for ad hoc reporting, and support more types of visuals, including custom
visuals.

The way you interact with a paginated report is different from other reports. You can do
things like print, bookmark, export, and comment, but there's less interactivity. Often,
paginated reports require input from you to populate the report canvas. Other times the
report displays default data and you can enter parameters to see different data.

Interact with a paginated report



Paginated reports are formatted to fit well on a page and to print well. What you see in
the browser is what you see when you print. Plus, if the report has a long table, the
entire table prints, even if it spans multiple pages.

Paginated reports can have many pages. For example, this report has 563 pages. Each
page is laid out exactly, with one page per invoice and repeating headers and footers.
When you print this report, you'll get page breaks between invoices.

Print a paginated report



In this sales order report, there are three parameters: Business type, Reseller, and Order
number.

Navigate the paginated report



To change the information shown, enter new values for the three parameters and select
View report. Here, we've selected Specialty bike shop, Alpine Ski House, and order
number SO46085. Select View report to refresh the report canvas with the new sales
order.

The new sales order shows the parameters we selected.



Some paginated reports have many pages. Use the page controls to navigate through
the report.

You have a variety of options for exporting paginated reports, including PDF, Word,
XML, PowerPoint, and Excel. When you export, as much of the formatting as possible is
preserved. Paginated reports exported to Excel, Word, PowerPoint, MHTML, and PDF, for
example, keep their formatting.

Export the paginated report





When you subscribe to a paginated report, Power BI sends you an email with the report
as an attachment. When you set up your subscription, you choose how often you want
to receive the emails: daily, weekly, hourly, or monthly. The subscription contains an
attachment of the entire report output, up to 25MB in size. Export the entire report, or
choose the parameters ahead of time. Choose from many attachment types, like Excel,
PDF, and PowerPoint.



Subscribe to the paginated report

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-paginated-report/power-bi-four.png#lightbox


A paginated report can appear blank until you select parameters and choose View
report.

If you don't have any paginated reports, check out these sample paginated reports
that you can import to your workspace.

Considerations and troubleshooting

Next steps

https://learn.microsoft.com/en-us/power-bi/paginated-reports/paginated-reports-samples


Power BI reports
Paginated reports in Power BI: FAQ
More questions? Try the Power BI Community .

https://learn.microsoft.com/en-us/power-bi/paginated-reports/paginated-reports-faq
https://community.powerbi.com/


View a paginated report in the Power BI
service
Article • 01/09/2024

In this article, you learn about viewing a paginated report in the Power BI service.
Paginated reports are reports created in Report Builder. They can be uploaded to any
Power BI workspace.

Paginated reports have their own icon  .

You can also export paginated reports to many formats:

Microsoft Excel
Microsoft Word
Microsoft PowerPoint
PDF (and Accessible PDF, or PDF/UA)
Comma-separated values
XML
Web archive (.mhtml)

1. Open the Power BI service, then select the paginated report in the workspace.

View a paginated report

https://learn.microsoft.com/en-us/power-bi/report-server/rendering-extension-support


2. If the report has Required parameters, they won't appear when you first open it.
Select Parameters, then select View Report. You see a notification of the fields
required to open the report. You can change the parameters at any time.

The following example shows a report with a parameter that requires you to select
a month.

3. When you have a multiple-page report, use the page through feature. You can use
the arrows at the top of the page or type a page number in the box. The following
example shows where to find the page through feature.



4. To Search, type all or part of the content you're looking for in the report. You're
searching for the content across all the pages of the report.

5. You can also sort by selecting the sort icon on the report.

７ Note

The report author may have limited sorting for reports created in Power BI
Report Builder. You have to update sort in Power BI Report Builder to be able
to sort on all columns on the Power BI service.



6. To export your report to a different format, select Export. Then choose the format
you want to use from the dropdown menu.

You can only search and sort in "Web layout."
Search doesn't work if there are over 300 rows per page.
Sort:

You can only sort on one column at a time.
If a report was created in the service before December 2023, you have to edit
the report for sorting to be available during consumption.

Paginated reports in the Power BI service

Considerations and limitations

Next steps



View parameters for paginated reports
in the Power BI service
Article • 03/17/2023

In this article, you learn how to interact with parameters for paginated reports in the
Power BI service. A report parameter provides a way to filter report data. Parameters
offer a list of available values. You can choose one or many values, or type in a
parameter text box to search for values. Sometimes parameters have a default value,
and sometimes you have to choose a value before you see the report.

When you view a report that has parameters, the report viewer toolbar displays each
parameter so you can interactively specify values. The following illustration shows the
parameter area for a report with parameters for Buying Group, Location, a From Date,
and a To Date.

1. Parameters pane Select Parameters to show or hide the Parameters pane.

2. Organization parameter The Organization parameter is set to allow you to select
only one value.

3. Date From / Date To parameters The two date parameters have default values. To
change the date, type a date in the text box, choose a date in the calendar, or
select Go to today.

4. View Report After you enter or change parameter values, select View Report to
run the report.

Parameters pane in the Power BI service



5. Default values If all parameters have default values, the report runs automatically
on first view. The parameters in this report have default values, so you see the
report with those values.

Paginated reports in the Power BI service

Next steps



Use data to make meetings productive
in Microsoft Teams
Article • 01/25/2023

APPLIES TO: 
Power BI service for business users 
Power BI service for designers
& developers 
Power BI Desktop 
Requires Pro or Premium license

In meetings, keeping everyone on track towards shared objectives is important. Use
data, trends, and metrics to show the impact of the work you and your team are doing.

It’s easy to use Power BI in meetings to help keep crucial data top of mind. It helps
everyone know which data is the most important and builds skills that help your team
make agile decisions based on your progress toward objectives. By staying focused on
driving towards measurable outcomes, your team gains a sense of the positive impact of
their work.

Here's how you can use data before, during, and after your meetings.

Before the meeting. Add the reports and scorecards directly to the meeting invite
so everyone can access to them.
During the meeting. Open and present these reports from the calendar. You can
even use chat to share more reports and scorecards or to find answers to
questions raised in the meeting.



After the meeting. Send a summary with the key results discussed and actions the
team decided to take to help achieve the desired outcomes.

Here some questions you can add to your meeting agenda to start discussion and
determine the best actions to take to achieve your desired outcomes:

Are we making progress toward our objectives as quickly as we expected to?
What actions can we take in the next week or month that are most likely to
improve our metrics?
What metrics can we start tracking to get a better sense if we’re making progress
towards our desired outcomes?

Review your data weekly, or at least monthly, to get in the habit of asking questions and
discussing the best actions to take in the next week or two. It will help the team learn to
leverage data as they plan their work.

To get ready for the meeting, add a Power BI report or scorecard to the meeting invite.
Review the data in the report or scorecard and encourage other participants to do the
same. Then everyone is ready for the meeting.

Here's how to add a Power BI report or scorecard to a meeting.

1. Schedule a meeting in Teams.

2. Send the meeting invite.

3. Select Edit to open the meeting in the calendar. You only see the option to edit if
you're the meeting organizer.

Ask data-driven questions

Before the meeting

Add Power BI



4. Select the + Add a tab button to add the Power BI tab to the meeting.

5. Navigate to a report or scorecard and select it.

6. Select Save.



7. See Give team members permission in the "Lead data-driven discussions in
Microsoft Teams" article for how to share with your colleagues.

8. Add an agenda item to the meeting to review and discuss the data.

It's a good idea to review your data in Power BI before a meeting.

1. Open the meeting from the calendar.
2. Open the Power BI tab that has the report or scorecard.
3. Review the report or scorecard.

Consider setting a reminder for your meeting so attendees can also pre-read the data
before the meeting. It helps everyone be aware of the latest data and improves the
discussion during the meeting.

When you’re in a meeting, data can help guide the discussion or answer questions
raised by attendees. It’s easy to present data in Power BI during the meeting, share links

Review the data

During the meeting



to data with meeting attendees, and find data that can answer questions.

1. After joining the meeting, navigate to the Teams window.

2. Open the calendar in Teams.

3. Open the meeting in the calendar.

4. Anyone in the meeting can select the Power BI tab to view the report you added to
the meeting.

5. Use the meeting window to present your screen.

1. View the report in the Power BI app in Teams.

2. Select a visual.

3. Select Copy visual as image to copy the visual.

Capture visuals that are important for everyone to see



4. Paste the visual into the meeting chat.

1. View the report in the Power BI app in Teams or in the Power BI service.

2. Select the report or a specific visual.

3. Select the Chat in Teams button.

4. Select the meeting name to send to.

5. Type your message above the link that's provided.

6. Select Send.

Send a message in the meeting chat from a report



Your message appears as part of the meeting chat. Attendees can open it to see the
data with the filters and slicers applied.

1. Open the meeting chat.

2. Select Messaging extensions (...).

3. Select Power BI.

4. Search for content, or select from your list of recent items.

5. Pick a Power BI item.

6. Select Send.

Answer questions with data in chat



7. Select Open.



It’s useful to share a summary of the most important data points discussed and the
actions the team will take to help achieve outcomes. If you captured visuals during the
meeting in chat, you can pull those into a meeting summary post in chat or a follow-up
message.

Consider using key data points to create metrics and track them in a scorecard.
Consistently tracking progress against a metric through a series of meetings is a great
way to keep your team or project on track.

Add the Power BI app to Microsoft Teams
Use Power BI metrics to improve results in Microsoft Teams
Lead data-driven discussions in Microsoft Teams
Create reports from data in Microsoft Teams
Analyze your Teams collaboration data

After the meeting

Next steps

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-microsoft-teams-app


Use Power BI metrics to improve results
in Microsoft Teams
Article • 07/08/2022

APPLIES TO: 
Power BI Desktop 
Power BI service

Your team benefits from having clear and measurable objectives. Tracking metrics in
Microsoft Teams with your team helps the team stay on track, promoting accountability,
alignment, and visibility. By tracking progress towards key objectives together, the team
can engage in creative and agile decision-making that helps achieve objectives faster.

It takes just a minute to create a metric in Power BI. Each metric has a name, owner, the
current value, the target, and a status. You can even add start and end dates for the
metric. Submetrics help you track key objectives that are needed to support a bigger
metric.

In Microsoft Teams, select More added apps ... > Power BI.

Add the Power BI personal app to Teams



Now Power BI opens right inside Microsoft Teams.

It's simple to start tracking metrics by creating a scorecard.

1. Open Power BI in Teams.

2. Select Metrics in the navigation pane to open the Metrics hub.

Create your first metric in a scorecard



3. Select New scorecard.

4. Give the scorecard a name and description.



5. Create a metric in the scorecard, with a Metric name, Owners, Current and Final
target values, Status, Start date, and Due date. You can type in numbers, or select
connect to data to get values from your reports.

6. Select Save.

After you’ve saved your scorecard with its metrics, you can share with your team by
adding it to a Teams meeting, channel, or chat as a tab or as a link in the meeting chat.
Read more about creating scorecards and metrics in Power BI.

To keep your metrics top of mind for your team, add your scorecards as tabs to your
channels and meetings.

1. Open a channel or meeting.

2. Select the + Add a tab button and add the Power BI tab.

Track metrics with your team

https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-introduction


3. Pick a scorecard. If you keep Post to the channel about this tab selected, Teams
adds a post to the chat, about the new tab.

4. Select Save.

5. Now you see the scorecard as a tab in the channel.

6. You may need to share it with colleagues. See Give team members permission in
the "Lead data-driven discussions in Microsoft Teams" article for how to share with
your colleagues.



7. Open the chat window in Teams to see the post about the scorecard.

Make keeping your metrics up to date easier with just a little more work. Here are a few
capabilities to explore:

Use check-ins for metrics to share context about metrics. When your team
encourages and reviews check-ins on metrics, they can share the reasons behind
the numbers so they’re visible to everyone.
Automatically update your goals' current values. When you connect your metric to
a report, whenever the data in the report refreshes, the goal’s current value is
automatically kept up to date.
Set the metric status automatically. You can create automated rules to set the
status of metrics, so the goal’s status always reflects the data correctly.

These capabilities help your team save time by eliminating manual updates, and help
keep scorecards fully updated.

Each project and organization can have its own metrics. You can find all your metrics in
one place in the Metrics hub that is part of the Power BI app for Microsoft Teams. Here’s
how to find it.

1. Open the Power BI app for Teams from the Teams left navigation.

2. Select Metrics in the Power BI navigation pane to open the Metrics hub.

Make tracking metrics part of your team
rhythm

Find all your metrics in the Metrics hub



Add the Power BI app to Microsoft Teams
Create scorecards and metrics in Power BI
Use data to make better meetings in Microsoft Teams
Share a data-driven discussion in Microsoft Teams
Create reports from data in Microsoft Teams
Analyze your Teams collaboration data

Next steps

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-microsoft-teams-app
https://learn.microsoft.com/en-us/power-bi/create-reports/service-goals-introduction


Lead data-driven discussions in
Microsoft Teams
Article • 01/23/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Data helps everyone get on the same page before important decisions. Sharing data
with your team is important and easy with Power BI in Microsoft Teams. You can share
data in Teams in channels, in chats, and in meetings.

1. Open the channel, chat, or meeting where you’d like to share.

2. Select the + Add a tab button and add the Power BI tab.

3. Pick the Power BI item you’d like to share.

4. Select Save.

Share in channels, chats, and meetings



You can share in channels, meetings, and even in chats.

Make sure your team has permission to the report or scorecard by sharing it with them.

1. Open the item in Power BI in Teams, or in the Power BI service, and select File >
Manage Permissions.

Give team members permission



If you don't see this option, you might not have permission to share the item. If
you do not, don’t worry. The attendees can request access themselves when they
try to view the report.

2. Select Direct access.

3. Select Add user.





https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-share-data/teams-power-bi-file-manage-permissions-new.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-share-data/teams-power-bi-direct-access-new.png#lightbox


4. Add the names of your colleagues. Decide what permissions you want them to
have, whether to send them an email, and select Grant access.

When discussing data, it’s important that your colleagues can open the underlying data
to see and explore trends. This helps them answer questions and understand the full
context of requests you’re making. It’s also an easy way to encourage more use of data
in decision making.





Chat about data with rich links and cards

Discussing data is easy

https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-share-data/teams-power-bi-add-user-new.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-share-data/teams-power-bi-grant-access-new.png#lightbox


1. Open a report in the Power BI app in Teams, or in the Power BI service.

2. (Optionally) If you want, select a specific visualization, and then click Chat in
Teams.

3. Send a message to a channel where you work with your team.

The link will include the full context of the data you were looking at, including the page,
the visual, and any filters you applied. When your colleagues open the link, they quickly
see the data you’re referring to.

1. In the Teams channel or chat, start a new conversation.

2. In the command bar for the editor, select Messaging extensions (...).



Send your colleagues links to reports

https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-share-data/teams-power-bi-visual-report-chat.png#lightbox


3. Select Power BI.

4. Search for the content you want to share, or select from your list of recent items.

5. Pick a Power BI item.

6. Select Send.

A rich card is added to the conversation, making it easy for anyone to open the
item.



It’s a great way to help without leaving the conversation, and saves everyone time.

If you use Power BI in a web browser, it’s easy to send a link to a colleague.

1. Open a report in the Power BI service in the browser, and copy the link.

2. Start a conversation and paste the link. Teams automatically creates a rich card.

3. Select Send.

Create rich cards to paste in chat



https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-share-data/teams-power-bi-copy-link-new.png#lightbox


4. Your colleague sees a rich card with a link to open the report.

Add the Power BI app to Microsoft Teams
Use data to make better meetings in Microsoft Teams
Use Power BI metrics to improve results in Microsoft Teams
Create reports from data in Microsoft Teams
Analyze your Teams collaboration data



Related content

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-microsoft-teams-app
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-share-data/teams-power-bi-rich-card-chat.png#lightbox


Create reports from data in Microsoft
Teams
Article • 11/10/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

It’s easy to create Power BI reports in Microsoft Teams. This article has a few examples of
reports you can create. When you’re ready, you can also use tools like Power BI Desktop
for more advanced report authoring.

If you have a table with data, such as an Excel spreadsheet, and want to try visualizing in
Power BI, create your report with the help of Microsoft Teams. You can start in Microsoft
Teams or the Power BI service.

1. Open the Power BI app from Microsoft Teams.

Need to install the Power BI app? Install the app, then pin it to the Teams
navigation pane.

2. Select the Create tab, then choose Paste or manually enter data to open the
Power BI service on your browser.

Create an automatic report from data you have

Create an automatic report with Microsoft Teams



https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-microsoft-teams-app#install-the-power-bi-app
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/teams-power-bi-create-paste-manually.png#lightbox


3. After the Power BI service opens in your browser, go to Step 3 in Create an
automatic report with the Power BI service to finish creating your report.

1. Open the Power BI service.

2. Select the New report button.

3. Select Paste or manually enter data.

4. Copy the data or spreadsheet you want to visualize, then select the first cell in the
Power Query dialog box and paste the data.

5. Select Use first row as headers from the dropdown menu if you want to apply the
setting. Then name your table and choose Auto-create report.

Create an automatic report with the Power BI service





https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/power-bi-new-report.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/power-bi-create-paste-manually.png#lightbox


6. Set a sensitivity label, if prompted.

Power BI automatically analyzes and visualizes your data in a prebuilt report.

7. Customize your visuals. If you want to customize a single visual on your report,
select the Personalize this visual icon.





https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/power-bi-paste-auto-create.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/power-bi-auto-created-report.png#lightbox


8. Save the report.

9. After you save the report, you can customize the whole report by selecting Edit.

When you’re done, save and share the report with your colleagues in Teams.

Many organizations share semantic models that you can use to build your reports.
These semantic models are great because they offer up-to-date authoritative data.
Semantic models marked certified or promoted are likely to be higher quality and better
maintained, so your reports keep working longer.

To build a report from a semantic model shared with you, follow these steps.



Create a report from a semantic model in your
organization

https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/power-bi-edit-auto-created-report.png#lightbox


1. Open the Power BI app for Microsoft Teams.

2. Select the Create tab > Pick a published semantic model.

3. Select a semantic model > Auto-create report.

4. Start exploring the data.

Use visualizations like charts, tables, and maps to show data in various ways.
Select data points to see other visuals update to filter data to your selection.
Change formatting to make the report useful and readable by your
colleagues.

5. After you complete your work, save and share the report.





https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/teams-power-bi-create-published-dataset.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/teams-power-bi-select-dataset.png#lightbox


It's easy to find all the semantic models your organization has shared with you. They’re
in the OneLake data hub in the Power BI app for Microsoft Teams. Again, semantic
models marked certified or promoted are likely to be higher quality and better
maintained.

1. Open the Power BI app for Microsoft Teams.

Need to install the Power BI app? Install the app, then pin it to the Teams
navigation pane.

2. Go to the OneLake data hub tab.

3. Select a semantic model from the list or from the recommended semantic models.

4. Explore the Semantic model details page.

Explore semantic models and reports shared
with you



https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-microsoft-teams-app#install-the-power-bi-app
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/teams-power-bi-datasets-tab.png#lightbox


Discover prebuilt reports that use the semantic model.
Create a report in Power BI from the semantic model with Create a report.
Share data and give people access to the semantic model to work.
Select a table or column to export data or select more than one table to
create a paginated report.

When you find interesting reports relevant to your team, bring them into your
collaboration. Add them to channels, meetings, and chats as tabs or in a conversation.

It’s easy to keep working on your reports right in the Power BI service and Power BI in
Teams. Take advantage of the artificial intelligence capabilities built into Power BI.

For example, ask a question about your data by adding a Q&A visual, where you can ask
natural language questions and get answers in the form of a visual.

1. In the Visualizations pane, select the Q&A icon.



Enhance reports in the Power BI service and in
Teams

Q&A visual

https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/teams-power-bi-datasets-details.png#lightbox


Power BI generates a list of suggested questions you can choose from or type your
own.

2. If you like the visual that Power BI creates, you can convert it from a Q&A visual to
a standard visual on the page.



For more information, see Create a Q&A visual in a report in Power BI.

You can also easily create a smart narrative visual, a dynamically generated text box that
provides relevant insights that you can customize.

1. In the Visualizations pane, select the Smart narrative visual icon.

Smart narrative visual

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-q-and-a


Power BI generates a text description of key takeaways in your report.

2. You can edit the visual, change the way it looks, and change the inline values it
generates.

For more information, see Create smart narrative summaries.

Power BI Desktop is a downloadable Windows app to make sophisticated reports. It's
like PowerPoint, but it uses data visualizations to help you gain insights into your data.
Power BI Desktop has powerful capabilities like data import, cleaning, modeling, and
much more.

To get started with Power BI Desktop, follow these steps.



Create sophisticated reports in Power BI
Desktop

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-smart-narrative
https://learn.microsoft.com/en-us/power-bi/consumer/media/business-user-teams-create-reports/power-bi-teams-smart-narrative-visual.png#lightbox


1. Install Power BI Desktop. You can download it from the Microsoft Store .

2. Create a report in Power BI Desktop.
In the following tutorial sample, you prepare and model your data. Then create a
report based on the model you've created. You can't do both tasks in a report in
the Power BI service.

Tutorial: From dimensional model to stunning report in Power BI Desktop

3. Publish the report to the Power BI service.

4. Share the report with your colleagues in Teams.

Add the Power BI app to Microsoft Teams
Use data to make meetings productive in Microsoft Teams
Use Power BI metrics to improve results in Microsoft Teams
Lead data-driven discussions in Microsoft Teams
Analyze your Teams collaboration data

Get Power BI Desktop

Next steps

https://aka.ms/pbidesktopstore
https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-dimensional-model-report
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-publish-to-web
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-microsoft-teams-app
https://aka.ms/pbidesktopstore


Analyze your Teams collaboration data
Article • 01/27/2023

APPLIES TO: 
Power BI service for business users 
Power BI service for designers
& developers 
Power BI Desktop 
Requires Pro or Premium license

Many of us spend a lot of time collaborating in Microsoft Teams. With Power BI, you can
get insights into where you're spending your time and how you and your team
collaborate. By reviewing this data, you and your team can plan improved ways of
working to be more responsive, agile, and productive.

To get insights about collaboration in Microsoft Teams, follow these steps.

1. Open the Power BI app for Microsoft Teams.

Need to install the Power BI app? Install the Power BI app, then pin it to the Teams
navigation pane.

2. Go to the Create tab and select Analyze your Teams data.

3. Explore your usage in the automatically generated report.

4. Explore engagement in the teams you participate in.

The report is saved in your Power BI account and stays refreshed. You can come back
every few days to see how your actions change the trends. When working in a team, it’s
great to discuss the data and ways to improve.

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-microsoft-teams-app#install-the-power-bi-app


When looking at your meeting participation, you can see where you spend your time.
Look at whether you spend most of your time in meetings or if you have enough focus
time to get work done. You can see if you’re mostly participating in or organizing
meetings. Depending on your organization and your role, the balance of what’s “right”
might change, but it’s important to ask the following questions:

Are the meetings I’m in clearly furthering the objectives of my role and my
organization?
Am I setting the pace of delivery effectively by organizing important meetings to
support my objectives?

Remote and hybrid work enables many of us to work from anywhere, which can impact
the relationships we have with colleagues. It helps to build strong relationships with
colleagues to succeed, overcome challenges, and build a cohesive work environment.
Look at the 1:1 calls metric to see if you’re making the connections you need for the
future.

Questions to ask about your collaboration

Am I effective in meetings?

Am I building relationships with my colleagues?

Am I using chat effectively?



Chat experiences help us communicate quickly with others without interrupting their
flow of work. Chat messages are fast, easy to write, and allow the recipient to multi-task
by responding when they’re able. To use chat effectively, consider how you’re using chat
across the experiences Teams offers.

Look at the number of chat messages you send in a day and the trend. If you’re sending
numerous messages (20, 30, 40, 50), see what they were and review them. Consider
whether a meeting or a 1:1 call could have achieved the same outcome while creating a
stronger connection with your colleague. You may even want to send a document rather
than writing chats. Consider asking your colleague which option is the most effective for
them.

Teams and channels help keep your entire workgroup or project team up to date.
Sometimes it’s easier to message someone directly instead of posting in a channel. This
practice can raise challenges since others teammates lack visibility into work happening
around them and don’t have the opportunity to offer input. It’s also harder for them to
help and finish something when someone goes on vacation. If you’re primarily using
Chats, consider if Channels would be a good option to add to your collaboration habits.

Looking at meeting activities such as audio, video, and screen sharing, you can gain
insight into how effectively you’re using in-meeting experiences. If you’re sharing audio
but not video, you may be missing opportunities to make a stronger connection with

 Tip

Start a chat with a coworker by stating why you're contacting them, rather than just
typing "Hi" or "Are you busy?" Just ask your question. That way, they can respond
quickly rather than wait for you to ask the question.

Am I sending too many chats?

Am I using channels effectively?

Am I using in-meeting experiences in the best way?



other meeting attendees. If you’re screen sharing a lot, it could indicate that you’re
driving the discussion forward in these meetings.

Sometimes where you work is as important as how you work. The Teams activity view
gives you a summary of how your teams collaborate. You can quickly see which teams
you might be overlooking and which ones you might close. If multiple teams cover the
same topic, consider merging them to help everyone work together.

When you view the details for a specific team, you can get more detailed usage data. As
a team owner, you might show this view in a meeting to seek input to improve your
collaboration. It’s also a great way to evaluate if you should retire a team with few active
users or low engagement.

Understand activity in teams you access and
own



Add the Power BI app to Microsoft Teams
Use data to make meetings productive in Microsoft Teams
Use Power BI metrics to improve results in Microsoft Teams
Lead data-driven discussions in Microsoft Teams
Create reports from data in Microsoft Teams

Next steps

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-microsoft-teams-app


How to determine that content is up to
date
Article • 06/11/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

This article shows you how to determine when your content was last updated or
refreshed and also suggests ways to stay in sync with your most important data.

As a business user, you interact with content that's created by designers and made
available to you. The content contains timestamps, so you know when it was published,
shared, or last updated. Knowing that you're working with the freshest content gives
you confidence and is often critical in making the right decisions.

What can you do to ensure you're using the latest content? In most cases, you don’t
need to do anything at all. Content, like apps, dashboards, scorecards, or reports, is
shared with you by designers. And the designers refresh and update the content. The
designers either manually update content, or they update it automatically by setting an
automated refresh schedule.

If you have questions about content freshness, contact the designer directly. The
examples show you how to identify and contact the owner of your content.

Timestamps in the Power BI service



Power BI adds date and time information when content is published, shared, updated,
and refreshed. The type of date depends on the content. For example, apps have a
published date and the content within an app has an updated date. Other types of
content display shared and refreshed dates.

It's less helpful to know which type of timestamp goes where, and more helpful to know
where to find a timestamp. The following are general guidelines to help you determine
the freshness of your content.

In a list of content in the Power BI service, there's an owner column and a timestamp
column. The type of owner and timestamp depends on the content. The following
example shows the Publisher name and Published date on the Apps page.

Different types of timestamps

Content lists



The next example shows the Owner of the content and the Shared date when you go to
the Browse page and then the Shared with me tab.

The final example shows a content list in a workspace. The Owner of the content, the
Refreshed date, and the date of the Next refresh are listed.







https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-fresh/power-bi-app.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-fresh/power-bi-app.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-fresh/power-bi-shared.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-fresh/power-bi-shared.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-fresh/power-bi-app-workspace-list.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-fresh/power-bi-app-workspace-list.png#lightbox


The designer sets up the refresh schedule for content. Some content gets updated
continually and other content might refresh daily, weekly, or not at all. Not all content is
scheduled for refreshing, so you might see empty entries. If an error occurs during a
refresh, an error icon appears in the timestamp column.

In a report, there's an arrow on the title bar. Select the arrow to see contact information
and a timestamp. Dashboards, worksheets, and scorecards show the owner but not a
timestamp. Select the Owner or Contact link if you have questions or suggestions for
the owner of the report.

The dashboard title menu shows a contact, but not a timestamp. However, you can view
the last refresh date for individual dashboard tiles and for the underlying semantic
model.

1. View a tile in Focus mode to see the Last refresh timestamp. On a dashboard tile,
select More options (...) and choose Open in focus mode.

View reports

View dashboards



The last refresh date is in the upper right corner. If you don't see it, expand your
browser to make it wider.

2. Open a dashboard, select More actions (...), and then choose See related content
from the Power BI upper menu bar.



The Related content pane shows the last refresh information for the dashboard or
report's underlying semantic model.



Feedback

Was this page helpful?

Provide product feedback | Ask the community

There are built-in Power BI features available that can help you stay up-to-date with
your most important content.

To be notified if data goes above or below a specified limit, Create a data alert for a
dashboard. Stay up-to-date by using data alerts. Adjust your settings, so Power BI sends
you an email if a value on a dashboard passes a specific threshold. For example, receive
an alert if inventory falls below 25 units or if sales exceed a specified goal.

Another way to stay up-to-date is to subscribe to a report or dashboard. Instead of
logging in to view a report or dashboard, have a snapshot sent to you on a schedule
that you set. For more information, see subscribe to dashboards and reports.

Each individual piece of content within an app has its own updated date and owner.
That information might be different from the published date and app owner for the
entire app.

Create a data alert
Subscribe to dashboards and reports
View related content

Stay in sync with your content

Set data alerts

Subscribe to see changes

Considerations and limitations

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi
https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-subscribe
https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-subscribe


Display content in more detail: focus
mode and full screen mode
Article • 04/02/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

You want your reports, dashboards, visuals, and tiles to display a certain way. Power BI
offers you many options to get it just right. Two of those options: the View menu and
Focus mode are discussed in this article. Used together, you can achieve the display that
you want. And these display options aren't just for viewing, you can interact with the
reports, dashboards, and visuals in all of these display modes. Most of these display
options are also available in Power BI Desktop.

Focus mode and full screen mode are two different ways to see more detail in your
visuals, reports, and dashboards. Full screen mode is applied to the current contents of a
report canvas or dashboard. It removes all the panes surrounding your content. Focus
mode is applied to individual report visuals or dashboard tiles. It enlarges the tile or
visual along with filters, menus, and navigation panes. Let's take a closer look at the
similarities and differences.

Content Focus
mode

Full screen mode

Dashboard No Yes

７ Note

This video might use earlier versions of Power BI.

https://www.youtube-nocookie.com/embed/dtdLul6otYE

 Tip

Reports can be navigated using keyboard shortcuts.

Focus mode versus full screen mode

ﾉ Expand table

https://www.youtube-nocookie.com/embed/dtdLul6otYE
https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-accessibility-consuming-tools


Content Focus
mode

Full screen mode

Report page No Yes

Report visual Yes Yes, if it's already in focus mode and therefore the only visual on
the report canvas.

Dashboard tile Yes No

Windows 10
mobile

No Yes

In the following example, we started with a report (1), opened one of the visuals in focus
mode (2) and then opened that same visual in full screen mode (3).



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-focus/power-bi-reports.png#lightbox


0c503460d027dc8fd874b257f9554b0d6c46955a

Display your Power BI service content (dashboards, report pages, and visuals) without
the distraction of menus and nav panes. You get an unadulterated, full view of your
content at a glance, all the time. This view is sometimes referred to as TV mode.

If you're using the Power BI windows app, Screenshot of full screen in Power BI Windows
app.

Use full screen mode to:

Present your dashboard, visual, or report at a meeting or conference.
Display in an office on a dedicated large screen or projector.
View on a small screen.
Review in locked mode--you can touch the screen or mouse over tiles without
opening the underlying report or dashboard.

Focus mode lets you expand (pop out) a visual or tile to see more detail. Maybe you
have a dashboard or report that is a little crowded and you want to zoom in on only one



When to use full screen mode



When to use focus mode

https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-windows-10-app-presentation-mode
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-focus/power-bi-reports.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-focus/power-bi-dashboard-focus.png#lightbox


visual. This function is a perfect use of focus mode.

While in focus mode, you can interact with any filters that were applied when this visual
was created.

Full screen mode is available for dashboards and report pages.

To open a dashboard in full screen mode, select the full screen icon  from the
top menu bar.

To open a report page in full screen mode, select View > Full screen.



Work in full screen mode

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-focus/power-bi-compare.png#lightbox


To see a visual in full screen mode, first open it in focus mode so that it's the only
visual on the report page. Then open that report page in full screen mode.

Your selected content fills the entire screen. When you're in full screen mode, navigate
using the menu bar at the bottom. If you don't see menu options for a dashboard, move
your cursor, and the menu appears. Because full screen is available for such a wide
variety of content, the navigation options vary. Some of the options are:

Select the Back, Go back, or Back to report button to navigate to the previous
page in your browser. If the previous page was a Power BI page, it too displays in
full screen mode. Full screen mode persists until you exit out.

 
Use the Fit to page or Fit to screen option to display your selected content at the
largest size possible without resorting to scrollbars.

 
Sometimes you don't care about scrollbars, but you want the dashboard to fill the
entire width of the available space. Select the Fit to width button.



In full screen reports, use these arrows to move between the pages in the report.
Each page displays in full screen mode. Full screen mode persists until you exit full
screen mode.

To exit full screen mode, select the Exit full screen icon.

Focus mode is available for dashboard tiles and report visuals.

To open a dashboard tile in focus mode, hover over a tile, select More options (...)
and choose Open in focus mode.

Work in focus mode



To open a report visual in focus mode, hover over the visual and select the Focus

mode icon. 

The visual opens and fills the entire canvas. Notice that your report canvas still has a
Filters pane that you can use to interact with the visual. The Filters pane can be



collapsed.

Explore further by modifying the filters and looking for interesting discoveries in your
data. In reading view, you can't add new filters, change the fields being used in the
visuals, or create new visuals. However, you can interact with the existing filters, cross-
filter, pin, subscribe, comment, and much more.

For a dashboard tile, your changes can't be saved. For a report visual, any modifications
you make to the existing filters are saved when you exit Power BI. If you don't want

Power BI to remember your modifications, select the Reset to default button. 





https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-focus/power-bi-filter.png#lightbox
https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-focus/power-bi-filter-collapse.png#lightbox


Feedback

Was this page helpful?

Provide product feedback | Ask the community

Leave focus mode and return to the dashboard or report by selecting either Exit focus
mode or Back to report (in the upper left corner of the visual).

When using focus mode with a visual in a report, you can view and interact with all
filters: Visual level, Page level, Drillthrough, and Report level.
When using focus mode with a visual on a dashboard, you can view and interact
with only the Visual level filter.

Change the View settings for reports

Considerations and troubleshooting

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi


Favorite dashboards, reports, and apps
in the Power BI service
Article • 06/11/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

When you make content a favorite, you can access it quickly from the Favorites content
list. Favorites are typically content that you visit most often and are identified with a
filled star.

1. Open a dashboard or report that you use often. Even content that is shared with
you can be a favorite.

2. From the upper menu bar of the Power BI service, select Add to Favorites or the

star  icon.

You can also favorite a dashboard or report from anywhere you see the star icon,
such as Home, Recent, Apps, and Shared with me.

Add a dashboard or report as a favorite



You have several options for viewing your favorites.

1. To see all the content that you added as favorites, on the Browse pane, select the
Favorites tab.

From here, you can take action. You can open a favorite, identify owners, and even
share favorites with your colleagues.

2. Favorites are also available from Power BI Home. If you selected the Expanded
display mode, your favorites are listed in the Favorites + frequents section. If you
selected the Simplified display mode, your favorites are listed in the Favorites tab.

Work with favorites



If you no longer use a report, dashboard, or app as often as you used to, you can
unfavorite it. When you unfavorite content, it's removed from your Favorites list but not
from Power BI. Just select the black star to turn it back to a white star.

Unfavorite content



Feedback

Was this page helpful?

Provide product feedback | Ask the community

When you set an app as a favorite, it automatically favorites all the reports and
dashboards for that app. It isn't possible to favorite individual app reports or
dashboards.

Basic concepts for the Power BI service business user
More questions? Ask the Power BI Community .

Considerations and limitations

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi
https://community.powerbi.com/
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Print from the Power BI service
Article • 12/22/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Print an entire dashboard, a dashboard tile, a report page, or a report visual from the
Power BI service. If your report has more than one page, you need to print each page
separately. Printing isn't available from Power BI Desktop.

Report designers create most Power BI dashboards and reports for use online. They look
amazing on any device used to view them. However, when it comes time to print the
content, you might not get the results you want.

You can make changes to your browser and print settings to adjust the print job. But to
ensure your printouts match what you see in your browser, consider exporting to PDF
and then printing the PDF instead.

When you print from Power BI, your browser opens a Print window. Every browser has a
different Print window, but they all have similar options available to use and control the
look of your printout.

Here are a few quick tips you can use to format your printout.

1. Use the Landscape layout if your dashboard, report, or visual is wider than it's tall.

Print considerations

Adjust your browser print settings

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-pdf


2. Adjust the margins and scale settings to fit more onto a printed page. For example,
if your tile doesn't fit on the page, you might want to change the scale to 75%.

Experiment with your browser's settings until you get the look you like. Some browsers
even have options to print background graphics.

Dashboard



1. Open the dashboard that you'd like to print.

2. In the upper left corner, select File > Print this page.

3. If your report has a sensitivity label, decide whether you should print the
report or not.

4. Adjust your print settings.

5. Select Print.

Print a dashboard



Q: Why can't I print all the report pages at once?
A: Report pages can only be printed one page at a time.

Q: Why can't I print to PDF?
A: You have this option only if you already configured the PDF driver in your browser. If
you don't see this option, your administrator might have disabled print to PDF.

Q: Why doesn't my browser match the screenshots when I select Print?
A: The Print screens vary by browser and software version.

Q: Why am I having scaling and orientation issues (such as incorrect scaling or the
dashboard doesn't fit on the page)?
A: We can't guarantee the printed copy is exactly the same as it appears in the Power BI
service. Things like scaling, margins, visual details, orientation, and size aren't controlled
by Power BI. Try adjusting the print settings for your browser. Some of the print settings
we suggest include page orientation (portrait or landscape), margin size, and scale. If
these setting adjustments don't help, refer to the documentation for your specific
browser.

Q: Why don't I see the print option when I hover over the visual in full screen mode?
A: Go back to the dashboard or report in default view and reopen the visual in Focus
mode and then Full screen mode.

Considerations and troubleshooting

Next step



Share Power BI reports and dashboard with coworkers and others
More questions? Ask the Power BI Community

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards
https://community.powerbi.com/


See related content in the Power BI
service
Article • 11/10/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

The Related content pane shows you how your Power BI service content -- dashboards,
reports, and semantic models -- are interconnected. The Related content pane is also a
launching pad for taking action. From here you can do things like open a dashboard,
open a report, generate insights, analyze the data in Excel, and more.

In the Power BI service, reports are built on semantic models, report visuals are pinned
to dashboards, and dashboard visuals link back to reports. But how do you know which
dashboards are hosting visuals from your Marketing report? And how do you locate
those dashboards? Is your Procurement dashboard using visuals from more than one
semantic model? If so, what are they named and how can you open and edit them? Is
your HR semantic model being used in any reports or dashboards at all? Or, can it be
moved without causing any broken links? Questions like these can be answered on the
Related content pane. Not only does the pane display the related content, it also allows
you to take action on the content and easily navigate between the related content.

７ Note



In the following video, watch Will view related content for a dashboard. Then follow the
step-by-step instructions after the video to try it out yourself with the Sales and
Marketing Sample.

With a dashboard or report open, select More options (...) in the menu bar, and choose
See related content from the dropdown.

The Related content pane opens. For a dashboard, it shows all the reports that have
visualizations pinned to the dashboard and their associated semantic models. For this
dashboard, there are visualizations pinned from only one report and that report is based
on only one semantic model. If you look at the image at the beginning of this article,
you'll see related content for a dashboard that has visualizations pinned from two
reports, and one semantic model.

The related content feature does not work for streaming semantic models.

See related content for a dashboard or report

７ Note

This video might use earlier versions of Power BI Desktop or the Power BI service.

https://www.youtube-nocookie.com/embed/B2vd4MQrz4M#t=3m05s

https://www.youtube-nocookie.com/embed/B2vd4MQrz4M#t=3m05s


From here, you can take direct action on the related content, depending on your
permissions. For example, select a report or dashboard name to open it. For a listed
report, select an icon to open and edit the settings for the report, get insights, and
more. For a semantic model, review the last refresh date and time, analyze in Excel, get
insights, refresh, and more.

If you don't see "See related", look for the icon instead  . Select the icon to
open the Related content pane.
To open related content for a report, you need to be in Reading view.
The related content feature doesn't work for streaming datasets.

Tutorial: Get started creating in the Power BI service
More questions? Ask the Power BI Community

Considerations and limitations

Next steps

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-analyze-in-excel
https://learn.microsoft.com/en-us/power-bi/fundamentals/service-get-started
https://community.powerbi.com/


Recent content in the Power BI service
Article • 06/10/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Recent content is the last items you visited in the Power BI service. Recent content
includes: dashboards, reports, apps, semantic models, workspaces, scorecards, and
workbooks. When you select Recent from the Home pane, Power BI displays this
content in descending order by date. To change the sort order, select one of the
headings and choose ascending or descending. Content cannot be removed from
Recent until it is replaced by content you have viewed more recently.

Recents can also be opened from the nav pane. Select Browse > Recents.

Search and sort your list of recent content



Feedback

If your lists get long, use the Filter by keyword field, Filter button, and column sorting
function to find what you need.

Enter a keyword into the Filter by keyword field to show recent content that
includes that keyword.
Use the Filter drop-down to sort your content according to the content type or
any of the column headers.
Click a column heading to display a sorting arrow. In this example, hovering over
Location reveals the sort arrow.

The actions available to you from Recents depend on the settings assigned by the
content designer. One useful feature is the ability to add content to your list of favorites.

Black stars appear when you hover over content that is already a favorite. To make
content one of your favorites, select a white star to turn it black. 

For more information, see favorite a dashboard, report, or app.

Learn about Power BI service apps.
More questions? Ask the Power BI Community .

Add content to your Favorites list

Related content

https://community.powerbi.com/
https://community.powerbi.com/
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Navigation for Power BI business users:
global search
Article • 12/22/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

When you're new to the Power BI service, you have only a few pieces of content
(dashboards, reports, apps). But as colleagues begin sharing content with you and you
begin downloading apps, you can end up with long lists of content. That's when you
find searching and sorting helpful.

Search is available from almost every part of the Power BI service. Just look for the

search box or search icon. 

In the Search field, type all or part of the name of a dashboard, report, workbook,
workspace, app, or owner. Power BI searches all of your content.

In some Power BI areas, such as workspaces, you find two different Search fields. The
Search field in the menu bar searches all of your content while the Search field on the
workspace canvas searches only that workspace.

Search for content



If you have only a few pieces of content, sorting isn't necessary. But when you have long
lists of dashboards and reports, sorting helps you find what you need. For example, this
Shared with me content list has many items.

Right now, this content list is sorted alphabetical by name, from Z to A. To change the
sort criteria, select the arrow to the right of Name.

７ Note

Search is disabled for B2B guest users. If a guest user enters a search term, no
results are shown.

Sort content lists

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-roles-new-workspaces


Sorting is also available in workspaces. In this example, the content is sorted by the
Refreshed date. To set sorting criteria for workspaces, select a column header, and then
select again to change the sorting direction.

Not all columns can be sorted. Hover over the column headings to discover which can
be sorted.

Filter content lists



Another way to locate content quickly is to use the content list Filter. Display the filters
by selecting Filter from the upper right corner. The filters available depend on your
location in the Power BI service. This example is from a Recent content list. It allows you
to filter the list by content Type, Time, or Owner.

Search isn't enabled for B2B users
Search currently supports only English characters
Global search is currently supported only in Public cloud

Change how a chart is sorted in a Power BI report
More questions? Ask the Power BI Community

Limitations

Next step

https://community.powerbi.com/


Collaborate in workspaces
Article • 03/12/2024

Workspaces are places to collaborate with colleagues on specific content. Power BI
designers create workspaces to hold collections of dashboards and reports. The designer
can then share the workspace with colleagues. Designers can also bundle a collection of
dashboards and reports into an app and distribute it to the entire community, to their
organization, or to specific people or groups. Certain types of apps called template apps,
create a workspace when the app is installed. Learn more about apps.

Everyone using the Power BI service also has a My workspace. My workspace is your
personal sandbox where you can create content for yourself.

You can see your workspaces in Power BI by selecting Workspaces from your navigation
pane.

My Workspace stores all the content that you own and create. Think of it as your
personal sandbox or work area for your own content. For many Power BI business users,
My workspace remains empty because your job doesn't involve creating new content.
Business users, by definition, consume data created by others and use that data to make
business decisions. If you find that you're creating content, consider reading the Power
BI articles for designers instead.

Types of workspaces

https://learn.microsoft.com/en-us/power-bi/create-reports/


Workspaces contain content that can be use by one person or many. Because the
designer of the workspace can assign permissions to a workspace, it's a great place for
collaboration. Designers can share the workspace, invite collaborators, and even create
and distribute apps based on the workspace contents.

When a designer creates an app, they bundle together all the content that's necessary
for that app to be utilized. Content might include dashboards, reports, and semantic
models. Not every app contains these three pieces of content. An app might contain
only one dashboard, or three of each content type, or even 20 reports. It all depends on
what the designer includes in the app. Commonly, app workspaces shared with business
users don't include the semantic models.

The following Azure Decom workspace contains several reports and a dashboard.

Access permissions determine what you can do in a workspace, so teams can
collaborate. When designers grant access to a workspace, they add individuals or groups
to one of the workspace roles: Viewer, Member, Contributor, or Admin.

As a Power BI business user, you typically interact in workspaces using the Viewer role.
But designers can also assign you to the Member or Contributor role. The Viewer role
lets you view and interact with content (dashboards, reports, apps) created by others
and shared with you. And because the Viewer role can't access the underlying semantic
model, it's a safe way to interact with content and not have to worry that you'll "hurt"
the underlying data.

Permissions in the workspaces



For a detailed list of what you can do as a business user with the Viewer role, see Power
BI features for business users.

For a detailed list of all four roles and their capabilities, see Workspace roles.

Licensing also plays a part in determining what you can and can't do in a workspace.
Many sharing and collaborating features require that the user has a Power BI Pro or
Premium Per User (PPU) license or for the workspace to be stored in Premium capacity.

Often, business users work with a free license. Learn more about licensing. If the content
isn't stored in Premium capacity, the business user doesn't have access.

If the workspace is stored in Premium capacity, business users who are granted
permission by the designer, are able to view and interact with the content in that

workspace. This icon  identifies Premium workspaces. This icon  identifies
Premium Per User workspaces.

Licensing, workspaces, and capacity

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-roles-new-workspaces




To learn more, see Which license do I have?.

Apps in Power BI

Questions? Try asking the Power BI Community

Related content

https://community.powerbi.com/


Apps in Power BI
Article • 01/24/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Power BI designers create official packaged content, then distribute the content to a
broad audience organized as an app. Apps are created in workspaces where members
collaborate on Power BI content with their colleagues. They publish the finished app to
individuals, large groups of people in an organization, or an entire organization. An app
can have permissions that are different than the permissions set on a workspace. This
capability makes it easier for designers to manage permissions on an app.

An app combines related content, like dashboards, spreadsheets, semantic models, and
reports, all in one place. An app has one or more of each content type bundled
together. There are many ways a designer can share an app. You can learn more about
how apps are shared in the Get a new app section below.

There's a unique type of app called a template app. A Power BI Pro or Premium Per User
license is required to install, customize, and distribute a template app. Power BI partners
use the content from template apps to build and package analytical data into a new
app. They then deploy that app to other Power BI tenants through an available platform,
like AppSource or their own web service.

Depending on your role, you might be a designer who creates apps for your own use or
to share with colleagues. Or, you might be a business user who receives and downloads
apps created by others. The resources in this article are for business users.

Viewing and opening an app requires certain permissions. The recipient must have a
Power BI Pro or Premium Per User (PPU) license, or the app must be shared with the
recipient in a type of cloud storage called Premium capacity. To learn more about
licenses and Premium capacity, see Licensing for the Power BI service.

What is a Power BI app?

App designers and app users

Advantages of apps

https://learn.microsoft.com/en-us/power-bi/connect-data/service-template-apps-install-distribute


Apps are an easy way for designers to share many types of content at one time. App
designers create dashboards and reports and then bundle them together into an app.
The designers share or publish the app to a location where you, the business user, can
access it. It's easier to find and install content in the Power BI service  or on your
mobile device when it's organized together as an app. After you install an app, you don't
have to remember the names of several dashboards or reports because they're all
together in one app. You can easily access the app in your browser or on your mobile
device.

When the app author releases updates, you get a notification or you automatically see
the changes. The author controls how often the data is scheduled to refresh, so you
don't need to worry about keeping it up to date.

There are several ways to get a new app. You can search, find, and install apps in the
apps marketplace, or app designers can share apps with you.

1. To find apps in the apps marketplace, select Apps on your navigation pane.

2. On the Apps page, select Get apps.

Get a new app

Find and install apps from the Power BI apps marketplace

https://powerbi.com/


3. Browse through the list of apps in the Power BI apps marketplace until you find
one to install. Organizational apps are only available to people in your company.
Template apps are published by Microsoft and the community, and they're
available for any Power BI user with a Pro license to install.

4. After you install an app, it's available in your Apps content list. Select Apps in the
navigation pane to display your apps. The last updated date and the owner are on
the bottom of each app card.



For detailed step-by-step instructions for getting and exploring an app, see Install and
use apps with dashboards and reports in Power BI.

There are a few other ways to get apps.

The app designer installs the app automatically in your Power BI account. The next
time you open the Power BI service, the new app is in your Apps content list.
The app designer emails you a direct link to an app. Selecting the link opens the
app in the Power BI service.
In Power BI on your mobile device, you can only install an app from a direct link,
and not from the apps marketplace. If the app author installs the app
automatically, it's available in your list of apps.

Install and use apps with dashboards and reports in Power BI
Other ways to share content

Related content

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-shared-with-me


Install and use apps with dashboards
and reports in Power BI
Article • 11/07/2023

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Now that you have a basic understanding of apps, you can learn how to open and
interact with them.

You can get a new app:

From the Power BI apps marketplace in the Power BI service.
By using a direct link to an app that you receive from the app designer.
When an app designer in your organization installs the app automatically in your
Power BI account.

With Power BI mobile, you can only install an app from a direct link. The Power BI apps
marketplace isn't available in Power BI mobile. If the app designer installs the app
automatically, you'll see it in your list of apps.

Not all Power BI users can view and interact with apps. If you have a free license, you can
open apps that are stored in Premium capacity and that are shared with you. If you have
a Pro license or a Premium Per User license, you can open apps that are shared with you.

So, if you can't open an app, contact your administrator or help desk. For information
about licensing, see Power BI licensing.

You can find and install apps from the Power BI apps marketplace. In the apps
marketplace, you'll find both organizational apps and template apps.

Ways to get a new app

Apps and licenses

Get the app from the Power BI apps
marketplace



An organizational app is available to Power BI users in your organization. These
apps also include pre-built dashboards and reports that you can use as-is or
customize and share. Your organization might have apps for things like tracking
sales, measuring performance, or analyzing hiring success.
A template app comes with pre-built dashboards and reports that you can use to
connect to many of the services you use to run your business, such as SalesForce,
Microsoft Dynamics, and Google Analytics.

1. To install an app, sign in to the Power BI service if prompted.

2. Select Apps > Get apps.
If you're brand new to Power BI, your App page looks like the following example. If
you already have apps installed, select Get apps from the upper right corner of the
page.

3. The Power BI apps marketplace opens.



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-app-view/power-bi-get-apps.png#lightbox


Three tabs are available for you to use:

All apps - Browse both template apps and all the organizational apps that are
available to you. Template apps are distinguished by the shopping bag icon
in the upper right corner of their tiles.
Organizational apps - Browse organizational apps that have been shared
with you.
Template apps - Browse template apps that are hosted on AppSource.

Alternatively, you can use the search box to get a filtered selection of apps. Type
part of the name of an app or category, such as finance, analytics, or marketing, to
make it easier to find the item you're looking for.

The search box is sensitive to the tab you have open. Only apps of the selected
type are returned. If the All apps tab is open, both organizational and template
apps are returned. It can be confusing when an organizational app and a template
app have the same name. Just remember that the template app tiles have a
shopping bag icon in the top right corner.

4. When you find the app that you want, select Get it Now to install it.



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-app-view/power-bi-app-marketplace.png#lightbox


If you're installing an organizational app, it will immediately be added to your list
of apps.

If you're installing a template app, you'll be taken to the template app offering in
AppSource. See an example of how to download and install a sample template app
from the Power BI apps marketplace. The app is installed, along with a workspace
of the same name.

You can also install an organizational app from a direct link:

On your computer. When you select the link in an email, the Power BI service
opens the app in your browser.

７ Note

If you're using a free user license, you can download apps but you can't view
them unless you upgrade to a Power BI Pro or Premium Per User license or
unless the app is stored in a Premium capacity. For more information, see
Licenses for business users.

Install an app from a direct link

https://app.powerbi.com/


On your iOS or Android mobile device. When you select the link in an email on
your mobile device, the app installs automatically and opens in the mobile app.
You might have to sign in first.

Take some time to explore the data in the dashboards and reports that make up the
app. You have access to all of the standard Power BI interactions, such as filtering,
highlighting, sorting, and drilling down. The extent of what you can do with an app is
controlled by the permissions that the designer assigned to you. How you can interact
with the app's dashboards and reports is controlled by the access and roles that the
designer assigned to you.

Still a little confused by the difference between dashboards and reports? Learn more
about dashboards or reports in Power BI.

1. After you install an app or receive an app from a colleague, view it in your Apps
content list by selecting Apps from the navigation pane. The following example
shows the App page view set to Gallery. You can select View and then choose List
to see your apps as a list.

2. Select the app to open it. Depending on the app, you might receive a prompt that
looks similar to the following example. Some apps ask you for contact information

Interact with the dashboards and reports in the
app

Open an app



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-app-view/power-bi-apps-card.png#lightbox


(name and email) or for product details (customer ID, subscription number, or
parameters). Many apps load with sample data and provide a link for you to
connect your own data. For guidance on which option to select, see Install
template apps.

3. Select the app card to open it.

4. The Sales and Marketing Sample app opens to a report. The layout might look
different if your app opens to a dashboard. If you select a report in the dashboard,
the layout will look like the following example.

https://learn.microsoft.com/en-us/power-bi/connect-data/service-template-apps-install-distribute


Apps have different layouts, visuals, colors, and options, but they all have most of the
features shown in this example:

1. Name of the app and last updated time. Select the dropdown arrow to look up the
owner and Help contact.

2. Select Power BI to return to Home.
3. Your menu bar.
4. The report page canvas.
5. The app navigation pane. Below the name of the app is the list of content. This app

has one report with six pages. Select a report page name to open it. We currently
have the Return rate page open.

6. Select the arrow to expand the Filters pane.

You can explore the associated workspace if you've been given access. When you install
or download a template app, the Power BI service creates a workspace for you. When
you install an organizational app, it might not include access to the workspace. For more
information, see Collaborate in workspaces. Select Power BI (number 2) to return to
Home and choose Workspaces.



https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-app-view/power-bi-app-number.png#lightbox


You can share reports and dashboards that are in an app the same way you share any
other report or dashboard:

Open the report or dashboard, and select Share.

See the article Share Power BI reports and dashboards with coworkers and others for
more information.

Sometimes app designers release new versions of their apps. How you get the new
version depends on how you received the original.

If you got the app from your organization, the update to the new version is
automatic and you don't have to do anything.

Share reports and dashboards from an app

Get an update of an app

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards


If you got a template app from AppSource, the next time you open the app you'll
see a notification banner. The notification lets you know that a new version is
available.

1. Select Get it to update.

2. When prompted to install the updated app, select Install.

3. Because you already have a version of this app, you can decide whether you
want to replace the existing version, update only the workspace content
without updating the app, or install the updated app in a new workspace.

７ Note



4. Once you've installed the updated version, select Update app to complete
the update process.

The ability to install apps can be turned on and off by your Power BI administrator.
Contact your IT department or help desk if you need this feature enabled.
The use of apps requires either a Pro or Premium Per User license or for the app to
be stored in a workspace in Premium shared capacity. Learn about licenses.

Back to the apps overview
View a Power BI report
Other ways content is shared with you

Installing a new version overwrites any changes you might have made to the
app's reports and dashboards. To keep your updated reports and dashboards,
save them under a different name or in a different location before installing.

Considerations and troubleshooting

Next steps

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-shared-with-me


Discover data items using the data hub
Article • 06/12/2024

The data hub helps you find, explore, and use data items in your organization, such as
semantic models, datamarts, and their related reports. It provides information about the
data items and about reports built using those items. In this way, report consumers can
find reports based on trustworthy data.

This article explains what you see on the data hub and describes how to use it. For more
details and advanced features available on the data hub, see Data discovery using the
data hub.

The data discovery experience starts on the data hub. To get to the data hub:

In the Power BI service left navigation pane, select Data hub.
In the Power BI app in Teams, select either the Data hub tab or Data hub in the
navigation pane.

The image shows the OneLake data hub in the Power BI service.

The data hub shows a selection of recommended data items and a list of all the data
items in the organization that you have permissions to access. If semantic model

Find the data you need

https://learn.microsoft.com/en-us/power-bi/connect-data/service-data-hub
https://learn.microsoft.com/en-us/power-bi/connect-data/service-data-hub
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-discovery


Feedback

Was this page helpful?

Provide product feedback | Ask the community

discoverability is enabled for your account, you also see a list of semantic models.

Continue learning about the OneLake data hub. Explore how to select a semantic model,
how to explore reports built using a semantic model, and how to create a new report
yourself.

Learn about Data discovery using the data hub
Learn how to Find your dashboards, reports, and apps

Related content

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-discovery
https://learn.microsoft.com/en-us/power-bi/connect-data/service-data-hub
https://learn.microsoft.com/en-us/power-bi/connect-data/service-data-hub


Connect to the services you use with
Power BI
Article • 01/09/2023

With Power BI, you can connect to many of the services you use to run your business,
such as Salesforce, Microsoft Dynamics, and Google Analytics. Power BI starts by using
your credentials to connect to the service. It creates a Power BI workspace with a
dashboard and a set of Power BI reports that automatically show your data and provide
visual insights about your business.

Sign in to Power BI to view all of the services you can connect to. Select Apps > Get
apps.

After you install the app, you can view the dashboard and reports in the app and the
workspace in the Power BI service (https://powerbi.com ). You can also view them in
the Power BI mobile apps. In the workspace, you can modify the dashboard and reports
to meet the needs of your organization, and then distribute them to your colleagues as
an app.

https://powerbi.com/


1. Select Apps in the navigation pane, then choose Get apps in the upper-right
corner.

2. In Power BI apps, select the Apps tab, and search for the service you want.

Get started



When the import is complete, the new app appears on the Apps page.

1. Select Apps in the navigation pane, then choose the app.

2. You can ask a question by typing in the Q&A box, or select a tile to open the
underlying report.

Edit the dashboard and reports



Change the dashboard and report to fit the needs of your organization. Then
distribute your app to your colleagues

After connecting to a service, you see a newly created app and workspace with a
dashboard, reports, and dataset. The data from the service is focused on a specific
scenario and might not include all the information from the service. The data is
scheduled to refresh automatically once per day. You can control the schedule by
selecting the dataset.

You can also connect to many services in Power BI Desktop, such as Google Analytics,
and create your own customized dashboards and reports.

For more information on connecting to specific services, see the individual help pages.

Empty tiles: While Power BI is first connecting to the service, you might see an empty
set of tiles on your dashboard. If you still see an empty dashboard after two hours, it's
likely the connection failed. If you didn't see an error message with information on
correcting the issue, file a support ticket.

Select the question mark icon (?) in the upper-right corner > Get help.

What's included

Troubleshooting

https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-create-distribute-apps
https://learn.microsoft.com/en-us/power-bi/connect-data/desktop-data-sources


Missing information: The dashboard and reports include content from the service
focused on a specific scenario. If you're looking for a specific metric in the app and don't
see it, add an idea on the Power BI Support  page.

Do you use a service you'd like to suggest for a Power BI app? Go to the Power BI
Support  page and let us know.

If you're interested in creating template apps to distribute yourself, see Create a
template app in Power BI. Power BI partners can build Power BI apps with little or no
coding, and deploy them to Power BI customers.

Distribute apps to your colleagues
Create workspaces in Power BI
Questions? Try asking the Power BI Community

Suggesting services

Next steps

https://support.powerbi.com/forums/265200-power-bi
https://support.powerbi.com/forums/265200-power-bi
https://learn.microsoft.com/en-us/power-bi/connect-data/service-template-apps-create
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-create-distribute-apps
https://learn.microsoft.com/en-us/power-bi/collaborate-share/service-create-the-new-workspaces
https://community.powerbi.com/


Install and use the sample Sales and
Marketing app in the Power BI service
Article • 02/15/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Now that you have a basic understanding of how to get Power BI content, let's use
Microsoft AppSource to add the Marketing and Sales template app to Power BI. The
Marketing and Sales template app contains sample data that you can use to explore the
Power BI service. This particular app has one dashboard and several report pages.

1. Open https://appsource.microsoft.com .

2. In the search box, enter Microsoft sample and select Microsoft sample - Sales &
Marketing.

） Important

Installing this app from Microsoft AppSource requires that you have a Power BI Pro
or Premium Per User license. For more information, see licenses.

Get the app from Microsoft AppSource

https://appsource.microsoft.com/


3. Optionally, read through the overview and reviews, and take a look at the images.
Then, select Get it now > Install.

4. The Power BI service displays a success message once the app is installed. Select
Go to workspace. Or select the app itself from the Apps container.

5. Depending on how the designer created the app, either the app dashboard or app
report displays. This template app is set to open to the dashboard.



Take some time to explore the data in the dashboard and reports that make up the app.
You have access to all of the standard Power BI interactions such as filtering,
highlighting, sorting, and drilling down. If you're confused by the difference between
dashboards and reports, see the article about dashboards and the article about reports.

View Apps in Power BI
View a report in the Power BI service for business users
Display the dashboards and reports that are shared with me

Interact with the dashboards and reports in the
app

Related content

https://learn.microsoft.com/en-us/power-bi/collaborate-share/end-user-shared-with-me


Q&A for Power BI business users
Article • 01/11/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Sometimes the fastest way to get an answer from your data is to ask a question using
natural language. For example, "show total units by year and product manufacturer."

Use Q&A to explore your data using natural language capabilities and receive answers
in the form of charts and graphs. Unlike a search engine, Q&A only provides results
about the data in Power BI semantic models.

To learn how to use Q&A, see Explore your data and create visuals using Q&A.

Q&A picks the best visual based on the data. Sometimes data is defined as a certain
type or category, which helps Q&A know how to display it. For example, if data is
defined as a date type, it's more likely to be displayed as a line chart. Data that is
categorized as a city is more likely to be displayed as a map.

What is Q&A?

Which visualizations does Q&A use?

https://learn.microsoft.com/en-us/power-bi/natural-language/q-and-a-intro


If you want a specific type of visual, tell Q&A which one to use by adding it to your
question. For example, "show me total sales by category as a treemap." But keep in
mind that it isn't always possible for Q&A to display the data using the visual type you
requested. Q&A prompts you with a list of workable visual types.

Q&A is available on dashboards in the Power BI service, and at the bottom of the
dashboard in Power BI mobile. If the dashboard designer gave you edit permissions,
save the visual by pinning it to your dashboard.

Where can I use Q&A?

Use Q&A on a dashboard

https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-pin-tile-from-q-and-a


To learn more, see Use Q&A on a dashboard.

Q&A is available in reports if the report designer added a specific type of interactive
visual called a Q&A visual or added a Q&A button. Ask natural language questions and
create new report visuals that represent the answers to your questions. If you have edit
permissions for the report, turn the results into a new visual in the report.

To learn more, see Use Q&A in a report.

Q&A is available in Power BI iOS apps and in Power BI embedded analytics as well.

Use Q&A in a report

Use Q&A in mobile apps and embedded reports

Considerations and limitations

https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-q-and-a
https://learn.microsoft.com/en-us/power-bi/create-reports/desktop-buttons#select-the-action-for-a-button
https://learn.microsoft.com/en-us/power-bi/natural-language/power-bi-tutorial-q-and-a
https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna
https://learn.microsoft.com/en-us/power-bi/developer/embedded/qanda


Question: I don't see Q&A on this dashboard.

Answer 1: If you don't see a question box, check your settings. Select the Settings icon
in the upper right corner of your Power BI toolbar.

Choose Power BI Settings > Dashboards. Highlight the dashboard that doesn't have a
Q&A question box. Make sure there's a check mark next to Show the Q&A search box
on this dashboard.

Answer 2: Sometimes you don't have access to the settings. If the dashboard owner or
your administrator turned Q&A off, check with them to see if it's OK to turn it back on.
To look up the owner, select the name of the dashboard from the top menu bar.

Question: I'm not getting the results I'd like to see when I type a question.

Answer: Select the option to contact the report or dashboard owner. You can find the
report or dashboard owner from the Q&A dashboard page or the Q&A visual. Or, you
can look up the owner from the Power BI header. There are many things the owner can

https://learn.microsoft.com/en-us/power-bi/natural-language/q-and-a-tooling-intro


do to improve the Q&A results. For example, the owner can rename columns in the
semantic model to use terms that are easily understood ( CustomerFirstName  instead of
CustFN ). Since the owner knows the semantic model, they can also come up with helpful
questions and add them to the Q&A suggested questions.

Microsoft might use your questions to improve Power BI. For more information about
how Microsoft uses your questions, see the Microsoft Privacy Statement  for more
information.

To learn how to ask your own natural language questions and create answers in
the form of visuals, see Use Q&A on a dashboard or Use Q&A in a report.

For tips on forming questions, see How to ask questions with Q&A.

If you have edit permissions, learn how to create a Q&A visual on a dashboard and
add a Q&A visual in a report.

Privacy

Related content

https://learn.microsoft.com/en-us/power-bi/natural-language/q-and-a-tooling-intro
https://go.microsoft.com/fwlink/?LinkId=521839
https://learn.microsoft.com/en-us/power-bi/natural-language/power-bi-tutorial-q-and-a
https://learn.microsoft.com/en-us/power-bi/create-reports/power-bi-visualization-introduction-to-q-and-a
https://learn.microsoft.com/en-us/power-bi/visuals/power-bi-visualization-q-and-a


Tutorial: Use Power BI Q&A to explore
your data and create visuals on a
dashboard
Article • 11/10/2023

APPLIES TO:  Power BI Desktop  Power BI service

Q&A is available throughout Power BI, and this article focuses on using Q&A on a
dashboard. We import a sample and use Q&A to explore our data and pin interesting
findings to our dashboard.

Read the Q&A intro article Q&A for Power BI business users.

Sign up for a free or trial license for the Power BI service.

Open the Power BI service in a browser.

Download and open the Retail analysis sample.

1. Open the Power BI service ( app.powerbi.com ), and select Learn in the left
navigation pane.

2. On the Learning center page, under Sample reports, scroll until you see the Retail
Analysis Sample.

3. Select the sample. It opens in Reading mode.

Prerequisites

Import the sample in the Power BI service

https://learn.microsoft.com/en-us/power-bi/fundamentals/service-self-service-signup-purchase-for-power-bi


4. Select My workspace in the left navigation pane and scroll until you find the Retail
Analysis sample. Power BI imports the built-in sample, adding a new dashboard,
report, and semantic model to the current Retail Analysis workspace.

In the Power BI service (app.powerbi.com), a dashboard contains tiles pinned from one
or more semantic models, so you can ask questions about any of the data contained in
any of those semantic models. To see what reports and semantic models were used to
create the dashboard, select More options (...) from the menu bar, and then choose See
related content.



Get started using Q&A on a dashboard

https://learn.microsoft.com/en-us/power-bi/natural-language/media/end-user-q-and-a-tutorial/power-bi-sample-read-mode.png#lightbox


When you type a question, Power BI looks for the best answer using any semantic
model that has a tile on that dashboard. If all the tiles are from semantic modelA, then
your answer comes from semantic modelA. If there are tiles from semantic modelA and
semantic modelB, then Q&A searches for the best answer from those two semantic
models.

In our example, most of the tiles on this dashboard are from the Retail analysis sample.
To help form your questions, get familiar with the Retail analysis sample content. Take a
look at the visuals on the dashboard and in the report. Get a feel for the type and range
of data that is available to you. Optionally, read the article that describes the sample,
Retail Analysis sample for Power BI: Take a tour.

For example:

If a visual's axis labels and values include "sales", "account", "month", and
"opportunities", then you can confidently ask questions such as: "Which account
has the highest opportunity" or "show sales by month as a bar chart."

If your semantic model has website performance data for Google Analytics, you
can ask Q&A about time spent on a web page, number of unique page visits, and
user engagement rates. Or, if you're querying demographic data, you might ask
questions about age and household income by location.

Once you're familiar with the data, head back to the dashboard and place your cursor in
the question box. The Q&A screen opens.

 Tip

Be careful. If you only have one tile from semantic modelA and you remove it from
your dashboard, Q&A will no longer have access to semantic modelA.

７ Note

If you already feel comfortable with the data, just place your cursor in the question
box to open the Q&A screen.

https://learn.microsoft.com/en-us/power-bi/create-reports/sample-retail-analysis


Don't see the Q&A box? See Considerations and limitations in the Q&A for for Power BI
business users article.

The Q&A field is where you type your question using natural language. It's located in
the upper-left corner of your dashboard. Q&A recognizes the words you type and
figures out where, and in which semantic model, to find the answer. Q&A also helps you
form your question with autocompletion, restatement, and other textual and visual aids.

Let's try it out.

1. Open a dashboard and place your cursor in the Q&A field.

Even before you start typing, Q&A displays a new screen with suggestions to help
you form your question. You see phrases and complete questions containing the
names of the tables in the underlying semantic models and might even see
complete questions listed if the semantic model owner has created featured
questions.

Use Q&A on a dashboard in the Power BI
service

Create a visual using the Q&A field on a dashboard

https://learn.microsoft.com/en-us/power-bi/natural-language/q-and-a-intro
https://learn.microsoft.com/en-us/power-bi/create-reports/service-q-and-a-create-featured-questions


2. You can select any of these options to add them to the question box and then
refine the question to find a specific answer.

3. If you're unsure what type of questions to ask or terminology to use, expand Show
all suggestions or look through the other visuals in the report. These techniques
get you familiar with the terms and content of the semantic model.



4. Choose one of these questions as a starting point or begin typing your own
question and select from the dropdown suggestions.

5. As you type a question, Power BI helps you with autocomplete, visual cues,
restatement, and feedback. Power BI also picks the best visualization to display
your answer.



6. The visualization changes dynamically as you modify the question.

7. Don't like the default visualization that Power BI Q&A chose? Edit the natural
language question to include the visualization type that you'd prefer.



8. When you're happy with the result, pin the visualization to a dashboard by
selecting the pin icon in the top right corner. If the dashboard was shared with
you, or is part of an app, you might not be able to pin.

Considerations and limitations



If you've connected to a semantic model using a live connection or gateway, Q&A
needs to be enabled for that semantic model.

At the current time, Power BI Q&A only supports answering natural language
queries asked in English. There's a preview available for Spanish that your Power BI
administrator can enable.

Q&A for Power BI business users
Tips for asking questions in Power BI Q&A
Make Excel data work well with Q&A in Power BI
Enable Q&A for live connections in Power BI
Pin a tile to the dashboard from Q&A

Related content

https://learn.microsoft.com/en-us/power-bi/create-reports/service-q-and-a-direct-query
https://learn.microsoft.com/en-us/power-bi/create-reports/service-prepare-data-for-q-and-a
https://learn.microsoft.com/en-us/power-bi/create-reports/service-q-and-a-direct-query
https://learn.microsoft.com/en-us/power-bi/create-reports/service-dashboard-pin-tile-from-q-and-a


Tips for asking questions in Power BI
Q&A
Article • 01/16/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

The list of keywords on this page isn't exhaustive. The best way to see if Power BI
recognizes a keyword is to try it out by typing it in the question box. If the word or term
is grayed out, then Power BI doesn't recognize it. Even when Power BI doesn't recognize
a word, it makes a best guess.

The list below uses present tense, but all tenses are recognized in most cases. For
example, "is" includes: are, was, were, will be, have, has, had, will have, has got, do,
does, and did. And "sort" includes: sorted and sorting. Power BI also recognizes and
includes singular and plural versions of a word.

Category Keywords

Aggregates total, sum, amount, number, quantity, count, average, most, least, fewest,
largest, smallest, highest, biggest, maximum, max, greatest, lowest, littlest,
minimum, min

Articles a, an, the

Blank and
Boolean

blank, empty, null, prefixed with "non" or "non-", empty string, empty text, true,
t, false, f

Comparisons vs, versus, compared to, compared with

Conjunctions and, or, each of, with, versus, &, and, but, nor, along with, in addition to

Words and terminology that Q&A recognizes

７ Note

Q&A is also available in the Microsoft Power BI app for iOS on iPads, iPhones, and
iPod Touch devices.

ﾉ Expand table

https://learn.microsoft.com/en-us/power-bi/consumer/mobile/mobile-apps-ios-qna


Category Keywords

Contractions Q&A recognizes almost all contractions. Try it out. Here are a few examples:
didn't, haven't, he'd, he's, isn't, it's, she'll, they'd, weren't, who's, won't, wouldn't

Dates Power BI recognizes most date terms (day, week, month, year, quarter, decade,
...) and dates written in many different formats (see Relative dates). Power BI
also recognizes the following keywords: MonthName, Days 1-31, decade.
Examples: January 3rd of 1995, January 3rd 1995, Jan 03 1995, 3 Jan 1995, the
3rd of January, January 1995, 1995 January, 1995-01, 01/1995, names of
months

Relative dates today, right now, current time, yesterday, tomorrow, the current, next, the
coming, last, previous, ago, before now, sooner than, after, later than, from, at,
on, from now, after now, in the future, past, last, previous, within, in, over, N
days ago, N days from now, next, once, twice. Example: count of orders in the
past six days.

Equality
(Range)

in, equal to, =, after, is more than, in, between, before

Examples: Order year is before 2012? Price equals between 10 and 20? Is the
age of John greater than 40? Total sales in 200-300?

Equality
(Value)

is, equal, equal to, in, of, for, within, is in, is on

Examples: Which products are green? Order date equals 2012. Is the age of
John 40? Total sales that aren't equal to 200? Order date of 1/1/2016. 10 in
price? Green for color?

Names If a column in the semantic model contains the phrase "name" (for example,
EmployeeName), Q&A understands the values in that column are names. You
can ask questions like "which employees are named Robert."

Pronouns he, him, himself, his, she, herself, her, hers, it, itself, its, they, their, them,
themselves, theirs, this, these, that, those

Query
commands

sorted, sort by, direction, group, group by, by, show, list, display, give me,
name, just, only, arrange, rank, compare, to, with, against, alphabetically,
ascending, descending, order

Range greater, more, larger, above, over, >, less, smaller, fewer, below, under, <, at
least, no less than, >=, at most, no more than, <=, in, between, in the range of,
from, later, earlier, sooner, after, on, at, later than, after, since, starting with,
starting from, ending with

Times am, pm, o'clock, noon, midnight, hour, minute, second, hh:mm:ss

Examples: 10 pm, 10:35 pm, 10:35:15 pm, 10 o clock, noon, midnight, hour,
minute, second.



Category Keywords

Top N (order, ranking): top, bottom, highest, lowest, first, last, next, earliest, newest,
oldest, latest, most recent, next

Visual types all visual types native to Power BI. If it's an option in the Visualizations pane,
then you can include it in your question. The exception to this rule is Power BI
custom visuals that you manually added to the Visualization pane.

Example: show districts by month and sales total as bar chart

Wh
(relationship,
qualified)

when, where, which, who, whom, how many, how much, how many times, how
often, how frequently, amount, number, quantity, how long, what

Q&A does its best to understand and answer the question being asked. It tries to
understand in several ways. For all of these phrasings, you can accept the action in full,
in part, or not at all. As you type your question, Q&A:

Autocompletes words and questions. It uses various strategies, including
autocompleting recognized words, stored questions, and previously used
questions that returned valid responses. If more than one autocomplete option is
available, they're presented in a dropdown list.
Corrects spelling.
Provides a preview of the answer in the form of a visual. The visual updates as you
type and edits the question (it doesn't wait for you to press Enter).
Suggests replacement terms from one or more of the underlying semantic models
when you move the cursor back in the question box.
Restates the question based on the data in the underlying semantic models. Q&A
replaces the words you used with synonyms from the underlying semantic models.
By reading the restatement, you know whether Q&A understood your question or
not.
Adds a double underline to words it tries to understand.
Adds a single underline to words it does understand.
Adds a dotted underline to words it doesn't understand. These words might be in
the Recognized words list that you expect Q&A to understand. But, you might
have used that word in an unexpected way.
Allows you to contact the report or dashboard owner when your term isn't found
or your question doesn't get results.

Q&A helps you phrase the question

https://learn.microsoft.com/en-us/power-bi/developer/visuals/develop-power-bi-visuals


When typing natural language queries with Power BI Q&A, you can specify the visual
type in your query. For example:

"sales by state as treemap"

After Q&A displays your results, keep the conversation going. Use the interactive
features of the visual and of Q&A to uncover more insights.

Go to Q&A for Power BI business users
See Basic concepts for the Power BI service business user
More questions? Ask the Power BI Community

Tell Q&A which visual to use

Don't stop now

Related content

https://community.powerbi.com/


Glossary for business users of the Power
BI service
Article • 11/13/2023

The Power BI service can introduce terminology that is unfamiliar or confusing. The
glossary is a great place to look up terminology—you might want to bookmark it.
Another great resource for learning about the building blocks that make up Power BI
service is Basic concepts for the Power BI service business user. The article gives a high
level overview of the Power BI pieces and how they're connected.

This glossary is a community effort. If you don't see a word here, please ask us to add it
(you can use the documentation feedback button at the bottom of this article).

account

Use your work or school account to sign in to Power BI. Administrators manage work or
school accounts in Azure Active Directory. Your level of access is determined by the
Power BI license associated with that account and the capacity type where content is
stored. See license and Premium.

Admin portal

The location where Power BI admins manage users, features, and settings for Power BI in
their organization.

aggregates

When the values of multiple rows are grouped together as input on criteria to form a
single value of more significant meaning or measurement. Only implicit measures (see
definition) can be aggregated.

aggregation

The reduction of rows in underlying data sources to fit in a model. The result is an
aggregate.

A

７ Note

Microsoft 365, Azure, and PowerApps use Admin center.)



alert, alerts

A feature that notifies users of changes in the data based on limits they set. Alerts can
be set on tiles pinned from report visuals. Users receive alerts on the service and on
their mobile app.

annotate

To write lines, text, or stamps on a snapshot copy of a tile, report, or visual on the Power
BI mobile app for iOS and Android devices.

app, apps

A bundle of dashboards, reports, and semantic models. It also refers to the mobile apps
for consuming content, such as the Power BI app for iOS.

AppSource

Centralized online repository where you can browse and discover dashboards, reports,
semantic models, and apps to download.

ArcGIS for Power BI

ArcGIS is a mapping and analytics platform created by the company Esri. The name of
the visual included in the Power BI visuals library is called ArcGIS for Power BI.

Auto Insights

Auto Insights are now called Quick Insights.

BI

Business intelligence.

bookmark

A view of data captured in the Bookmarks pane of a report in Power BI Desktop or
service. In Desktop, the bookmarks are saved in the pbix report file for sharing on the
Power BI service.

breadcrumbs

The navigation at the top left to quickly navigate between reports and dashboards.

B



calculation

A mathematical determination of the size or number of something.

capacity

[Power BI Premium] Data models running on hardware fully managed by Microsoft in
Microsoft cloud data centers to help ensure consistent performance at scale. BI solutions
are delivered to the entire organization regardless of Power BI license.

card (visual type)

A Power BI visualization type.

card (Power BI Home)

Power BI Home displays rectangular and square pictures that represent dashboards,
reports, apps, and more. These pictures are referred to as cards.

certified custom visual

A Power BI custom visual that met requirements and passed strict security testing.

connect live

A method of connecting to SQL Server Analysis Services data models. Also called a live
connection.

connector

Power BI Desktop includes an ever-growing collection of data connectors that are built
to connect to a specific data source. Examples include: GitHub, MailChimp, Power BI
dataflows, Google Analytics, Python, SQL Server, Zendesk, and more than 100 additional
data sources.

container

The areas on the navigation pane are containers. In the nav pane you find containers for:
Browse, Data hub, Apps, Metrics, Deployment pipelines, Learn, Workspaces, and Home.

content

Content for the Power BI service is generally dashboards, reports, and apps. It can also
include workbooks and semantic models.

C



content list

The content index for an app.

content view

The view that lists Power BI content you created or content that designers shared with
you.

continuous variable

A continuous variable can be any value between its minimum and maximum limits,
otherwise it's a discrete variable. Examples are temperature, weight, age, and time.
Continuous variables can include fractions or portions of the value. The total number of
blue skateboards sold is a discrete variable since we can't sell half a skateboard.

correlation

A correlation tells us how the behavior of things is related. If their patterns of increase
and decrease are similar, then they're positively correlated. And if their patterns are
opposite, then they're negatively correlated. For example, if sales of our red skateboard
increase each time we run a TV marketing campaign, then sales of the red skateboard
and the TV campaign are positively correlated.

cross-filter

Applies to visual interactions. Cross-filtering removes data that doesn't apply. For
example, selecting Moderation in the doughnut chart cross-filters the line chart. The line
chart now displays only data points that apply to the Moderation segment.

cross-highlight

Applies to visual interactions. Cross-highlighting retains all the original data points but
dims the portion that doesn't apply to your selection. For example, selecting
Moderation in the doughnut chart cross-highlights the column chart. The column chart
dims all the data that doesn't apply to the Moderation segment, and highlights all the
data that does apply to the Moderation segment.

custom visual

Visuals that the community and Microsoft create. They can be downloaded from the
Microsoft Store for use in Power BI reports.
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dashboard

In the Power BI service, a dashboard is a single page, often called a canvas that uses
visualizations to tell a story. Because it's limited to one page, a well-designed dashboard
contains only the most important elements of that story. Dashboards can be created
and viewed only in the Power BI service, not in Power BI Desktop. For more information,
see Basic concepts for the Power BI service business user.

data connector

See connectors.

data model, Excel data model

In Power BI content, a data model refers to a map of data structures in a table format.
The data model shows the relationships that are being used to build databases. Report
designers, administrators, and developers create and work with data models to create
Power BI content.

dataflow

Dataflows ingest, transform, integrate, and enrich big data by defining data source
connections, Extract Transform Load (ETL) logic, refresh schedules, and more. Formerly
called "data pool."

dataset

Refer to semantic model.

diamond

Power BI Premium. The shape of the icon that signifies a workspace is a Premium
capacity workspace.

dimension

Dimensions are categorical (text) data. A dimension describes a person, object, item,
product, place, and time. In a semantic model, dimensions are a way to group measures
into useful categories. For our skateboard company, some dimensions might include
looking at sales (a measure) by model, color, country/region, or marketing campaign.

drill up, drill down, drillthrough

In Power BI, "drill down" and "drill up" refer to the ability to explore the next level of
detail in a report or visual. "Drill through" refers to the ability to select a part of a visual
and be taken to another page in the report, filtered to the data that relates to the part



of the visual you selected on the original page. Drill to details commonly means to show
the underlying records.

Editing view

The mode in which report designers can explore, design, build, and share a report.

ellipsis

(...) menu. Selecting an ellipsis displays the menu options. Also referred to as the More
actions or More options menu, depending on the menu options.

embed code

A common standard across the internet. In Power BI, the customer can generate an
embed code and copy it to place content such as a report visual on a website or blog.

embedded

See Power BI Embedded.

embedding

In the Power BI developer offering, the process of integrating analytics into apps using
the Power BI REST APIs and the Power BI SDK.

environment

[Power BI Desktop, Power BI Mobile, the Power BI service, and others] Another way to
refer to one of the Power BI tools. It's OK to use Power BI environment (tenant) in
documentation where it might help business analysts who are familiar with the term
tenant to know it's the same thing.

explicit measures

Power BI uses explicit measures and implicit measures (see definition). Explicit measures
are created by report designers and saved with the semantic model. They're displayed in
Power BI as fields, and can therefore be used over and over. For example, a report
designer creates an explicit measure TotalInvoice that sums all invoice amounts.
Colleagues who use that semantic model, and who have edit access to the report, can
select that field and use it to create a visual. When an explicit measure is added or
dragged onto a report canvas, Power BI doesn't apply an aggregation. Creating explicit
measures requires edit access to the semantic model.
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favorite, unfavorite

Verb meaning to add to the Favorites list for quick access to frequently visited
dashboards and reports in Power BI. When you no longer want them as a favorite, you
unfavorite them.

filter versus highlight

A filter removes data that doesn't apply. A highlight grays out the data that doesn't
apply.

focus mode

Use focus mode to pop out a visual or tile to see more detail. You can still interact with
the visual or tile while in focus mode.

free account

See account.

full screen, full-screen mode

Use full screen mode to view Power BI content without the distraction of menus and
navigation panes. Full screen is sometimes referred to as TV mode.

gateways or on-premises data gateways

A bridge to underlying data sources. It provides quick and secure data transfer between
the Power BI service and on-premises data sources that support refresh. Usually
managed by IT.

high-density visuals

Visuals with more data points than Power BI can render. Power BI samples the data to
show the shape and outliers.

Home
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The default landing age for Power BI service users. Doesn't modify anything. Can be
called Power BI Home or simply Home.

implicit measures

Power BI uses implicit measures and explicit measures (see definition). Implicit measures
are created dynamically. For example, when you drag a field onto the report canvas to
create a visual. Power BI automatically aggregates the value using one of the built-in
standard aggregations (SUM, COUNT, MIN, AVG, and others). Creating implicit measures
requires edit access to the report.

insights

See quick insights.

KPIs

Key performance indicators. A type of visual.

left navigation (left nav)

This term was replaced with nav pane but might still appear in some documentation.
The controls along the left edge of Power BI service. First instance: navigation pane.
Subsequent mentions or tight spaces: nav pane.

license

Your level of access is determined by the Power BI license associated with your account
and the capacity type where content is stored. For example, in shared capacity, a user
with a Power BI Pro license can collaborate only with users who are also assigned a Pro
license. In shared capacity, a free license enables access to only the user’s personal
workspace. However, when content is in Premium capacity, users with a Pro license can
share that content with users who are assigned a free license. A license is assigned to a
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user and can be a free or Pro license. Depending on how the license was acquired, it
might be paid or unpaid. The accounts are either per-user or organizational. Per-user
accounts are available as free or Pro. A Power BI free user is either using stand-alone
Power BI Desktop or is using Power BI service stand-alone or is using Power BI service
within an organization that has a Premium organizational subscription. The Power BI
per-user Pro account is a paid monthly subscription that allows for collaboration and
sharing of content with other Pro users. The organizational Premium (also known as
Premium capacity) subscription adds a layer of features on top of per-user licenses. For
example, free per-user account holders within an organization that has a Premium
subscription, are able to do more with Power BI than free users without Premium. For
example, free users in Premium organizational accounts, can collaborate with colleagues
and can view content hosted on Power BI Premium capacity.

list page or content list

One of the section pages for the elements in the nav pane. For example, Create, Data
hub, or My workspace.

measure

A measure is a quantitative (numeric) field that can be used to do calculations. Common
calculations are sum, average, and minimum. For example, if our company makes and
sells skateboards, our measures might be number of skateboards sold and average
profit per year.

Microsoft R (R)

R is a programming language and software environment for statistical computing and
graphics.

mobile app

Apps that allow you to run Power BI on iOS, Android, and Windows mobile devices.

modeling

[Power BI Desktop] Getting the connected data ready for use in Power BI. This includes
creating relationships between tables in multiple data sources, creating measures, and
assigning metrics.

My workspace
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The workspace for each Power BI customer to use to create content. If they want to
bundle anything created here into an app, and they have designer permissions, they
upload it to the appropriate workspace or create a new one.

native

Included with the product. For example, Power BI comes with a set of native visualization
types. But you can also import other types, such as Power BI visuals.

navigation pane or nav pane

The controls along the left edge of the Power BI service. First instance: navigation pane.
Subsequent mentions or tight spaces: nav pane.

notification

Messages sent by and to the Power BI Notification center.

Notification center

The location in the service where messages are delivered to users, such as notice of
sunsetting certain features.

OneDrive for work or school vs OneDrive

OneDrive is a personal account and OneDrive for work or school is for work accounts.

on-premises

The term used to distinguish local computing (in which computing resources are located
on a customer's own facilities) from cloud computing.

on-premises data gateways

See gateways or on-premises data gateways.

PaaS
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Platform as a service, for example, Power BI Embedded.

page

Reports have one or more pages. Each tab on the report canvas represents a page.

paginated reports

Paginated reports are designed to be printed or shared. They're called paginated
because they're formatted to fit well on a page. They display all the data in a table, even
if the table spans multiple pages. You can control their report page layout exactly. Power
BI Report Builder is the standalone tool for authoring paginated reports.

pbiviz

The file extension for a Power BI custom visual.

pbix

The file extension for a Power BI Desktop file (letters pronounced individually as P-B-I-
X).

permissions

What a user can and can't do in Power BI is based on permissions. As a consumer you
don't have the same permissions as a designer, administrator, or developer.

phone report

The name for a Power BI report that's formatted for viewing on a phone.

phone view

The user interface in the Power BI service for laying out a phone report.

pin, unpin

The action a report designer takes when placing a visual, usually from a report, onto a
dashboard.

Power BI, Power BI service, Power BI Desktop, Power BI mobile

Some of the Power BI offerings. Power BI is the general term. It's often used in place of a
full product name, such as Power BI service and Power BI mobile, after the first mention
of the full product name.

Power BI Desktop



Also referred to as Desktop. The free Windows application of Power BI you can install on
your local computer that lets you connect to, transform, and visualize your data. Used by
report designers and admins. For more information, see What is Power BI.

Power BI Embedded

A product used by developers to embed Power BI dashboards and reports into their
own apps, sites, and tools.

Power BI Premium

An add-on to the Power BI Pro license that enables organizations to predictably scale BI
solutions through the purchasing of reserved hardware in the Microsoft cloud. See
account and license.

Power BI Pro

A monthly per-user license that provides the ability to build reports and dashboards,
collaborate on shared data, keep data up-to-date automatically, audit and govern how
data is accessed and used, and the ability to package content to distribute (Power BI
apps). See account and license.

Power BI Report Builder

It's a free, standalone Windows Desktop application used for authoring paginated
reports. Used by report designers. For more information, see Power BI Report Builder.
Power BI Report Builder can be downloaded from the Power BI site.

Power BI Report Server

An on-premises report server with a web portal in which you display and manage
reports and KPIs. It allows organizations to build distributed, hybrid BI systems (a mix of
cloud and on-premises deployments).

Power BI service

An online SaaS (software as a service). For more information, see What is Power BI.

Premium workspace

A workspace running in a capacity, signified to customers by a diamond icon.

Pro license or Pro account

See account and license.

publish

https://learn.microsoft.com/en-us/power-bi/fundamentals/power-bi-overview
https://learn.microsoft.com/en-us/power-bi/paginated-reports/report-builder-power-bi
https://learn.microsoft.com/en-us/power-bi/fundamentals/power-bi-overview


Power BI service report designers bundle the contents of a Power BI workspace to make
it available to others as a Power BI app. Power BI Desktop report designers use publish
to refer to sending a Power BI Desktop report in pbix format to the Power BI service so
that they can build dashboards from it and easily share it with others.

Q&A

The Power BI feature that allows natural language questions about a semantic model
and get responses in the form of visualizations. Appears in the Power BI service and
Desktop.

Q&A virtual analyst

[Power BI Mobile] For iOS, the conversational UI for Q&A.

QR codes

[Power BI Mobile] A matrix barcode that can be generated for dashboards or tiles in the
Power BI service to identify products. QR codes can be scanned with a QR code reader,
or with the Power BI Mobile app on iOS or Android, to link directly to the dashboard or
tile.

query string parameter

In the broadest sense, a query string recovers information from a database. Add one to
a URL to prefilter the results seen in a Power BI report.

Quick Insights

Quick Insights refer to automatically generated insights that reveal trends and patterns
in data.

Reading view

Read-only view for reports (as opposed to Editing View).

real-time streaming

The ability to stream data and update dashboards in real time from sources such as
sensors, social media, usage metrics, and anything else from which time-sensitive data
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can be collected or transmitted.

recent

The container on the home page that holds all the individual items that were accessed
last.

related content

Shows the individual pieces of content that contribute to the current content. For
example, for a dashboard, you can see the reports and semantic models providing the
data and visualizations on the dashboard.

relative links

Links from dashboard tiles to other dashboards and reports that are shared directly or
distributed through a Power BI app. Relative links enable richer dashboards that support
drillthrough.

report

A multi-perspective view into a single semantic model, with visualizations that represent
different findings and insights from that semantic model. Can have a single visualization
or many, a single page, or many pages.

report editor

The report editor is the tool in which new reports are created and changes are made to
existing reports by report designers.

report measures

Also called custom calculations. Excel calls these calculated fields. See also measures.

responsive visuals

Visuals that change dynamically to display the maximum amount of data and insights,
no matter the screen size.

row-level security (RLS)

Power BI feature that enables database administrators to control access to rows in a
database table based on the characteristics of the user executing a query (for example,
group membership). Administrators can configure RLS for data models imported into
Power BI with Power BI Desktop.



SaaS

Software as a service is a way of delivering applications over the internet as a web-based
service. Also referred to as: web-based software, on-demand software, or hosted
software.

screenshot

Simple screenshots of a report can be emailed using the send a screenshot feature.

semantic model

A semantic model is a collection of data used to create visualizations and reports.

Desktop or Power BI Desktop

Free Power BI tool used primarily be report designers, admins, and developers.

service

See Power BI service. A standalone resource available to customers by subscription or
license. A service is a product offering delivered exclusively via the cloud.

settings

The location for Power BI users to manage their own general settings, such as whether
to preview new features, set the default language, close their account, and more. Also,
users manage individual settings for content assets, alerts, and subscriptions.
Represented by a cog icon.

share, sharing

In Power BI, sharing typically means directly sharing an individual item (a dashboard or
report) with one or more people by using their email address. Requires a Power BI Pro
license for sender and recipient. On mobile devices, share can refer to native OS share
functionality, such as "annotate and share."

Shared with me

The container in the nav pane that holds all the individual items that were directly
shared by another Power BI user.

snapshot
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In Power BI, a snapshot is a static image compared with a live image of a tile, dashboard,
or report.

SQL Server Analysis Services (SSAS)

An online analytical data engine used in decision support and business analytics,
providing the analytical data for business reports and client applications such as Power
BI, Excel, Reporting Services reports, and other data visualization tools.

SQL Server Reporting Services (SSRS)

A set of on-premises tools and services to create, deploy, and manage report servers
and paginated reports.

streaming data

See real-time streaming.

subscriptions, subscribe

You can subscribe to report pages, apps, and dashboards and receive emails containing
a snapshot. Requires a Power BI Pro license.

summarization

[Power BI Desktop] The operation being applied to the values in one column.

tiles

Power BI dashboards contain report tiles.

time series

A time series is a way of displaying time as successive data points. Those data points
could be increments such as seconds, hours, months, or years.

value, values
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Numerical data to be visualized.

visual, visualization

A chart. Some visuals are: bar chart, treemap, doughnut chart, map.

visual interaction

One of the great features of Power BI is the way all visuals on a report page are
interconnected. If you select a data point on one of the visuals, all the other visuals on
the page that contain that data change, based on that selection.

Visualizations pane

Name for the visualization templates that ship in the shared report canvas for Power BI
Desktop and the Power BI service. Contains small templates, also called icons, for each
native visualization type.

workbook

An Excel workbook to be used as a data source. Workbooks can contain a data model
with one or more tables of data loaded into it by using linked tables, Power Query, or
Power Pivot.

workspace

Containers for dashboards, reports, and semantic models in Power BI. Users can
collaborate on the content in any workspace except My workspace. The contents can be
bundled into a Power BI app. Workspaces stored in Premium capacity can be shared
with free users. Personal workspaces (under My workspace) can be hosted in Premium
capacity.

x-axis

The axis along the bottom, the horizontal axis, of a line graph.

y-axis
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The axis along the side, the vertical axis, of a line graph.

Basic concepts for Power BI service consumer

Z

Next steps



Frequently asked questions about
Power BI
FAQ

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

The Power BI service is a cloud-based business analytics service that enables anyone to
visualize and analyze data with greater speed, efficiency, and understanding. It connects
users to a broad range of cloud-based and on-premises data through easy-to-use
dashboards, interactive reports, and compelling visualizations that bring data to life. For
more information, see What is Power BI.

The way you interact with Power BI depends on your job role. As an end user or business
user, you're the person who receives content (dashboards, reports, and apps) from
colleagues. If you work in the online or mobile version of Power BI, then you're using the
Power BI service to review and interact with content to make business decisions. For
more information, see Power BI for business users.

Power BI Pro is an individual user license that allows access to all content and
capabilities in the Power BI service. You can even share content and collaborate with
other Pro users. Only Pro users can publish content to other workspaces, share
dashboards, and subscribe to dashboards and reports.

Premium Per User (PPU) gives organizations a way to license premium features on a per-
user basis. PPU includes all Power BI Pro license capabilities that were previously only
available with a Premium capacity subscription. With a PPU license, you don't need a
separate Power BI Pro license because all Pro license capabilities are included.

What's the Microsoft Power BI service?

What's a Power BI business user?

What's the difference between Power BI
Pro, Premium Per User (PPU) and Power
BI Premium?

https://learn.microsoft.com/en-us/power-bi/fundamentals/power-bi-overview


Power BI Premium is a subscription that provides a capacity to deliver more consistent
performance. It also supports larger data volumes in Power BI. For individual users,
Premium enables widespread distribution of content by Pro users, and doesn't require
per-user Pro licenses for recipients viewing the content. This means business users can
collaborate with colleagues and view and interact with dashboards, reports, and apps
that are shared with them.

To learn more, see What type of license do I have? and Premium Per User FAQ

For questions related to Power BI Premium, see Power BI Premium FAQ.

Power BI Desktop is a free application you install on your computer. Power BI Desktop
works cohesively with the Power BI service. Data scientists, report designers, admins, and
developers work with Power BI Desktop to produce reports and make them available to
the Power BI service business users like you. For more information, see What is Power BI
Desktop.

If your company purchased Power BI licenses or a Premium capacity account, all you
need to start is a Web browser and credentials. To log in, use your work email address
and a password (set by your Power BI administrator).

You can also sign up for the Power BI service as an individual. For more information, see
the Power BI self-service sign-up process.

Power BI doesn't support email addresses provided by consumer email services or
telecommunications providers. To learn more, see the Power BI self-service sign-up
process.

What if I have questions about Power BI
Premium?

What is Power BI Desktop?

What do I need as a business user to get
started with the Power BI service?

Why do I have to sign up with my work
email?

https://learn.microsoft.com/en-us/power-bi/enterprise/service-premium-per-user-faq
https://learn.microsoft.com/en-us/power-bi/enterprise/service-premium-faq
https://learn.microsoft.com/en-us/power-bi/fundamentals/desktop-what-is-desktop
https://learn.microsoft.com/en-us/power-bi/fundamentals/service-self-service-signup-for-power-bi
https://learn.microsoft.com/en-us/power-bi/fundamentals/service-self-service-signup-for-power-bi


Yes. Power BI has native apps for Android phones and tablets, iOS devices, and Windows
10 devices. Download one of the Power BI mobile apps  from its respective store.

Apple App Store
Google Play
Windows Store

To use the Power BI service for free, you need a Web browser and email, then download
the Power BI mobile apps from their respective stores (also for free).

Apple App Store
Google Play
Windows Store

The following resources are available to help get you started:

Power BI Blog
Webinars
Getting started videos on our YouTube Channel
Get started with Power BI as a business user article
Join our community  and ask questions
See 10 tips for getting help for more suggestions

Here's a complete list of supported browsers for Power BI.

Here's a complete list of regions and languages supported by Power BI.

Does Power BI support mobile devices?

What do I need to install to use Power
BI?

Where do I get started with Power BI?

Which browsers does Power BI support?

What regions and languages does
Power BI support?

https://powerbi.microsoft.com/mobile
https://go.microsoft.com/fwlink/?LinkId=526218
https://go.microsoft.com/fwlink/?LinkID=544867&clcid=0x409
https://go.microsoft.com/fwlink/?LinkId=526478
https://go.microsoft.com/fwlink/?LinkId=526218
https://go.microsoft.com/fwlink/?LinkID=544867&clcid=0x409
https://go.microsoft.com/fwlink/?LinkId=526478
https://powerbi.microsoft.com/blog/
https://learn.microsoft.com/en-us/power-bi/fundamentals/webinars
https://www.youtube.com/user/mspowerbi
https://community.powerbi.com/
https://learn.microsoft.com/en-us/power-bi/support/service-tips-for-finding-help
https://learn.microsoft.com/en-us/power-bi/fundamentals/supported-languages-countries-regions


Feedback

Was this page helpful?

Provide product feedback | Ask the community

Learn more about Power BI security, privacy, and compliance here:

Power BI Security white paper

Power BI security support article

Like many other Microsoft services and software, Power BI provides an easy way to undo
your last command.

To undo your last action or last few actions, press CTRL+Z.

What is a Power BI business user?
How does a business user interact with Power BI?
More questions? Try asking the Power BI Community
Still have an issue? Visit the Power BI support page

Where can I learn more about security?

How do I undo in Power BI?

Next steps

 Yes  No

https://ideas.fabric.microsoft.com/?forum=2d80fd4a-16cb-4189-896b-e0dac5e08b41
https://community.fabric.microsoft.com/powerbi
https://learn.microsoft.com/en-us/power-bi/guidance/whitepaper-powerbi-security
https://learn.microsoft.com/en-us/power-bi/enterprise/service-admin-power-bi-security
https://community.powerbi.com/
https://powerbi.microsoft.com/support/


Supported browsers for Power BI and
Fabric
Article • 01/30/2024

Power BI and Fabric are designed to work with any of the supported modern browsers
mentioned here. However, performance differs depending on your choice of a browser.
If you're using Internet Explorer in particular, which is no longer supported by Power BI
or Fabric, you might encounter worse performance. We strongly recommend a
supported modern browser, like Microsoft Edge. If you still encounter unacceptable
performance, test other supported modern browsers to see if they provide better results
for your Power BI solution.

Power BI supports these browsers on all platforms where they're available:

Microsoft Edge version 120 and later.
Chrome desktop latest version and Windows 10 version 1703 and later.
Safari Mac latest version.
Firefox desktop latest version. Firefox might change the fonts used in Power BI.

Power BI and Fabric use the Segoe UI font for text as its default, and the Din font for
numbers, and other fonts when creating reports, dashboards, and other items. These
fonts might not be available on non-Windows computers such as Macs. As a result the
font, alignment of items, and visuals for the same report look different when viewed on
a Windows computer versus a Mac.

The Calibri and Cambria fonts are only installed on Macs that have Microsoft Office
installed. They're not included in the default set of fonts on Macs.

If you're creating reports viewed on Mac computers, select fonts that display
properly on Macs. These links provide information about which fonts are available

７ Note

Power BI and Fabric don't run in any browsers in iOS10 or previous versions.

Fonts

Limitations and considerations



on Macs. Microsoft doesn't support these links. They're provided only for reference
and further reading.

Review the list of typefaces included with macOS.
Find Calibri and Cambria for Macs.
Fix missing Calibri, Cambria and Segoe UI fonts on a Mac.

Enable third-party cookies. Many areas of Power BI require third party cookies.
Ensure that third-party cookies are enabled in your browser settings.

Microsoft Edge: Select Settings > Cookies and site permissions > Cookies and
data stored > Manage and delete cookies and site data. Ensure that Allow is
toggled on and Block 3rd-party cookies is turned off. Optionally, scroll to Allow
and add app.powerbi.com.
Chrome: Select Settings > Privacy and security > Third-party cookies and
ensure that third-party cookies isn't turned off. Optionally, add
app.powerbi.com to Allowed to use third-party cookies.
Firefox: Settings -> Privacy and security -> Cookies and site data -> Manage
exceptions and add app.powerbi.com.

What is Power BI?
Ask the Community
Still have an issue? Visit the Power BI support page

Related content

https://wikipedia.org/wiki/List_of_typefaces_included_with_macOS
https://apple.stackexchange.com/questions/128091/where-can-i-find-default-microsoft-fonts-calibri-cambria
https://ben.lobaugh.net/blog/204750/how-to-fix-missing-calibri-and-cambria-fonts-on-mac
https://learn.microsoft.com/en-us/power-bi/fundamentals/power-bi-overview
https://community.powerbi.com/
https://powerbi.microsoft.com/support/


Types of insights supported by Power BI
Article • 02/14/2024

APPLIES TO:  Power BI service for business users  Power BI service for designers
& developers  Power BI Desktop  Requires Pro or Premium license

Ask Power BI to look through your data and find interesting trends and patterns. These
trends and patterns are presented as visuals called Insights. Insights are available for
visuals on dashboards, visuals in reports, and entire report pages.

To learn how to use dashboard Insights, see View data insights on dashboard tiles with
Power BI.

How does Insights work?

https://learn.microsoft.com/en-us/power-bi/consumer/media/end-user-insight-types/power-bi-insight-line.png


Power BI searches different subsets of your semantic model and applies a set of
sophisticated algorithms to discover potentially interesting insights. You can run Insights
on dashboard tiles, report visuals, and report pages.

Power BI uses statistical algorithms to uncover Insights. The algorithms are listed and
described in the next section of this article. Before we get to the algorithms, here are
definitions for some terms that might be unfamiliar.

Measure - A measure is a quantitative (numeric) field that can be used to do
calculations. Common calculations are sum, average, and minimum. For example, if
our company makes and sells skateboards, our measures might be number of
skateboards sold and average profit per year.

Dimension - Dimensions are categorical (text) data. A dimension describes a
person, object, item, products, place, and time. In a semantic model, dimensions
are a way to group measures into useful categories. For our skateboard company,
some dimensions might include looking at sales (a measure) by model, color,
country/region, or marketing campaign.

Correlation - A correlation tells us how the behavior of things relates. If their
patterns of increase and decrease are similar, they're positively correlated. If their
patterns are opposite, they're negatively correlated. For example, sales of red
skateboards increase each time we run a tv marketing campaign. Sales of the red
skateboards and the tv marketing campaign are positively correlated.

Time series - A time series is a way of displaying time as successive data points.
Those data points could be increments such as seconds, hours, months, or years.

Continuous variable - A continuous variable can be any value between its minimum
and maximum limits, otherwise it's a discrete variable. Examples are temperature,
weight, age, and time. Continuous variables can include fractions or portions of the
value. The total number of blue skateboards sold is a discrete variable since we
can't sell half a skateboard.

For reports, Power BI proactively performs analyses for anomalies, trends, and KPIs. For
dashboard tiles, Power BI can find 10 types of Insights.

Some terminology

What types of insights can you find?



Highlights cases where one or two categories have larger values than other categories.

Highlights when there are significant changes in trends in a time series of data.

Category outliers (top/bottom)

Change points in a time series



Detects cases where multiple measures show a similar pattern or trend when plotted
against a category or value in the semantic model.

Detects cases where data points for a dimension aren't far from the mean, so the
variance is low. Let's say you have the measure "sales" and a dimension "region." And
looking across the region you see that there's little difference between the data points
and the mean (of the data points). The insight triggers when the variance of sales across
all regions is below a threshold. In other words, when sales are similar across all regions.

Correlation

Low Variance



Finds cases where most of a total value can be attributed to a single factor when broken
down by another dimension.

Majority (Major factors)

Outliers



This insight type uses a clustering model to find outliers not related to time in series
data. Outliers detect when there are specific categories with values significantly different
than the other categories.

Detects upward or downward trends in time series data.

Overall trends in time series

Seasonality in time series



Finds periodic patterns in time series data, such as weekly, monthly, or yearly
seasonality.

Highlights cases where there's a parent-child correlation between the share of a child
value in relation to the overall value of the parent across a continuous variable. The
steady share insight applies to the context of a measure, a dimension, and another
date/time dimension. This insight triggers when a particular dimension value, for
example "the east region," has a steady percentage of overall sales across that date/time
dimension.

The steady share insight is similar to the low variance insight, because they both relate
to the lack of variance of a value across time. However, the steady share insight
measures the lack of variance of the percentage of overall across time, while the low
variance insight measures the lack of variance of the absolute measure values across a
dimension.

Steady share



For data across a time series, detects when there are specific dates or times with values
significantly different than the other date/time values.

Time series outliers

Related content



View data insights on dashboard tiles with Power BI.

More questions? Ask the Power BI Community.

https://community.powerbi.com/

	The Power BI service for business users
	Overview
	What is a Power BI business user?
	Basic concepts and terminology for Power BI business users
	Take a tour of the Power BI service

	Get started
	Find your way around in Power BI
	Find content using your Home landing page
	List of features available to business users
	Sign in for the first time
	Which Power BI license do I have?
	Learn how to ask questions using natural language

	Dashboards
	Dashboards
	View a dashboard
	Dashboard tiles
	Add a comment or start a conversation
	View automatic insights for dashboard tiles
	Create a dashboard alert

	Power BI reports
	Reports
	View a report
	Change the way a report displays
	Change the sort order in a visual
	Use filters in a report
	Learn how report visuals cross-filter each other
	Interact with report slicers
	How to identify and use buttons
	Add a bookmark to a report
	Add a spotlight to a report
	Set an alert on a report
	Personalize a visual
	Explore your data in the Power BI service
	Analyze fluctuations in visuals

	Visualizations
	Types of visualizations
	Drill down in a visualization
	How to use an ArcGIS map in Power BI

	Metrics
	Get started with metrics
	Stay on top of your metrics
	View hierarchies in metrics

	Paginated reports in Power BI
	Paginated reports
	View a paginated report
	Interact with parameters

	Power BI in Teams
	Use data for productive meetings
	Use metrics to drive results
	Lead data-driven discussions
	Create reports from your data
	Analyze collaboration data

	Common tasks
	Look up the content owner and last refreshed date
	Different ways to zoom into content using Focus and Full screen modes
	Favorite dashboards, reports, and apps in Power BI
	Print a dashboard, print a dashboard tile, print a report page
	View related content
	View recent content
	Search and sort content in Power BI

	Get data
	Workspaces in Power BI
	Apps in Power BI
	Install and use apps
	Data hub
	Connect to services
	Get a sample app from the app marketplace

	Ask questions of your data
	Q&A in Power BI
	Q&A tutorial
	Tips and tricks for asking questions with Q&A in Power BI

	Resources
	Glossary and terminology
	Frequently asked questions
	Supported browsers
	Types of Quick Insights



